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Preface 

This manual provides information on the Electronic Health Record (EHR) 
p13additions and changes. 

Recommended Users: 
This document addresses the needs of Clinical Application Coordinators (CAC), as 
well as end-users of the Indian Health Service (IHS) Imaging Viewer. 

Related Manuals: 
The VA also has multiple manuals for Computerized Patient Record System (CPRS). 
Refer to www.va.gov/vdl for additional information. 

Required Configuration: 
Configuration is required before utilization of the new functionality and components. 
Refer to the Patch 13 MU Setup Guide for configuration instructions before using this 
User Guide. 
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1.0 Introduction 
This manual is designed to inform the CACs with the changes that have been 
implemented in the upgrade to EHR p13, as well as new items that have been added 
for IHS. 
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2.0 Overview 

2.1 What’s New 
Note: Configuration is required for these components before use. 

Refer to the Patch 13 MU Setup Guide for details. 

The following components are new for p13. 

• Acute Myocardial Infarction (AMI) (Currently disabled) 

• Consolidated Clinical Document Architecture (CCDA) Generation 

• Clinical Information Reconciliation (CIR) 

• Integrated Problem List (IPL) 

• Stroke Tool (Currently disabled) 

2.2 What’s Changed 
Note: Configuration may be required for these updates before 

utilization. Refer to the Patch 13 MU Setup Guide for 
details. 

The following components have been updated with functionality for p13. 

• Consults: 

Note: A parameter must be defined for Consult Type that assigns 
a Systematized Nomenclature of Medicine-Clinical Terms 
(SNOMED® CT) value for the consult. Refer to the Patch 
13 MU Setup Guide, “Defining a Consult Type SCT 
(SNOMED CT Consult Type) for a Consult 
Specialty/Service” topic for instructions. 

− In the Consults Component, when Other is selected in the Clinical Indication 
field, a SNOMED CT term must be added when adding new consults. 

− In the Orders Component, when Other is selected in the Clinical Indication 
field, a SNOMED CT term must be added when adding new consults. 

Note: The new, optional Clinical Indication field replaces the 
Provisional Diagnosis field. 

• Exams: 
SNOMED CT and Logical Observation Identifiers Names and Codes (LOINC) 
codes store when completing the Document an Exam dialog. 
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• Family History: 
SNOMED CT code stores when adding a family history condition. 

• Historical Diagnosis: 
This component has been changed to view-only. Past diagnosis can no longer be 
edited or deleted, nor set as Today’s POV. 

• Immunizations: 

− Lot number and manufacturer name can be added to active vaccines. 
− Administration Notes can be added to active vaccines. 
− Contraindications Reasons for specified vaccines display on the selected 

patient Official Immunization Record. 
− The Vac. Eligibility field drop-down list can be designated to present users 

with only codes relevant to their site. 
• Infant Feeding: 

− Infant Feeding Choices have been updated, including Secondary Fluids 
selections. 

− A right-click menu has been added to the component. 
− SNOMED CT codes associated with the feeding choices are stored. 

• Lab POC Data Entry: 
SNOMED CT code is saved with associated the lab order when Other is selected 
in the Sign or Symptom field. 

• Labs: 

− Info button renamed to Education Information button and launches Medline 
Plus and the Add Patient Education Event dialog. 

− New Clinical Decision Support button automatically returns information from 
UpToDate about a highlighted lab order. 

• Medications: 

− When Other is selected in the Clinical Indication field, a SNOMED CT term 
must be added when ordering Simple Dose Outpatient medications. 

− Inpatient’s Last Weight is displayed in the Medication Order dialog. 
− Outpatient’s Last Weight is displayed in the Medication Order dialog. 
− A new Discharge Medications field has been added. The field defaults to 

selected if the patient is currently admitted or if the ordering location has 
clinic stop code of 30. 

− Order Checks show the source of drug interaction information. 
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− Info button renamed to Education Information button and launches Medline 
Plus and the Add Patient Education Event dialog. 

− New Clinical Decision Support button automatically returns information from 
UpToDate about a highlighted medication order. 

• Orders: 

− When Other is selected in the Clinical Indication field, a SNOMED CT term 
must be added when ordering Lab Tests. 

− When Other is selected in the Clinical Indication field, a SNOMED CT term 
must be added when using Quick Orders. 

− Order Details dialog lists patient height and weight at last measurement, 
whether the medication is a discharge medication, and any comments. 

− Order Checks show the source of drug interaction information. 
• Patient Education: 

SNOMED CT term must be added when adding patient education using the 
Disease/Illness button in the Disease & Topic Entry topic. 

• Personal Health: 
SNOMED CT term must be added when entering Service Not Provided/Refusal 
information in the Personal Health component. 

• Visit Diagnosis: 

This component has been changed to view-only. Past visits can no longer be 
added, edited, or deleted, nor can a previously selected POV be added as Today’s 
POV. 
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3.0 New Components 
The following components are new for p13. 

3.1 Acute Myocardial Infarction Events 
The AMI tool captures specific SNOMED CT terms in the evaluation and treatment 
of AMI. The user can easily capture onset of symptoms, date/time implement 
protocols and/or standing orders, time EKG done, and EKG findings. 

This component is delivered disabled with the EHR p13release. This component will 
be enabled in the EHR p14 release. 

3.2 Consolidated Clinical Document Architecture Generation 
The CCDA Generation component employs stylesheet templates that are declared at 
the document, section, and entry level of CCDA documents. 

These templates (Clinical Summary and Transition of Care) are utilized to generate 
documents that are used to transition care and provide other external provider access 
to needed patient longitudinal data. 

The clinical content of the templates is limited to the most relevant patient data 
captured during one or more encounters to ensure continuity of patient care. 

The templates contain both human-readable and machine-readable data and provide a 
Summary of Care record for each transition of care or referral. 

 
Figure 3-1: CCDA Button 

The following options are available, depending on whether the encounter is a visit or 
a referral. Click the link for additional information about these topics. 

• Clinical Summary (visits only) 

• Transitions of Care (TOC) (visits and referrals) 

Note: TOC is also used for Inpatient Discharges to other 
facilities. 

The EHR displays the full .xml or .pdf file, whether a Clinical Summary or TOC, as a 
single document. When the Generate CCDA for Visits/Referrals option is used and 
multiple visits are selected; one document per selected visit is generated. 
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Transitions of Care documents, or documents that were customized (either Clinical 
Summary or TOC) are stored on an individual document basis in VistA Imaging, 
associated to the patient using an assigned HRN, and can be retrieved at a later time, 
as needed. 

3.2.1 Clinical Summary 
The CCDA component enables a user to electronically create a Clinical Summary or 
Transition of Care/Referral Summary from the Resource and Patient Management 
System (RPMS)-EHR in CCDA format. That summary is distributed to the patient 
and/or provider by the following methods: 

• Printing 

• Fax 

• E-mail 

For both ambulatory and inpatient settings, the Summary uses the Common MU Data 
Set data with named standards as appropriate: 

• Patient name 

• Sex 

• Date of birth 

• Race 

• Ethnicity 

• Preferred language 

• Smoking status 

• Problems 

• Medications 

• Medication allergies 

• Laboratory tests 

• Laboratory values/results 

• Vital signs – height, weight, blood pressure, Body Mass Index, infant head 
circumference 

• Care plan fields – including goals and instructions 

• Procedures 

• Care team members 
If the patient refuses or declines the Clinical Summary, the SNOMED CT refusal 
type, 422735006- reason Refused, is stored. 
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The following tasks apply to the Clinical Summary: 

• Generate Clinical Summary for Current Selected Visit 

• Generate Clinical Summary for Current Date of Service Visits 

• Generate CCDA for Visits/Referrals 

3.2.2 Transitions of Care 
The Transitions of Care (TOC) supports the electronic exchange of core clinical 
information for referrals among providers, patients, and other authorized entities 
electronically to improve the quality of care. 

The TOC Submit button sends all referrals for the selected visit electronically to the 
external provider(s) in the vendor file. If a vendor does not have electronic-referral 
capability, the referral may be sent to print or fax. 

The following tasks apply to the TOC: 

• Generate Transition of Care for Current Selected Visit 

• Generate Transition of Care for Current Date of Service Visits 

• Generate CCDA for Visits/Referrals 

3.2.3 Completing CCDA Tasks 
Follow these steps to complete various CCDA tasks, such as printing Clinical 
Summaries or submitting Transitions of Care. 

1. In RPMS-EHR, select a patient and a visit. 

Note: If a visit is not selected, you are presented with only the 
Generate CCDA for Visits/Referrals option, where you 
must select a visit or referral. Refer to the Generate CCDA 
for Visits/Referrals topic for details. 

2. Briefly rest your mouse pointer over the CCDA button. Alternatively, you can 
right-click to view the menu. The CCDA menu appears with the following 
options. 

 
Figure 3-2: CCDA Menu 
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3. Click a link: 

• DO NOT GENERATE Summary, Patient has active Personal Health Record 
(PHR): 

– This option is only visible if the patient has active PHR data captured in 
RPMS and stores a patient education. 

• DO NOT GENERATE Summary, Patient Declines: 

– The SNOMED CT refusal type 422735006 is stored in the background. 
• GENERATE Clinical Summary for Current selected visit: 

– Print 
– Review/Customize 

• GENERATE Clinical Summary for Current date of service visits: 
– Print 
– Review/Customize 

• GENERATE Transition of Care for Current selected visit: 

• GENERATE Transition of Care for Current date of service visits: 

• GENERATE CCDA for Visits/Referrals 

3.2.3.1 Generating Clinical Summary for Current Selected Visit 
To generate a Clinical Summary for the current selected visit, select Generate Clinical 
Summary for Current selected visit. Then select one of the following actions. 

Note: To select an additional action, you must re-enter the CCDA 
component. 

 
Figure 3-3: Clinical Summary for Current Selected Visit 

3.2.3.1.1 Print 
To print a Clinical Summary for the current selected visit, follow these steps: 

1. Click the Print option. The Print dialog opens. 

2. In Select Printer, select a printer. 
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3. Click Print. 

3.2.3.1.2 Review/Customize 
To review or customize a Clinical Summary for the current selected visit, follow 
these steps: 

1. Click the Review/Customize option. The CCDA Clinical Summary dialog opens. 

Note: The Clinical Document list is fully expanded and all of the 
check boxes are pre-selected as the default. 

 
Figure 3-4: CCDA Clinical Summary dialog 

Note: Briefly rest the mouse pointer in the Clinical Document 
pane of the Clinical Summary dialog to view a message 
that instructs to press F1 to view Online Help about the 
topic. 

2. Clear the check boxes next to any items you want to remove from the Clinical 
Summary. Clearing a check box also clears any check boxes below it. For 
example, clearing the Allergies check box also clears all allergy items listed 
individually below it. Select any check boxes for individual sub-topics, as needed. 

The following occurs in the Clinical Summary preview when a check box is 
cleared: 

• The topic data is cleared when the check box is cleared but the heading 
remains and the word Redacted appears below the heading of the section that 
was cleared. 
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• When a subheading check box is cleared, the subheading remains and the 
word Redacted appears below it. 

• The following note appears at the top of the Clinical Summary, "Some 
information may have been redacted at patient's request or legal requirement." 

 
Figure 3-5: Redacted Clinical Summary dialog 

If no data is available for a specific item, the text below the heading indicates 
None or No information for the report-generation criteria. 

3. Click the Collapse button ( ) to collapse Subheadings, as needed. 

Note: The arrows in the bottom-left of the dialog are only active 
to view multiple pages if the Generate CCDA for 
Visits/Referrals option is used and multiple visits are 
selected. 

4. When you have completed your selections, select the Finalized check box at the 
bottom of the CCDA Clinical Summary dialog. The Print button becomes active. 

5. Click Print. The Print dialog opens. 

a. In Select Printer, select a printer. 

b. Click Print. 

6. Close the CCDA Clinical Summary dialog. 
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3.2.3.2 Generate Clinical Summary for Current Date of Service Visits 
To generate a Clinical Summary for the current date of service visits (multiple visits 
for one date), from the CCDA menu, select Generate Clinical Summary for Current 
Date of service visits. Then select one of the following actions. 

Note:  To select an additional action, you must re-enter the CCDA 
component. 

• Print 

• Review/Customize 

 
Figure 3-6: Clinical Summary for Current Date of Service Visits 

3.2.3.2.1 Print 
To print a Clinical Summary for the current date of service visits, follow these steps: 

1. Click the Print option. The Print dialog opens. 

2. In Select Printer, select a printer. 

3. Click Print. 

3.2.3.2.2 Review/Customize 
To review or customize a Clinical Summary for the current date of service visits, 
follow these steps: 

1. Click the Review/Customize option. The CCDA Clinical Summary dialog opens. 

Note: The Clinical Document list is fully expanded and all of the 
check boxes are pre-selected as the default. 
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Figure 3-7: CCDA Clinical Summary dialog 

Note: Briefly rest the mouse pointer in the Clinical Document 
pane of the Generate CCDA for Visit/Referrals dialog to 
view a message that instructs to press F1 to view Online 
Help about the topic. 

2. Clear the check boxes next to any items you want to remove from the Clinical 
Summary. Clearing a check box also clears any check boxes below it. For 
example, clearing the Allergies check box also clears all allergy items listed 
individually below it. Select any check boxes for individual sub-topics, as needed. 

The following occurs in the Clinical Summary preview when a check box is 
cleared: 

• The topic data is cleared when the check box is cleared but the heading 
remains and the word Redacted appears below the heading of the section that 
was cleared. 

• When a subheading check box is cleared, the subheading remains and the 
word Redacted appears below it. 

• The following note appears at the top of the Clinical Summary, “Some 
information may have been redacted at patient’s request or legal requirement.” 

Note: Refer to the Redacted Clinical Summary dialog to view an 
example. 

3. Click the Collapse button to collapse Subheadings, as needed. 
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Note: The arrows in the bottom-left of the dialog are only active 
if the Generate CCDA for Visits/Referrals option is used 
and there are multiple pages available. 

4. When you have completed your selections, select the Finalized check box at the 
bottom of the CCDA Clinical Summary dialog. The Print button becomes active. 

5. Click Print. The Print dialog opens. 

a. In Select Printer, select a printer. 

b. Click Print. 

3.2.3.3 Generate Transition of Care for Current Selected Visit 
To generate a Clinical Transition of Care (TOC) for the current selected visit, select 
Generate Transition of Care for Current selected visit from the CCDA menu and 
follow these steps: 

Note: If the patient has referrals for the current visit, the user sees 
this screen. If no referrals are available, a message displays 
stating that no referrals currently exist for this visit. 

1. The Referrals tab with the TOC option button selected opens (default). 

If you select the Visits tab, the Clinical Summary and the Transition of Care 
option buttons are active. If you select the Referrals tab, only the Transition of 
Care option button is active. 

2. In the top-right portion of the dialog, if the Generate TOC option is selected, the 
Transition of Care option button is the default, if Clinical Summary is selected, 
the Clinical Summary option button is the default. 

• Clinical Summary 

• Transition of Care 

3.2.3.3.1 Clinical Summary 
If you select Clinical Summary, refer to the Generate Clinical Summary for Current 
Selected Visit topic for details. 

3.2.3.3.2 Transition of Care 
The following steps are for generating a Transition of Care document. 

Note: Every other node within the same level or column is 
highlighted in blue for readability. 
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Figure 3-8: Generate Transition of Care for Current Selected Visit 

1. Click the Expand button ( ) to expand, or the Collapse button to collapse the 
document list. 

2. Select the check boxes to select or to clear any referrals you want to add or 
remove from the list, as needed. 

3. Click one of the following buttons to complete the action for the Transition of 
Care document: 

Note: The Clinical Document list is fully expanded and all of the 
check boxes are pre-selected as the default. 

Submit button. The following submission method opens, depending on what 
type of contact information is provided in the referral: 

• If no contact information is provided, the Print dialog opens. 
– In Select Printer, select a printer. 
– Click Print to print the referral for faxing manually or other delivery. 

• If a fax number is provided, the following information message confirms that 
the image was sent to VistA Imaging for faxing. Click OK and the system 
generates a notification to the defined mail group. 
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Figure 3-9: Imaging Confirmation Message 

• If an e-mail address is provided, the DirectEmailForm dialog opens. 

Note: If both a fax and an-email address are provided, the referral 
is sent by e-mail. 

 
Figure 3-10: DirectEmailForm dialog 

– In Username, type your user name. 
– In Password, type your password. 

Note: Do not change the Port, direct service is read-only. 

– Click Send to send the referral. 
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Review/Customize button: 

• Click the Review/Customize option. The CCDA Transition of Care dialog 
opens. 

Note: The Clinical Document list is fully expanded and all of the 
check boxes 

 
Figure 3-11: CCDA Transition of Care dialog 

• Clear the check boxes next to any items you want to remove from the 
Transition of Care. Clearing a check box also clears any check boxes below it. 
For example, clearing the Allergies check box also clears all allergy items 
listed individually below it. Select any check boxes for individual sub-topics, 
as needed. 

The following occurs in the Transition of Care preview when a check box is 
cleared: 

– The topic data is cleared when the check box is cleared but the heading 
remains and the word Redacted appears below the heading of the section 
that was cleared. 

– When a subheading check box is cleared, the subheading remains and the 
word Redacted appears below it. 
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– The following note appears at the top of the Transition of Care, "Some 
information may have been redacted at patient's request or legal 
requirement." 

Note: Refer to the Redacted Clinical Summary dialog to view an 
example of redacted information. 

• Click the Collapse button to collapse Subheadings, as needed. 

Note: The arrows in the bottom-left of the dialog are only active 
if the Generate CCDA for Visits/Referrals option is used 
and there are multiple pages available. 

• When you have completed your selections, select the Finalized check box 
at the bottom of the CCDA Transition of Care dialog. Submit: Refer to 
Step 3. 

Cancel button: Cancels your action. 

3.2.3.4 Generate Transition of Care for Current Date of Service Visits 
To generate a Clinical a Transition of Care (TOC) for the current date of service visit 
from the CCDA menu, select Generate Transition of Care for Current Date of Service 
Visits and follow these steps: 

Note: If the patient has referrals for the current visit, the user sees 
this screen. If no referrals are available, a message displays 
stating that no referrals currently exist for this visit. 

1. The Referrals tab with the TOC option button selected opens (default). 

• If you select the Visits tab, the Clinical Summary and the Transition of Care 
option buttons are active. 

• If you select the Referrals tab, only the Transition of Care option button is 
active. 

2. In the top-right portion of the dialog, select one of the following: 

• Clinical Summary 

• Transition of Care 

3.2.3.4.1 Clinical Summary 
If you select Clinical Summary, refer to the Generate Clinical Summary for Current 
Date of Service Visits topic for details. 
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3.2.3.4.2 Transition of Care 
The following steps are for generating a Transition of Care document. 

Note: Every other node within the same level or column is 
highlighted in blue for readability. 

 
Figure 3-12: Generate Transition of Care for Current Selected Visit 

1. Click the Expand button to expand, or the Collapse button to collapse the 
document list. 

2. Select the check boxes to select or to clear any referrals you want to add or 
remove from the list, as needed. 

3. Click one of the following buttons to complete the action for the Transition of 
Care document: 

Note: The Clinical Document List is fully expanded and all of the 
check boxes are pre-selected as the default. 

Submit button. The following submission method opens, depending on what 
type of contact information is provided in the referral: 

• If no contact information is provided, the Print dialog opens. 
– In Select Printer, select a printer. 
– Click Print to print the referral for faxing manually or other delivery. 

• If a fax number is provided, the following information message confirms that 
the image was sent to VistA Imaging for faxing. Click OK. 
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Figure 3-13: Imaging Confirmation Message 

• If an e-mail address is provided, the DirectEmailForm dialog opens. 

Note: If both a fax number and an e-mail address are provided, 
the referral is sent by e-mail. 

– In Username, type your user name. 
– In Password, type your password. 
– The remaining fields auto-fill. Click Send to send the referral. 

Review/Customize button: 

• Click the Review/Customize option. The CCDA Transition of Care dialog 
opens. 

Note: The Clinical Document list is fully expanded and all of the 
check boxes are pre-selected as the default. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual New Components 
September 2014 

20 

 
Figure 3-14: CCDA Transition of Care dialog 

• Clear the check boxes next to any items you want to remove from the 
Transition of Care. Clearing a check box also clears any check boxes below it. 
For example, clearing the Allergies check box also clears all allergy items 
listed individually below it. Select any check boxes for individual sub-topics, 
as needed. 

The following occurs in the Transition of Care preview when a check box is 
cleared: 

– The topic data is cleared when the check box is cleared but the heading 
remains and the word Redacted appears below the heading of the section 
that was cleared. 

– When a subheading check box is cleared, the subheading remains and the 
word Redacted appears below it. 

– The following note appears at the top of the Transition of Care, "Some 
information may have been redacted at patient's request or legal 
requirement." 

Note: Refer to the Redacted Clinical Summary dialog to view an 
example of redacted information. 

• Click the Collapse button to collapse Subheadings, as needed. 
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Note: The arrows in the bottom-left of the dialog are only active 
if the Generate CCDA for Visits/Referrals option is used 
and there are multiple pages available. 

• When you have completed your selections, select the Finalized check box 
at the bottom of the CCDA Transition of Care dialog. The Submit button 
becomes active. Submit: Refer to Step 3. 

Cancel button: Cancels your action. 

3.2.3.5 Generating CCDA for Visits/Referrals 
The CCDA for Visits/Referrals option displays all of the visits for a patient by date of 
service, sorted from newest to oldest visit. 

To generate a CCDA Clinical Summary for a visit or referral, from the CCDA menu 
select Generate CCDA for a Visits/Referrals. This creates multiple documents for 
each checked request. Follow these steps: 

1. In the Generate CCDA for Visit/Referrals dialog, click the Visits tab; the Clinical 
Summary and the Transition of Care option buttons are active. 

Notes: If you select the Referrals tab, only the Transition of Care 
option button is active. 
Every other node within the same level or column is 
highlighted in blue for readability. 
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Figure 3-15: Generate CCDA for Visits/Referrals 

Note: Briefly rest the mouse pointer in the Generate CCDA for 
Visit/Referrals dialog to view a message that instructs to 
press F1 to view Online Help about the topic. 

2. In the top-right portion of the dialog, select and create one of the following, as 
applicable. 

Clinical Summary: 

• Click the Expand button to expand, or the Collapse button to collapse the 
document list. The list is fully expanded by default. 

• Click the check boxes to select or to clear the selection next to any items you 
want to add or remove from the list. 

• Refer to the Generate Clinical Summary for Current Selected Visit topic for 
details on how to Print, Review/Customize, and Cancel. 
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Transition of Care: 

• Click the Expand button to expand, or the Collapse button to collapse the 
document list. The list is fully expanded by default. 

• Click the check boxes to select or to clear the selection next to any items you 
want to add or remove from the list. 

• Refer to the Generate Transition of Care for Current Selected Visit topic for 
details on how to Print, Review/Customize, and Cancel. 

3.3 Clinical Information Reconciliation 
The CIR component assists with the reconciliation of medications, problems, and 
adverse reaction clinical data from an externally received CCDA xml and/or a clinical 
summary/transition of care/referral summary scanned. Refer to the CCDA Online 
Help for additional details. 

The CIR tool contains the following functionality: 

• Data is displayed from two or more sources in a manner that enables the user to 
view the data and their attributes, and includes the source and last modification 
date of the information. 

• Users may add, merge, or remove individual data. 

• Users may review and validate the accuracy of a final set of data elements, and 
upon a user’s confirmation, automatically update the patient’s medication, 
problem, and adverse reaction list. 

3.3.1 CIR Button 
CIR is launched by clicking the CIR button after selecting a patient and a visit. 

• The CIR button is red if there are documents that have been received, but are not 
yet fully reconciled by the site. The button also indicates the number of 
documents that have not been reconciled in its center. 

 
Figure 3-16: Unreconciled CIR Button 

• The CIR button is green if there are received documents that have been reconciled 
or no documents have been received for the patient. The button also indicates the 
number of documents that have been received and reconciled in its center. 

 
Figure 3-17: Reconciled CIR Button 
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Note: If no patient is selected, the CIR button displays in green 
with the initials CIR in its center and the words Clinical 
Information Reconciliation if you briefly rest your mouse 
pointer on the button. If the patient does not have any 
CCDA documents, the button shows a zero and a message 
opens, informing the user there are no attached images for 
the patient; CIR still launches. 

With a patient and visit selected, briefly pause your mouse pointer on the CIR button 
to view a pop-up message that shows the number of reconciled documents versus the 
total number of documents. 

 
Figure 3-18: Reconciled Message 

3.3.2 Orientation 
The CIR Tool contains the following panes, tabs, columns, and buttons. A description  
of their functionality follows. 

 
Figure 3-19: CIR Tool Main Window with Problems Tab Selected 
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3.3.2.1 Panes 
The CIR Tool main window contains the following panes: 

• Generated by CCDA pane: Contains a list of received and potentially reconciled, 
Continuity of Care Document Architecture documents (Clinical Summaries). The 
Generated by CCDA pane can be sorted by selecting one of the following sources 
from the CCDA Source drop-down menu: 

− Patient 
− Bag of Pills 
− Spouse 
− Legal Guardian 
− Paper Document 

If no CCDA document is available, the ability to select an information source 
and reconcile the chart can be completed selecting one of the sources listed . 

• RPMS pane: Contains the native list from RPMS of Medications, Problems, or 
Adverse Reactions, depending on which tab is selected. 

• Clinical Document pane: Depending on the Class of the Generated by CCDA 
document selected, the following is displayed in the Clinical Document pane: 

− CCD (Continuity of Care Document): Contains the preview of the Patient 
Summary. 

− CCR (Continuity of Care Record): Contains the preview of the CCR. 
− CCDA (Consolidated Clinical Document Architecture): Contains the 

reconciled list of Problems, Adverse Reactions, or Medications, depending on 
which tab is selected in the RPMS pane. 

− PDF (Portable Document Format): Contains a preview of the generated .pdf 
file. 

• Reconciled pane: At initial launch, contains only RPMS data. During the 
reconciliation process, additions and changes to medications, Problems, Adverse 
Reactions, or the CCDA data list, depending on which tab is selected in the 
RPMS pane, is updated into this pane from both RPMS and the Generated by 
CCDA pane. 

Note: The panes can be re-sized, as needed, by dragging the 
splitter bar. 

3.3.3 Tabs 
The RPMS pane contains the following three tabs. When a tab is selected, the Clinical 
Document and Reconciled panes refresh with the applicable data, A document must 
be selected in the Generated by CCDA pane. Clear a document selection in the 
Generated by CCDA pane by double-clicking on the check box. 
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Click the applicable link to view instructions for working with these tabs. 

• Problems Tab 

• Adverse Reactions Tab 

• Medications Tab 
Columns can be sorted alphabetically or chronologically by clicking the column 
header. Refer to the applicable tabs section (Problems Tab, Adverse Reactions 
Tabadversereactions_adverse_reactio_4708, and Medications Tab) to view 
information about the RPMS pane, Clinical Document pane, and Reconciled pane 
columns. 

3.3.3.1 Generated By CCDA Pane Columns 
The Generated By CCDA pane contains the following columns: 

• Select: Contains a check box that is selected to view a particular reconciled 
document's details. 

• Source: Displays the source of the document, for example, the name of the clinic 
or Scanned List. 

• Responsible Party: Provider name. 

• Type: Provider type. 

• Encounter Date: Date of the encounter or visit. 

• Created: Date and time the document was created. 

• Class: The document types include CCDA, CCD, PDF, or CCR. 

• Reconciled: Date of the reconciliation. The Problem reconciliations are noted 
with a P before the date, Adverse Reaction reconciliations are noted with an A, 
and Medication reconciliations are noted with an M. For example, M(10/18/2013) 
indicates the Medications were reconciled on October 18th. 

3.3.3.2 Right-Click Menus 
3.3.3.2.1 Generated by CCDA Pane 

Depending on the document Class in this pane, the right-click menus appear as 
follows: 

• CCD: Right-click in a CCD item to select to view the full CCD. 

 
Figure 3-20: CCD Right-Click Menu 

• CCR: Right-click in a CCR item to select to view the full CCR. 
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Figure 3-21: CCR Right-Click Menu 

• CCDA: Right-click in a CCDA item and select to view the full CCDA or specific 
sections of the CCDA only. For example, you can select Advance Directives from 
the right-click menu to view only the Advance Directives section of the CCDA. 

 
Figure 3-22: CCDA Right-Click Menu 

• PDF: Right-click in a PDF item to View Details. 

 
Figure 3-23: PDF Right-Click Menu 

The PDF Viewer window opens, showing a preview of the generated .pdf file. 
Refer to the PDF Viewer Task Bar topic for details on how to use the task bar that 
appears when you pause your mouse pointer over the document, as shown in 
Figure 3-24. 
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Figure 3-24: PDF Viewer 

The right-click menus of the RPMS, Clinical Document, and Reconciled panes 
change depending on which tab (Problems tab, Adverse Reactions tab, or 
Medications tab) is selected. Refer to those topics for details. 

3.3.3.3 Buttons 
• Restore button: Located in the top-left portion of the CIR Tool window. Click this 

button to restore the original order of the RPMS pane. For example, if the user 
manually sorts by clicking a column heading, clicking the Restore button re-sorts 
the items back to their original order. Refer to the Problems tab, Adverse 
Reactions tab, or Medications tab, topics for details. 

• Accept All button: Located in the top-right portion of the CIR Tool window. 
Click this button to accept and sign reconciled problems, adverse reactions, and 
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medications, or a combination of these that the user completed. Otherwise, each 
tab can only be reconciled individually. 

• Cancel button: Closes the CIR tool. 

• Maximize button: Click this button ( ) in the RPMS or Clinical Document pane 
next an item to view additional details, such as Problem ID, Status, Description, 
and so on. 

 
Figure 3-25: Expand Details 

3.3.4 Problems Tab 
Problems may be reconciled by a nurse, pharmacist, provider, or case manager at 
triage. Reconciliation takes place at the time of provider appointment, pharmacy 
medication pickup or pharmacy medication management visit, or Public Health Nurse 
(PHN) or case manager visit. 

Problems are reviewed and reconciled from externally received CCDA documents, 
for example, paper copies of clinical summaries, patient history, or transition of care 
xmls. 

An example of the Problems tab and corresponding Clinical Document and 
Reconciled panes is shown in Figure 3-26. 
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Figure 3-26: CIR Tool Problems Tab 

3.3.4.1 RPMS Pane 
The problems listed in the RPMS pane that have a match (by SNOMED CT Concept 
ID and/or by name) on incoming lists are highlighted in green when a user selects a 
matching event from the RPMS or CCDA pane. If a problem is not yet SNOMED CT 
coded, an asterisk shows before the problem name. 

Note: To de-select matching events, press Ctrl and click. 

3.3.4.1.1 Columns 
When the Problems tab is clicked, the RPMS pane shows the following columns: 

• Problem: Description of problem 

• Status: Chronic, Episodic, and so on 

• Onset: Date and time of problem onset 

• Last Date: Date of last modification or the date entered 
The problems are listed by reverse chronological Last Date order if there are no 
matching problems from the Generated by CCDA pane. You can sort the items by 
clicking any of the column headings. Click the Restore button to restore the original 
order. 

3.3.4.1.2 Right-Click Menu 
Note: The right-click menu only appears and applies if a CCDA 

Class item is selected in the Generated by CCDA pane. 
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The right-click menu of the Problems tab RPMS pane contains the following 
commands: 

 
Figure 3-27: Problem RPMS Right-Click Menu 

• Change: The Reconcile RPMS Problem dialog opens. Refer to the Reconciling 
RPMS Problems topic for details. 

• Reviewed, No Action: The Problem shows as RPMS Reviewed, No Action in the 
Reconciled Problems pane, Action column. 

• View Details: The View Problem Details dialog opens. Any highlighted items 
from the main screen containing RPMS Pane and CCDA data display in a side-by 
side comparison when this menu option is selected. The View Problem Details 
dialog also has a right-click menu of the following options, as shown in Figure 
3-28. Refer to the applicable sections in this Help for details. 

 
Figure 3-28: View Problem Details dialog 

• Entered in Error: The Delete RPMS Problem dialog opens. 
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Figure 3-29Delete RPMS Problem dialog 

1. In Reason for deleting the problem, select one of the option buttons: 

• Duplicate 

• Entered in Error 

• Other 

2. If Other is selected, type a reason in the free-text field. 

3. Click OK. The Reconciled Problems pane is updated with an RPMS Entered in 
Error status in the Action column for the problem. 

3.3.4.2 Clinical Document Pane 
3.3.4.2.1 Columns 

The Clinical Document pane shows the following columns, indicating Problem data: 

• Problem: Problem name. 

• Status: Active, inactive, and so on. 

• Onset: Date of onset. 

• Source: Clinician who entered the problem. 

• Last Date: Date of last modification or the date entered. 

Note: If a PDF Class item is selected in the Generated by CCDA 
pane, the Clinical Document pane shows the PDF 
document from CCDA, and the Add buttons in the 
Reconciliation pane are utilized to add the PDF CCDA 
content to RPMS. 

3.3.4.2.2 Right-Click Menu 
Note: The right-click menu only appears and applies if a CCDA 

Class item is selected in the Generated by CCDA pane. 
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The right-click menu of the Problems tab Clinical Document pane contains the 
following commands: 

 
Figure 3-30: Clinical Document Right-Click Menu 

• Add: The Add CCDA Problem dialog opens. Refer to the Adding Problems from 
Reconciled Problems Pane topic for details. 

• Do Not Add, Redundant: The Problem shows as RPMS Reviewed, No Action, 
CCDA Do Not Add, Redundant in the Reconciled Problems pane, Action column. 

• Do Not Add, Not Clinically Significant: The Problem shows as RPMS Reviewed, 
No Action, CCDA Do Not Add, Not Clinically Significant in the Reconciled 
Problems pane, Action column. 

• View Details: The View Problem Details dialog opens. 

3.3.4.3 Reconciled Problems Pane 
3.3.4.3.1 Columns 

The Reconciled Problems pane shows the following columns, indicating Problem 
reconciliation data: 

• Problem: Problem name. 

• Status: Status applied to the problem. 

• Onset: Date of onset. 

• Action: Action taken in the Clinical Document pane. 

Note: There is no right-click menu in the Reconciled Problems 
pane. At initial launch, the Reconciled Problems pane 
displays all RPMS entries currently for the patient as 
Reviewed, No Action. Instead of using a right-click menu, 
items can be changed by using the options in the RPMS 
pane. 
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3.3.4.3.2 Buttons 
The Reconciled Problems pane contains the following buttons: 

Add Problem button: The Add Problem dialog opens. Refer to the Adding CCDA 
Problems topic for details. 

Accept Problems button: The Review/Sign Changes for Patient Name dialog opens. 

 
Figure 3-31: Review/Sign Changes for Patient Name dialog 

1. The CIR Reconciled Problems list in the dialog is pre-selected by default. 

2. In the Electronic Signature Code field, type your code, and then click Sign. Your 
signature is applied to the selected items. 

Cancel button: Cancels the action. 

3.3.5 Adding CCDA Problems 
Add a CCDA Problem from the Clinical Document right-click menu by clicking the 
Add option. The Add CCDA Problem dialog opens. The following fields are pre-
populated in the Add CCDA Problem dialog: 

• SNOME CT code 

• Date of Onset 

• Status is Episodic by default 

• A canned Comment 
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Figure 3-32: Completed Add CCDA Problem dialog 

Note: Required fields are indicated by an asterisk and are shown 
in a gray section. 

1. In Priority, click the Up and Down arrows to select the applicable priority, from 
1-5. 

Note: The Pregnancy Related and Use as POV check boxes are 
disabled. 

2. In the SNOMED CT field, if you need to changed the problem, type the problem 
in the blank field and click the Ellipsis button to search for the SNOMED CT 
term. The SNOMED CT Lookup dialog opens. Refer to the Adding Problems 
from Reconciled Problems Pane topic for details on completing this dialog. 

Note: Refer to the Using the Pick List Button for details on using 
the Pick List button from the Add CCDA Problem dialog. 
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Figure 3-33: SNOMED CT dialog 

3. In Status, select the applicable option button: 

• Chronic 

• Sub-acute 

• Episodic (default) 

• Social/Environmental 

• Inactive 

• Personal Hx 

4. In Provider Text, type any additional instructions. 

Note: You can briefly rest your mouse pointer over some of the 
fields to view instructions for that field. 

5. In Severity, select one of the following from the drop-down menu: 

• Fatal 

• Life threatening severity 

• Mild 

• Mild to Moderate 
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• Moderate 

• Moderate to Severe 

• Severe 

6. In Clinical Course, click the Ellipsis button. The Select Clinical Courses dialog 
opens. Select one or more of applicable check boxes: 

 
Figure 3-34: Select Clinical Courses dialog 

Note: The Clinical Course field in the Add CCDA Problem 
dialog contains a red triangle in the top-right corner to 
indicate when entries exist in the field. 

7. In Date of Onset, the date auto-fills from RPMS. Click the Ellipsis button to 
change the date by selecting a new date from the calendar, if needed. 

8. In Comments, type a comment. 

9. Click Save in the top-right portion of the Add CCDA Problem dialog. Your 
changes are saved, and the Reconciled Problems pane shows a CCDA: Add 
Problem status in the Action column. 

If the added values match an existing entry, the Action column states, RPMS: 
Reviewed, No Action, CCDA do not add, redundant. 

3.3.6 Adding Problems from Reconciled Problems Pane 
Add a problem from the Reconciled Problems pane by clicking the Add Problem 
button. The Add Problem dialog opens. 

 
Figure 3-35: Add Problem dialog from Reconciled Problems Pane 

1. In the blank field next to the Ellipsis button, type the problem name, and then 
click the Ellipsis button. The SNOMED CT Lookup dialog opens with the Search 
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field populated with your selection and a list of matching SNOMED CT terms in 
the list. 

Note: If needed, refer to the Using the Pick List Button for details 
on using the Pick List button from the Add Problem dialog. 

 
Figure 3-36: SNOMED CT dialog 

a. If the term you are looking is not in the list, select the Synonym option button. 
(Fully specified name is the default.) 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the Expand button ( ) next to the term to expand and view the child 
entries. 

• Synonym returns the full list of SNOMED CT terms. 
b. In Maximum Results, select one of the following to limit the number of 

returned results (or select ALL): 

• 25 (default) 

• 50 

• 100 

• 200 
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• ALL 
c. In Search Date, the field defaults to the current date. Click the drop-down 

arrow to open the calendar and select a different date to search, if needed. 

d. In Search, you can type a different term by which you want to search. 

e. In Subset, you can select a subset in which to search, if needed. 

f. Click either the IHS SNOMED CT or the ALL SNOMED CT button. The list 
of SNOMED CT terms is populated. 

g. Select and highlight a term, and then click the Select button. The Add 
Problem dialog opens with the SNOMED CT field populated with the 
SNOMED CT term you selected. 

2. In Status, select the applicable option button: 

3. In Provider Text, type any additional instructions. 

Note: You can briefly rest your mouse pointer over some of the 
fields to view instructions for that field. 

4. In Severity, select one of the following from the drop-down menu: 

• Fatal 

• Life threatening severity 

• Mild 

• Mild to moderate 

• Moderate 

• Moderate to Severe 

• Severe 

5. In Clinical Course, click the Ellipsis button. The Select Clinical Courses dialog 
opens. Select one or more of applicable check boxes: 

 
Figure 3-37: Select Clinical Courses dialog 

6. In Date of Onset, the date auto-fills from RPMS. Click the Ellipsis button to 
change the date by selecting a new date from the calendar, if needed. 

7. In Comments, type a comment in the field. 
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8. Click Save in the top-right portion of the Add CCDA Problem dialog. Your 
changes are saved, and the Reconciled Problems pane shows a CCDA: Add 
Problem status in the Action column. 

3.3.7 Changing RPMS Problems 
From the PRMS Pane right-click menu, if the Change option is selected, the Edit 
Problem dialog opens. The following steps show how to complete the dialog. 

Note: Required fields are indicated by an asterisk and are shown 
in a gray section. 

 
Figure 3-38: Edit Problem dialog 

1. In Priority, click the Up and Down arrows to select the applicable priority, from 
1-5. 

2. In the SNOMED CT field, the selected problem is auto-populated. Click the 
Ellipsis button to search for the SNOMED CT term. The SNOMED CT Lookup 
dialog opens. 
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Figure 3-39: SNOMED CT dialog 

a. In the SNOMED CT lookup dialog, in the Diagnosis Lookup section, select 
either the Fully specified name or Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the Maximize button next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 
b. In Maximum Results, select one of the following to limit the number of 

returned results (or select ALL): 

• 25 

• 50 

• 100 

• 200 

• ALL 
c. In Search Date, the field defaults to the current date. Click the drop-down 

arrow to open the calendar and select a different date to search, if needed. 

d. In Search, type the term by which you want to search. 

e. In Subset, you can select a subset in which to search, if needed. 
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f. Click either the IHS SNOMED CT or the ALL SNOMED CT button. The list 
of SNOMED CT terms is populated. 

g. Select and highlight a term, and then click the Select button. The 
SNOMED CT field refreshes with the selected SNOMED CT term you 
selected. 

If the Problem is International Classification of Diseases (ICD) coded but not 
SNOMED CT coded, click the Get SCT button. Refer to the Using the Get SCT 
Button topic for details. 

3. In Status, select the applicable option button: 

• Chronic 

• Sub-acute 

• Episodic 

• Social/Environmental 

• Inactive 

• Personal Hx 

4. In Provider Text, type any additional instructions. 

Note: You can briefly rest your mouse pointer over some of the 
fields to view instructions for that field. 

5. In Severity, select one of the following from the drop-down menu: 

• Fatal 

• Life threatening severity 

• Mild 

• Mild to Moderate 

• Moderate 

• Moderate to Severe 

• Severe 
6. In Clinical Course, click the Ellipsis button. The Select Clinical Courses dialog 

opens. 

7. Select one or more of applicable check boxes: 
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Figure 3-40: Select Clinical Courses dialog 

8. In Date of Onset, the date auto-fills from RPMS. Click the Ellipsis button to 
change the date by selecting a new date from the calendar, if needed. 

9. In Comments, type a comment in the field. 

10. Click Save in the top-right portion of the Reconcile RPMS Problem dialog. Your 
changes are saved and the Reconciled Problems pane shows an RPMS Changed 
status in the Action column. 

3.3.8 Using the Get SCT Button 
The Get SCT button takes the ICD code from a historical entry that is not 
SNOMED CT coded (indicated by an asterisk in the Problem Name column of the 
RPMS pane), launches to Apelon, and displays a list of SNOMED CT codes that are 
mapped to that ICD. 

Note: The Get SCT button is only active when a Problem line 
item does not have a SNOMED CT code assigned yet. 

To add a SNOMED CT code to a problem, follow these steps: 

1. From the Reconcile RPMS Problem dialog, click the Get SCT button. The ICD 9 
to SNOMED CT Lookup dialog opens. 

 
Figure 3-41: ICD 9 to SNOMED CT Lookup dialog 
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2. The Search Date field automatically defaults to the current date. Click the drop-
down arrow to open the calendar where a new date can be selected. 

3. The ICD 9 Value field is automatically populated with the ICD code from the 
RPMS Problem selected when the Get SCT button is clicked. You can change this 
by typing in a new code. 

4. Click the Find button. The list of SNOMED CT terms is populated. 

5. Select and highlight a SNOMED CT concept term, and then click the Select 
button. The SNOMED CT code is saved to the entry and the asterisk on the 
Problem in the RPMS pane is cleared. 

3.3.9 Using the Pick List Button 
When adding CCDA problems or adding problems from the reconciled problems 
pane, the Pick List button on the Add CCDA Problem or the Add Problem dialog can 
be used to narrow the results of a SNOMED CT search. 

 
Figure 3-42: Add CCDA Problem dialog with Pick List Button 

 
Figure 3-43: Add Problem dialog with Pick List Problem 
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The Pick List button opens the Pick List dialog where the user can choose 
SNOMED CT descriptions by defined lists. Pick list entries may include associated 
qualifiers. 

1. Click the Pick List button. The Picklist Selection dialog opens. 

 
Figure 3-44: Picklist Selection dialog 

Note: The Manage Pick Lists button is currently disabled. 

2. The Picklist column, select one or more pick lists. The SNOMED CT Description 
column refreshes with the pick list you selected. 

Note: Both the pick lists and their items are in alphabetical order. 

3. Click Save. The Pick List disables any problem that is a duplicate and already on 
the patient's problem list. 
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3.3.10 Adverse Reactions Tab 
Adverse reactions or allergies may be reconciled by a nurse, pharmacist, provider, or 
case manager at triage, at time of provider appointment, at pharmacy medication 
pickup or pharmacy medication management visit, or at PHN or case manager visit. 

Adverse reactions are reviewed and reconciled from externally received CCDA 
documents, paper copies of clinical summaries, patient history, and so on. 

An example of the Adverse Reactions tab and corresponding Clinical Document and 
Reconciled panes is shown in Figure 3-45. 

Reactants that have a match by RxNorm (primary search, secondary search for exact 
text) on incoming lists are shown highlighted in green. To de-select any of the 
highlighted reactants, press Ctrl and click. 

Note: Matching occurs on the first word of a multiple-word name. 
For example, with potassium sulfate, it tries to match 
potassium. 

 
Figure 3-45: CIR Tool Adverse Reactions Tab Main Window 
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3.3.10.1 RPMS Pane 
3.3.10.1.1 Columns 

When the Adverse Reactions tab is clicked, the RPMS pane shows the following 
columns: 

• Causative Agent: Medication or substance which causes the adverse 
reaction/allergy. 

• Event: Name and SNOMED CT code of adverse reaction. 

• Symptoms: Description of symptoms and date and time of symptom(s) onset. 

• Status: Whether the adverse reaction is active, inactive, and so on. 

• Last Date: Date of last modification or the date entered. 

3.3.10.1.2 Right-Click Menu 
Note: The right-click menu only appears and applies if a CCDA 

Class item is selected in the Generated by CCDA pane. 

The right-click menu of the Adverse Reactions tab RPMS pane contains the following 
commands: 

 
Figure 3-46: Adverse Reaction RPMS Right-Click Menu 

• Change: The pre-populated Edit Adverse Reaction dialog opens. Change the 
applicable fields, as needed. 
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Figure 3-47: Edit Adverse Reaction dialog 

1. The Causative Agent field auto-populates with your selection from the RPMS 
pane. If needed, type a different causative agent in the field and then click the 
Ellipsis button. The list updates with your search results. 

2. In the Nature of Reaction field, select one of the following from the drop-down 
menu: 

• Allergy 

• Pharmacological 

• Unknown 
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3. In the Event Code field, select one of the following from the drop-down menu: 

• Allergy to Substance 

• Drug Allergy 

• Drug Intolerance 

• Food Allergy 

• Food Intolerance 

• Propensity to Adverse Reactions 

• Propensity to Adverse Reactions to Drug 

• Propensity to Adverse Reactions to Food 

• Propensity to Adverse Reactions to Substance 
4. In the Source of Information field, select one of the following from the drop-down 

menu: 

• Patient 

• Spouse 

• Family 

• Friend 

• Other Source 

• Chart Review 

• Medical Provider 

• External Source 

• Other Medical Provider 

5. In the Signs/Symptoms section, in the Available field, select one or more 
applicable symptoms. As you click, they are moved to the Selected field. 

Note: You can click the Move ( ) arrows to remove all of the 
selected symptoms. 

6. In the Source (of Signs/Symptoms) field, select one of the drop-down menu 
options, as listed in Step 4. 

7. In Date/Time, the default is the current date and time. Click the Ellipsis button to 
open the Select Date/Time dialog. Do any of the following: 
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Figure 3-48: Select Date/Time dialog 

• Select the applicable date and time from the calendar and time sliding scales 
and then click OK. 

• Click the Today button to automatically input the current date, and then click 
OK. 

• Click the Now button to automatically input the current date and time, and 
then click OK. 

• Click the Midnight button to reset the time sliding scale, select a new 
date/time, and then click OK. 

8. Select the Imprecise Date dialog, if the exact time is not known. 

9. Click OK. The Adverse Reaction is updated with your changes in the Reconciled 
Adverse Reactions pane and shows RPMS: Changed, No Action in the Action 
column. 

Note: If any of the required fields are not populated when OK is 
clicked, a warning message appears to complete the 
applicable field. 

• RPMS: Reviewed, No Action: The Adverse Reaction shows as RPMS 
Reviewed, No Action in the Reconciled Problems pane, Action column. 

• Entered in Error: The Entered in Error dialog opens. 
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Figure 3-49: Allergy Entered in Error dialog 

10. In the field, type a reason for the error. 

11. Click OK. The Reconciled Adverse Reactions pane is updated with an RPMS: 
Entered in Error status in the Action column for the allergy. 

• Inactivate: Contains the following sub-selections: 
– No Longer Allergic: Patient is no longer allergic. 
– Reaction is Tolerable: Patient's reaction is tolerable. 

Note: If an inactive Adverse Reaction is selected, the Inactivate 
command changes to Reactivate. 

• View Details: The View Allergy Details dialog opens. Any highlighted items 
from the main screen containing RPMS Pane and CCDA data display in a 
side-by side comparison when this menu option is selected. The View Allergy 
Details dialog also has a right-click menu of the following options, as shown 
in Figure 3-50. Refer to the applicable sections in this Help for details. 
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Figure 3-50: View Allergy Details dialog 

3.3.10.2 Clinical Document Pane 
3.3.10.2.1 Columns 

The Clinical Document pane shows the following columns, indicating Adverse 
Reactions data: 

• Causative Agent: The cause of the adverse reaction. 

• Event: Name of the adverse reaction event. 

• Symptom: Description of symptoms. 

• Status: Whether Active, Inactive, and so on. 

• Source: Clinician who entered the adverse reaction. 

• Last Date: Date of last modification or the date entered. 

3.3.10.2.2 Right-Click Menu 
Note: The right-click menu only appears and applies if a CCDA 

Class item is selected in the Generated by CCDA pane. 
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The right-click menu of the Adverse Reactions tab Clinical Document pane contains 
the following commands: 

 
Figure 3-51: Adverse Reaction Clinical Document Right-Click Menu 

• Add: The Create Adverse Reaction dialog opens. Refer to the Adding Adverse 
Reactions topic for details. 

Note: If Add is selected and an entry already exists, a warning 
message appears. Select another Adverse Reaction. The 
system will not allow you to add a duplicate allergen. 

• CCDA: Do not add, redundant: The allergy shows as RPMS Reviewed, No 
Action, CCDA Do Not Add, Redundant in the Reconciled Adverse Reactions 
pane, Action column. 

• CCDA: Do not add, not clinically significant: The allergy shows as RPMS 
Reviewed, No Action, CCDA Do Not Add, Not Clinically Significant in the 
Reconciled Adverse Reactions pane, Action column. 

• View Details: The View Allergy Details dialog opens. 

3.3.10.3 Reconciled Adverse Reactions Pane 
3.3.10.3.1 Columns 

The Reconciled Adverse Reactions pane shows the following columns, indicating 
Adverse Reaction reconciliation data: 

• Causative Agent: Name of allergen, whether a drug name, food, or substance. 

• Event: Shows the SNOMED CT code for the adverse reaction. For example, Drug 
Allergy 416098002. 

• Symptoms: The patient's symptoms when exposed to the allergen. 

• Action: What reconciliation action was taken, for example, RPMS: Changed, or 
CCDA: Add. 

Note: There are no right-click menu options in the Reconcile 
pane. 
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3.3.10.3.2 Buttons 
The Reconciled Adverse Reactions pane contains the following buttons: 

• Add Allergy Button: The Create Adverse Reaction dialog opens. Refer to the 
Adding Adverse Reactions topic for details. 

• Accept Adverse Reactions Button: The Review/Sign Changes for Patient Name 
dialog opens. 

1. The items in the CIR Adverse Reaction Reconciliation list in the dialog are pre-
selected by default. Clear any items you don' t want to include for signature. 

2. In the Electronic Signature Code field, type your code, and then click Sign. Your 
signature is applied to the selected items. 

 
Figure 3-52: Review/Sign Changes for Patient Name dialog 

If there are issues with any of the adverse reaction entries, the Order Checking - 
Source: IHS dialog may open instead. For Adverse Reactions, this is an 
informational dialog and may not require action from the user. 
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Figure 3-53: Order Checking – Source: IHS dialog when Accepting Adverse Reactions 

3. Review the data, and then click OK. The Order Checking - Source: IHS dialog 
closes and the Review/Sign Changes for Patient Name opens. 

4. Repeat Steps 1 and 2. 

• Cancel Button: Cancels the action. 

3.3.11 Adding Adverse Reactions 
From the Clinical Document right-click menu, if the Add option is selected or when 
the Add Allergy button is clicked from the Reconciled Adverse Reactions pane, the 
Create Adverse Reaction dialog opens. 

Note: If the Add Allergy button is used, the Create Adverse 
Reaction dialog is not pre-filled. If the Clinical Document 
right-click Add is used, the Create Adverse reaction dialog 
opens pre-filled with some allergy data. 
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The steps that follow show how to complete the Create Adverse Reaction dialog: 

 
Figure 3-54: Completed Create Adverse Reaction dialog 

1. The Causative Agent field is either blank if being added from the Reconciled 
Adverse Reactions pane, or auto-populates with your selection from the Clinical 
Document pane. If blank, type an allergen in the field, and then click the Ellipsis 
button. Any matches show in the field below. Select one. 

2. In the Nature of Reaction field, select one of the following from the drop-down 
menu: 

• Allergy (default) 
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• Pharmacological 

• Unknown 

3. In the Event Code field, select one of the following from the drop-down menu: 

• Allergy to Substance 

• Drug Allergy 

• Drug Intolerance 

• Food Allergy 

• Food Intolerance 

• Propensity to Adverse Reactions 

• Propensity to Adverse Reactions to Drug 

• Propensity to Adverse Reactions to Food 

• Propensity to Adverse Reactions to Substance 
4. In the Source of Information field, select one of the following from the drop-down 

menu: 

• Patient 

• Spouse 

• Family 

• Friend 

• Other Source 

• Chart Review 

• Medical Provider 

• External Source 

• Other Medical Provider 
5. In the Signs/Symptoms section, in the Available field, select one or more 

applicable symptoms. As you click, they are moved to the Selected field. 

Note: You can click the Move arrows to remove all of the 
selected symptoms. 

6. In the Source (of Signs/Symptoms) field, select one of the drop-down menu 
options, as listed in Step 4. 

7. In Date/Time, type a date and time, or click the Ellipsis button to open the Select 
Date/Time dialog. Do any of the following: 
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Figure 3-55: Select Date/Time dialog 

• Select the applicable date and time from the calendar and time sliding scales 
and click OK. 

• Click the Now button from the Select Date/Time dialog to automatically input 
the current date and time, and then click OK. 

• Click the Midnight button to reset the time sliding scale, select a new 
date/time, and then click OK. 

8. Select the Imprecise Date dialog, if the exact time is not known. 

9. The Comments auto-populates with a canned comment if the Clinical Document 
right-click menu, Add option is selected. Type a new comment, if needed. 

10. Click OK. The Adverse Reaction is updated with your changes in the Reconciled 
Adverse Reactions pane, indicated by CCDA: Add in the Action column. 

Note: If any of the required fields are not populated when OK is 
clicked, a warning message appears to complete the 
applicable field. 

3.3.12 Medications Tab 
CIR enables the reconciliation of a patient's medication orders to all of the 
medications the patient has been taking to avoid medication errors such as omissions, 
duplications, dosing errors, or drug interactions. 

A reconciliation should be performed at every transition of care in which new 
medications are ordered or existing orders are rewritten. The reconciliation may be 
done at triage, at time of provider appointment, pharmacy medication pickup or 
pharmacy medication management visit, or PHN or case manager visit. 
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An example of the Medications tab and corresponding Clinical Document and 
Reconciled Medications panes is shown in Figure 3-56. 

 
Figure 3-56: Medications Tab and Corresponding Panes 

3.3.12.1 RPMS Pane 
Medications that have a match by first word of medication (by RxNorm primary 
search, or NDC if no RxNorm match in EHR list) are shown highlighted in green and 
may be reconciled using the Change option in the right-click menu. 

Note: To de-select matching events, press Ctrl and click. 

The RPMS pane contains the following functionality: 

3.3.12.1.1 Columns 
When the Medications Tab is clicked, the RPMS pane shows the following columns: 

• Type: Outpatient (OP), or Non-VA (NV). 

• Medication: Medication name, strength, formula, class. Medications are sorted 
alphabetically, then by issued or last fill date. 

• Description: Dosing information. 

• Status: Whether the medication is Active, Pending, Hold, or Expired. 

• Last Date: Date of last modification or the date entered. 
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3.3.12.1.2 Right-Click Menu 
Note: The right-click menu only appears and applies if a CCDA 

Class item is selected in the Generated by CCDA pane. 

The right-click menu of the Medications tab RPMS pane contains the following 
commands: 

 
Figure 3-57: Medications RPMS Right-Click Menu 

• Change: The pre-populated Edit Medication dialog opens. Complete your changes 
and then click Accept Order. Refer to the Medications Online Help for details on 
completing this dialog. 

• Discontinue: The Discontinue Order dialog opens. Refer to the Discontinuing 
Medication Orders topic for instructions on completing this dialog. 

• Reviewed, No Action: The Medication shows as RPMS Reviewed, No Action in 
the Reconciled Medications pane, Action column. 

• Renew: The Order Checking - Source: Veterans Health Administration dialog 
opens, showing the applicable medications. 

• Click Accept Order. The Renew Order dialog opens. Refer to the Renewing 
Medication Orders topic for details. 

• Click Cancel Order. The order is cancelled. 

Note: If the order cannot be renewed, an Unable to Renew Order 
warning message opens. Click OK. 

• View Details: The View Medication Details dialog opens. Any highlighted items 
from the main screen containing RPMS Pane and CCDA data display in a side-by 
side comparison when this menu option is selected. The View Medication Details 
dialog also has a right-click menu of the following options, as shown in Figure 
3-58. Refer to the applicable sections in this Help for details. 
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Figure 3-58: View Medication Details dialog 

3.3.12.2 Clinical Document Pane 
3.3.12.2.1 Columns 

The Clinical Document pane shows the following columns, indicating Medication 
data: 

• Medication: Medication name 

• Description: Dosage information 

• Status: Whether the medication is Active, Pending, Hold, or Expired 

• Source: Clinician who prescribed the medication 

• Last Date: Date of last modification or the date entered 

3.3.12.2.2 Right-Click Menu 
Note: The right-click menu only appears and applies if a CCDA 

Class item is selected in the Generated by CCDA pane. 

 
Figure 3-59: Medications Clinical Document Right-Click Menu 
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• Add Outside: The Add Non-VA Medication dialog opens. Refer to the Adding 
Non-VA Medications topic for details. 

• Add OP: The Add Outpatient Medication dialog opens. Refer to the Adding 
Outpatient Medications topic for details. 

• Do Not Add, Discontinued: Medication has been discontinued and should not be 
added. The medication shows as RPMS Reviewed, No Action, CCDA Do Not 
Add, Discontinued in the Reconciled Medications pane, Action column. 

• Do Not Add, Redundant: Medication is a duplicate and should not be added. The 
medication shows as RPMS Reviewed, No Action, CCDA: Do Not ADD, 
Redundant in the Reconciled Medications pane, Action column. 

• View Details: The View Medication Details dialog opens. 

3.3.12.3 Reconciled Medications Pane 
3.3.12.3.1 Columns 

The Reconciled Medications pane shows the following columns, indicating 
Medication reconciliation data: 

• Medication: Medication name, strength, formula, class. 

• Description: Dosing information. 

• Status: Whether active, expired, and so on. 

• Action: Indicates whether the medication was reviewed, and what action (or No 
Action) was taken. 

Note: There is no right-click menu in the Generated by CCDA 
pane. 

3.3.12.3.2 Buttons 
The Reconciled Medications pane contains the following buttons: 

Add Outside Medication: The Add Non-VA Medication dialog opens. Refer to the 
Adding Non-VA Medications topic for details. 

Accept OP Medication: The Add Outpatient Medication dialog opens. Refer to the 
Adding Outpatient Medications topic for details. 

Accept Meds: The Review/Sign Changes for Patient Name dialog opens. 

1. The items in the CIR Reconciled Medications list in the dialog are pre-selected by 
default. Clear any items you don' t want to include for signature. 

Note: You may see other items, for example Adverse Reactions 
or other unsigned orders (as shown in Figure 3-60), in the 
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Review/Sign Changes dialog if they were not signed 
previously. 

2. In the Electronic Signature Code field, type your code, and then click Sign. Your 
signature is applied to the selected items. 

 
Figure 3-60: Review/Sign Changes for Patient Name dialog 

If there are issues with any of the medication entries, for example, duplicate 
orders, the Order Checking - Source dialog may open instead. For high alerts on 
medications, this may require action from the user. 
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Figure 3-61: Order Checking – Source dialog when Accepting Medications 

3. Review the data, and then click OK. The Order Checking - Source: IHS dialog 
closes and the Review/Sign Changes for Patient Name opens. 

Note: You may need to correct any medication issues first, as 
necessary, and then sign the orders. 

4. Repeat Steps 1 and 2. 

Cancel: Cancels the action. 

3.3.13 Adding Non-VA Medications 
From the Medications Clinical Document right-click menu, if the Add Outside option 
is selected or when the Add Outside Medication button is clicked from the 
Reconciled Medications pane, the Add Non-VA Medication dialog opens. 

Note: If the Add Outside Medication button is used, the Add 
Non-VA Medication dialog is not pre-filled. If the Clinical 
Document right-click Add is used, the Add Non-VA 
Medication dialog opens pre-filled with some data. 
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To complete the Add Non-VA Medication dialog: 

 
Figure 3-62: Completed Non-VA Medication dialog 

1. The Medication field auto-populates with the medication selected in the Clinical 
Document pane if the right-click menu is used. If the Add Outside Medication 
button in the Reconciled Medications pane is used, the field is blank. Click the 
Change button to open the Change Medication dialog to add or change a 
medication. 
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Figure 3-63: Change Medication dialog 

a. Scroll thought the list as necessary and select the Medication. 

b. Click OK. The Medication field of the Add Non-VA Medication dialog 
updates with your selection. 

2. In Dose, select a dose from the list. 

3. In Route, select the applicable administration route. 

4. In Schedule, select the applicable dosing schedule from the list. 

5. Select the PRN check box, if applicable. 

6. In Comments, type any comments. 

7. In Statement/Explanation, select one or more of the following check boxes: 

• Outside medication not recommended by provider. 

• Outside medication recommended by provider. 

• Patient buys OTC/Herbal product without medical advice. 

• Medication prescribed by another provider 

8. In Home Medication List Source, click one of the following option buttons: 
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• Patient 

• A list the patient may have 

• Medications themselves 

• Friend 

• Family member 

• Medical record 

• Patient's pharmacy 

• Patient's primary care physician 

• Other 

9. In Medication Reason, type a reason for prescribing a Non-VA medication. 

10. In Location of Medication, click one of the following option buttons: 

• Home 

• Hospital 

• Other 

11. In Start Date, type a date or click the Ellipsis button ( ) to open the Select 
Date/Time dialog. Do any of the following: 

 
Figure 3-64: Select Date/Time dialog 

• Select the applicable date and time from the calendar and time sliding scales 
and click OK. 

• Click the Now button from the Select Date/Time dialog to automatically input 
the current date and time, and then click OK. 

• Click the Midnight button to reset the time sliding scale, select a new 
date/time, and then click OK. 
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12. In Last Dose Taken, type a date or click the Ellipsis button to select a date from 
the calendar. 

13. Click Accept Order. 

3.3.14 Adding Outpatient Medications 
From the Medications Clinical Document right-click menu, if the Add OP option is 
selected or when the Add OP Medication button is clicked from the Reconciled 
Medications pane, the Add Outpatient dialog opens. 

If the Add Op option from the Medications Clinical Document right-click menu is 
used, the Medication field auto-populates with the medication selected in the Clinical 
Document pane. 

If the Add OP Medication button in the Reconciled Medications pane is used, the 
field is blank: 

1. Click the Change button on the Add Outpatient Medication dialog. The Change 
Medication dialog opens. 

 
Figure 3-65: Change Medication dialog 
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2. Type the first few letters of a medication in the field. The list updates with 
matching medications when you stop typing. 

3. Scroll thought the list, as necessary and select the medication you want. 

4. Click OK. The Medication field of the Add Outpatient Medication dialog updates 
with your selection. 

5. Clicking the ADR’s button opens the Patient Postings dialog. Click Done after 
reviewing the ADRs. 

 
Figure 3-66: Patient Posting dialog 

Refer to the Medications Online Help for details on completing Simple and Complex 
Dose Outpatient Medication Orders. 
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Figure 3-67: Completed Add Outpatient Medication dialog 

3.3.15 Renewing Medication Orders 
When the Renew option is selected in the right-click menu of the Medications RPMS 
pane, the Order Checking - Source: Veterans Health Administration dialog opens, 
showing the applicable medications. 

 
Figure 3-68: Order Checking - Source: dialog when Renewing Medication Orders 

• Click Accept Order. The Renew Order dialog opens. Refer to the Medications 
Online Help for details on completing this dialog. 
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• Click Cancel Order. The renewal of the medication is cancelled. 

3.3.16 Discontinuing Medication Orders 
From the Clinical Document Medications right-click menu, if the Discontinue option 
is selected, the Discontinue/Cancel Orders dialog opens. 

 
Figure 3-69: Discontinue/Cancel Orders dialog 

Follow these steps to complete the Discontinue/Cancel Orders dialog: 

1. In the Order section, select the orders to cancel. 

2. In Select a reason, select a reason for cancelling the medication. 

3. Click OK. The Reconciled Medications pane shows an RPMS: Discontinue status 
in the Action column. 

3.4 Integrated Problem List 
The IPL enables the convenient viewing of Problem List data on a main display, 
including: 

• Status 

• Onset Date 

• Provider narrative 

• Comments 

• If the problem was added to the patient's personal history 

• If the problem is Pregnancy Related 

• If the problem was used for an inpatient 

• ICD code 
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3.4.1 Orientation 
At the top of the Problem List screen of the IPL component are the following 
features, buttons, check boxes, and columns, which have the following functionality. 

 
Figure 3-70: IPL Problem List Main Screen 

3.4.1.1 Features 
• An asterisk in the Provider Narrative column indicates problems not 

SNOMED CT encoded. 

• For problems with a non-coded SNOMED CT code, the Edit button and POV 
button is disabled. 

• Viewing Problem Details: Double-click anywhere in a line item to view the 
Problem Details screen. 

• Right-Click Menu: Right-click anywhere on a line item to open the right-click 
menu. Select from: 

− Delete: To delete the line item. Refer to the Deleting an IPL topic for details. 
− Edit: To edit the line item. Opens the Edit Problem dialog. Refer to the 

Editing an IPL topic for details. 
− Get SCT: To update a historical ICD 9 entry. Opens the SNOMED CT 

Lookup dialog. Refer to the Using the Get SCT Button topic for details. 
− POV: To flag an outpatient problem as POV and to flag an inpatient problem 

as used for inpatient. Refer to the Using the POV Button topic for details. 
− Change Status: 

• Chronic 

• Episodic 

• Sub-acute 

• Personal History 

• Inactive 

• Social/Env 
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3.4.1.2 Buttons 
• Expand All/Collapse All button: Enables the user to expand or collapse all 

problems to view the care planning activity. Refer to the Care Plan Feature topic 
for details. 

• Ed button ( ): Click this button for a direct link to MedlinePlus. Refer to the 
Using the Education Information Button topic for details. 

• Information button ( ): Click this button for a direct link to UpToDate. Refer 
to the Using the Web Reference Button topic for details. 

• Get SCT button: Click this button to look up the SNOMED CT code. Refer to the 
Using the Get SCT Button topic for details. 

• POV button: Click the POV button to mark the problem as the POV and to add 
visit, care plan, or goal activity data. 

• PL Pick List button: Click the PL Pick List button to select SNOMED CT 
descriptions by defined pick lists. 

• Add button: Click this button to add a problem. See the Adding an IPL topic for 
details. 

• Edit button: Click this button to edit an existing problem. See the Editing an IPL 
topic for details. 

• Delete button: Click this button to delete a selected problem. See the Deleting an 
IPL topic for details. 

3.4.1.3 Check Boxes 
Select a check box (or multiple check boxes) to filter the problem list(s) associated 
with that status: 

• Chronic 

• Social/Env 

• Episodic 

• Inactive 

• Sub-acute 

• Current/Most Recent Inpatient 

3.4.1.4 Columns 
Columns on the main display screen can be sorted by clicking the column heading, 
added or removed by the user, made wider or narrower by dragging the column 
heading, and set as personal setting. 
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• Ellipsis button: Clicking this button opens the Care Planning information. Refer to 
the Care Planning Feature topic for details on using this feature. 

• Status column: Contains one of the following statuses, as selected by the user. 

− Chronic 
− Social/Env 
− Episodic 
− Inactive 
− Sub-acute 
− Current/Most Recent Inpatient 

• Onset Date column: Contains the date of the problem's onset, as input by the user 
(optional). 

• Provider Narrative column: Contains the data input by the user in the Provider 
Text field. 

• Comments column: Shows any comments typed by the user. 

• PHx column: A check mark in the PHx column indicates if the Personal History 
option was selected and the problem was added to the patient's personal history. 

• PIP column: A check mark in the PIP (Pregnancy Issues and Problems) column 
indicates if the Pregnancy Related option was selected. 

• IP column: A check mark in the IP column indicates if the Use for Inpatient 
option was selected. 

• ICD column: Indicates the mapped ICD code from the selected SNOMED CT 
term. 

3.4.1.5 Problem Details Screen 
You can double-click anywhere in the IPL screen to open the Problem Details dialog. 
This dialog is informational only and provides problem data. 
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Figure 3-71: Problem Details Screen 

3.4.2 Using the Get SCT Button 
These instructions are for the Get SCT button on the main screen to update a 
historical ICD 9 entry. See the Adding an IPL or Editing an IPL topics for 
information on using the Get SCT button from the Add Problem or Edit Problem 
dialogs. 

Note: A visit must be selected. 

1. From the main screen, select a problem line item that does not contain a 
SNOMED CT term and then click the Get SCT button. The ICD 9 to 
SNOMED CT Lookup dialog opens showing all the SNOMED CT codes mapped 
to that ICD 9. 
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Note: Problems that do not contain a SNOMED CT term are 
shown preceded by an asterisk (*). 

 
Figure 3-72: Problem List with Get SCT Button Active 

2. In the ICD 9 to SNOMED CT Lookup dialog, the ICD9 code for the problem 
shows in the ICD 9 Value field, with the related SNOMED CT concepts listed 
below each. Click the Expand button next to the Problem name to expand the 
section to view the list of Synonyms associated with that problem. (Click the 
Collapse button ( ) to collapse.). If needed: 

a. Type a new ICD number in the ICD 9 Value field. 

b. In Subset, select one or multiple subset lists to search. 

c. In Search Date, leave the current date default, or click the drop-down arrow to 
open a calendar from which you can select a new date. 

d. Click Find. The SNOMED CT Concept list refreshes with your findings. 

 
Figure 3-73: ICD-9 to SNOMED CT Lookup 
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3. Select the SNOMED CT line item you want to use, and then click Select. The 
problem updates with the asterisk (*) removed from the problem list, the ICD 
code in the ICD column updates with your selection, and the Get SCT button is no 
longer active for this problem. 

3.4.3 Using the POV Button 
These instructions are for the POV button on the main screen to store the 
SNOMED CT code for an outpatient visit or inpatient discharge diagnosis marked as 
Primary. 

Note: The POV button is only active for problems without an 
associated SNOMED CT code. The POV button is not 
active for problems with an INACTIVE ICD 9 code. 
Inactive problems may be POV. 

Refer to the Adding an IPL or Editing an IPL topics for information on using the 
POV button from the Add Problem or Edit Problem dialogs. 

Note: An unlocked visit must be selected. 

1. From the main screen, select one or more problem line items and then click the 
POV button. The POV dialog opens, which shows the selected problems. 

Note: A red triangle in the upper-right corner of a column 
indicates there are multiple entries. Click in the column to 
expand and view the entries. 

 
Figure 3-74: POV dialog 

2. The ID column shows a system-generated ID. 

3. The Status column shows the selected status for the problem. 

4. The Prov. (Provider) Narrative column contains SNOMED CT concept 
description and provider text. 
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5. The next column either shows a POV or INPT column and check box to indicate 
if the problem is POV or for an inpatient. Clear the check box if you no longer 
want to set the problem as POV or use for inpatient. 

Note: The POV check box can only be selected if a 
SNOMED CT code has been applied to the problem. 

6. The Episodicity column contains the following option buttons. Select or to clear, 
as applicable: 

• First episode 

• New episode 

• Old episode 

• Ongoing episode 

• Undefined episodicity 

7. The following columns have a right-click menu: 

• Prov. Text 

• Goal Notes 

• Care Plans 

• Visit Instructions 

8. Right-click in the column to view the following options: 

Note: Only the available options for a particular column are 
active in the right-click menu, depending on the column 
selected. Various examples follow. 

 
Figure 3-75: POV Right-Click Menu 

• Add: The Add dialog opens. Type your text and click OK. The text shows in 
the column. 
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Figure 3-76:Add dialog 

• Replace: A dialog showing the original text and Replacing text opens. Type 
your new text in the Replacing Text and click OK. The new text shows in the 
column. 

 
Figure 3-77: Replace dialog 

• Inactivate: A dialog showing the item you want to inactivate and a Comment 
field opens. Type a comment, and then click Yes. 

 
Figure 3-78: Inactivate Item dialog 

• Delete: The Delete dialog opens to confirm your deletion. Click OK. 
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Figure 3-79: Delete Confirm dialog 

• Sign: The Review/Sign dialog opens with a list of the items you added for you 
to sign. Type your electronic signature, and then click OK. 

 
Figure 3-80: Review/Sign Changes for Patient Name for POV 

9. Add any free-text information in the Prov. (Provider) Text column by selecting 
Add from the right-click menu. The Provider Text dialog opens. 

 
Figure 3-81: Provider Text dialog 

a. Type provider text to assist with the definition of a problem in the dialog. 
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b. Click OK. 

If Provider Text already exists, the Replace item will be active in the right-
click menu. The Provider Text dialog with (existing) Text and Replacing Text 
fields opens. 

c. Type the new provider text in the Replacing Text field. 

d. Click OK. Your change shows in the Prov. Text column. 

10. The Goal Notes column contains goals set for the patient to improve the problem, 
for example to reduce their cholesterol. You can Add a Goal Note by selecting 
Add from the right-click menu. The Goal Note dialog opens. Click the Template 

button ( ) to select a template, if needed. 

 
Figure 3-82: Goal Notes dialog with Templates Menu 

You can also type over an existing Goal Note by clicking in the text and making 
your changes. 

11. The Care Plans column contains instructions for the patient, for example, walk 
three times per week, and so on. You can add a Care Plan by selecting Add from 
the right-click menu. The Care Plan dialog opens. Click the Template button to 
select a template, if needed. 
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Figure 3-83: Care Plan dialog with Templates Menu 

You can also type over an existing Care Plan by clicking in the text and making 
your changes. 

12. The Visit Instructions column contains patient visit instructions for the selected 
visit. You can add a Visit Instruction by selecting Add from the right-click menu. 
The Visit Instruction dialog opens. Click the Template button to select a template, 
if needed. 

 
Figure 3-84: Visit Instruction dialog with Templates Menu 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual New Components 
September 2014 

83 

You can also type over an existing Visit Instruction by clicking in the text and 
making your changes. 

13. The Pt Ed (Patient Education) column contains the following Subtopic check 
boxes. Select one or more, as applicable: 

• DP (Disease Process) 

• EX (Exercise) 

• LA (Lifestyle Adaptation) 

• MED (Medication) 

• N (Nutrition) 

• P (Prevention) 
14. When a Pt Ed check box is selected, the following fields appear below the 

column. Select the applicable item from the drop-down list or type in the field, as 
applicable: 

• Comprehension Level: 
– Poor 
– Fair 
– Good 
– Group-No Assessment 
– Refused 

• Length (minutes): Type the length of the education in minutes. 

• Readiness to Learn: 
– Distraction 
– Eager to Learn 
– Intoxication 
– Not Ready 
– Pain 
– Receptive 
– Severity of Illness 
– Unreceptive 

15. The Tx/Regimen/FU column contains the Treatment/Regimen button. Click the 
Treatment/Regimen button to open the Treatment/Regimen dialog: 

a. Click the Expand button next to the applicable list heading to view the 
options. Other is shown in the example. 
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Figure 3-85: Treatment/Regimen dialog With Alcohol Abuse Expanded 

b. Select one or more check boxes to indicate the Treatment or Regimen for the 
patient. 

c. Click OK. The Tx/Regimen/FU Display Only column updates with your 
selection. 

16. The Tx/Regimen/FU display only column shows the Visit Instructions, Patient 
Education, and Tx/Regimen/FU information. For example, Given a Visit 
Instruction: exercise three times per week, Had Disease Process education, 
Follow-up: arranged. If data is added to any of these items, for example, an 
additional Patient Education is selected, the Tx/Regimen/FU display only column 
updates with the new data. 

17. The Primary POV drop-down menu contains a list of the patient's POVs. Select 
the POV that you want to make the Primary from the drop-down menu. 

Note: If a POV was previously set for the visit as primary, it 
displays in the drop-down menu, but can be changed by the 
user. 

 
Figure 3-86: Primary POV Drop-down Menu Sample 
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18. Click Save. 

If any items were added to Goal Notes, Care Plan, or Visit Instructions in the 
POV dialog, the Review/Sign Change for Patient Name dialog opens, listing the 
items to be signed. 

 
Figure 3-87: Review/Sign Changes for Patient Name 

The Problem List screen updates with your changes. If an outpatient, the POV 
shows in the Visit Diagnosis component. 

If you click Cancel, the Rollback Operations Already Executed dialog opens. If 
needed, select the Rollback check box to indicate that a care planning instruction 
was created, and then click OK. 

 
Figure 3-88: Rollback Operation Already Executed dialog 
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3.4.4 Using the PL Pick List Button 
These instructions are for the Pick List button on the main screen to update a Pick 
List. See the Adding an IPL or Editing an IPL topics for information on using the 
Pick List button from the Add Problem or Edit Problem dialogs. 

Note: If the Pick List button is clicked from the main IPL screen, 
more than one pick list can be selected. If the Pick List 
button is clicked from the Add an Integrated Problem List 
or the Edit an Integrated Problem List screen, only one pick 
list can be selected. 

The PL Pick List button opens the Pick List dialog where the user can choose 
SNOMED CT descriptions by defined pick lists. Pick list entries may include 
associated qualifiers. 

Providers can edit the Pick List, as well as users holding the BGOZ VPOV EDIT key. 

Note: The Pick List button is enabled and pick lists can be 
managed if no visit is selected. 

3.4.4.1 Selecting Problems from a Pick List 
1. Click the Pick List button from the IPL main screen. The Picklist Selection dialog 

opens. 
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Figure 3-89: Pick List dialog 

2. In the Picklist column: 

• One or more pick lists can be selected if the Pick List button from main IPL 
screen is used. 

• Only one pick list can be selected if the Pick List button from the Add or Edit 
an Integrated Problem List screen is used. 

The SNOMED CT Description column refreshes with the items related to the 
pick list(s) you selected. 

Note: Both the pick lists and their items are in alphabetical order. 
The top-right corner of the dialog indicates the number of 
SNOMED CT descriptions associated with the selected 
pick list. 

3. Click Save. New pick list items display as newly added problems. The Pick List 
disables any problem that is a duplicate and already on the patient's problem list. 
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3.4.4.2 Managing Pick Lists 
You can manage pick lists by performing the following steps for the associated 
problems: 

1. Click the Manage PickLists button from the PickList Selection dialog. The 
Manage Quick Picks dialog opens. 

2. From the Pick Lists drop-down menu, select a Pick List to manage. The Pick List 
Items list refreshes with the problems associated with that Pick List. 

3. Click to select a problem or select multiple problems by clicking on the problem 
while holding down the Ctrl key. The problem shows highlighted in orange. 

 
Figure 3-90: Manage Quick Picks dialog 

4. Click any of the following buttons to perform the necessary actions: 

3.4.4.2.1 Adding 
1. Click the Add button from the Manage Quick Picks dialog. The SNOMED CT 

Lookup dialog opens. 

2. In the Diagnosis Lookup section, select either the Fully specified name or 
Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click the 
Expand button next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual New Components 
September 2014 

89 

3. In Maximum Results, click one of the following option buttons to limit the 
number of results (or click ALL): 

• 25 

• 50 

• 100 

• 200 

• ALL 

4. In Search, type the term by which you want to search. 

5. In Subset, you can select a subset in which to search, if needed. 

6. In Search Date, the field defaults to the current date. Click the drop-down arrow 
to open the calendar and select a different date to search, if needed. 

7. Click either the IHS SNOMED CT or ALL SNOMED CT button. The list of 
SNOMED CT terms is populated. 

8. Select a problem from the list and then click Select. 

3.4.4.2.2 Deleting 
1. Click the Delete button from the Manage Quick Picks dialog. The Delete 1 (or 

number selected) Items confirmation message appears. 

 
Figure 3-91: Delete Pick List Item Confirmation Message 

2. Click Yes to Delete, No to cancel. If Yes is clicked, the item is removed from the 
Pick List. 

3.4.4.2.3 Changing Group 
1. Click the Group button from the Manage Quick Picks dialog. The Change the 

Group values for 1 (or number selected) Pick List Items dialog opens. 
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Figure 3-92: Change the Group dialog 

2. In Group, select the group to which you want to move the item from the drop-
down menu. 

3. Click Save to save the new Group. 

3.4.4.2.4 Changing Status 
1. Click the Status button from the Manage Quick Picks dialog. The Change the 

Status values for 1 (or number selected) Pick List Items dialog opens. 

 
Figure 3-93: Change the Status Values dialog 

2. In the Status drop-down, select a status to assign: 

• Chronic 

• Sub-acute 

• Episodic 

• Social/Environmental 

• Interactive 

• Personal Hx 

3. Click Save. 

Merging: 

1. Click the Merge button from the Manage Quick Picks dialog. The Merge PickList 
dialog opens. 
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Figure 3-94: Merge PickList dialog 

2. In From, select the Pick List to merge the item or items from. 

3. In To, select the Pick List to merge the item or items to. 

4. Click Merge. 

3.4.4.2.5 Querying 
1. Click the Query button from the Manage Quick Picks dialog. The Query for 

PickList Items dialog opens. 

 
Figure 3-95: Query for PicList Items dialog 

2. In Target PickList, select a pick list to query from the drop-down menu. 

3. In From Date, click the Ellipsis button to select a date from the calendar. 

4. In To Date, click the Ellipsis button to select a date from the calendar. 

Note: The From and To date defaults to the current date. 

5. In Hosp. Location, click the Ellipsis button to select a location. The Lookup 
Hospital Location dialog opens. 
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Figure 3-96: Lookup Hospital Location dialog 

a. In Search Value begin typing the first few letters of the location name. The list 
refreshes with your location. 

b. Click to select the location, and then click OK. Your selection is populated in 
the Hosp. Location field. 

6. In Clinic, click the Ellipsis button to select a clinic. The Lookup Clinic dialog 
opens. 
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Figure 3-97: Lookup Clinic dialog 

a. In Search Value, begin typing the first few letters of the clinic name. The list 
refreshes with your clinic. 

b. Click to select the clinic, and then click OK. Your selection is populated in the 
Clinic field. 

7. In Provider, click the Ellipsis button to select a provider. The Lookup Provider 
dialog opens. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual New Components 
September 2014 

94 

 
Figure 3-98: Lookup Provider dialog 

a. In Search Value begin typing the first few letters of the provider name. The 
list refreshes with providers. 

b. Click to select the provider, and then click OK. Your selection is populated in 
the Provider field. 

8. In Prov. Class, click the Ellipsis button to select a provider class. The Lookup 
Provider Class dialog opens. 
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Figure 3-99: Lookup Provider Class dialog 

a. In Search Value begin typing the first few letters of the provider's class. The 
list refreshes with provider classes. 

b. Click to select the provider class, and then click OK. Your selection is 
populated in the Prov. Class field. 

9. In Max hits, 500 is the default. Type a number of hits to return if you want to 
change the number of hits returned. 

10. Click OK on the Query for Pick List Items dialog. An information message 
appears, showing the number of returned records. 
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Figure 3-100: Query PickLists Finished Information Message 

3.4.4.2.6 Importing 
1. Click the Import button from the Manage Quick Picks dialog. The Import 

SNOMED CT PickLists dialog opens. 

 
Figure 3-101: Import SNOMED CT PickLists dialog 

2. In Look in, select a location from which to import. 

3. Locate the file you wish to import. The Files of Type defaults to SNOMED CT 
Pick Lists (*zgp). 

4. Click Open. Your file is imported. 

3.4.4.2.7 Exporting 
1. Click the Export button from the Manage Quick Picks dialog. The Save As dialog 

opens. 
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Figure 3-102: Save As (Export Pick List) dialog 

2. Select a location to save and type a file name and then click Save. Your 
SNOMED CT Pick List is saved as .zgp file type, ready for exporting. 

3.4.4.2.8 Marking Zero Freq(ency) 
1. Click the zero Freq button from the Manage Quick Picks dialog. A frequency of 

zero (0) is assigned to the pick list item. 

2. Click Exit to close the Manage Quick Picks dialog. 

3.4.4.3 Edit Pick List Button 
From the Manage Quick Picks dialog, click the Edit Pick Lists button to add, edit, 
delete or import a subset to an existing pick list. 

1. Click the Edit Pick Lists button. The Manage PickLists dialog opens. 
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Figure 3-103: Manage Pick Lists dialog 

2. Select a PickList from the list, and click one of the following buttons: 

3.4.4.3.1 Add 
1. Click Add from the Manage PickLists dialog. The Add PickList dialog opens. 

 
Figure 3-104: Add Pick List dialog 

a. In PickList Name, type a name for the pick list. 

b. In Hosp. Location, click the Ellipsis button to select a location. The Lookup 
Hospital Location dialog opens. 
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Figure 3-105: Lookup Hospital Location dialog 

c. In Search Value begin typing the first few letters of the location name. The list 
refreshes with your location. 

d. Click to select the location, and then click OK. Your selection is populated in 
the Hosp. Location field. 

2. In Clinic, click the Ellipsis button to select a clinic. The Lookup Clinic dialog 
opens. 
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Figure 3-106: Lookup Clinic dialog 

a. In Search Value begin typing the first few letters of the clinic name. The list 
refreshes with your clinic. 

b. Click to select the clinic, and then click OK. Your selection is populated in the 
Clinic field. 

3. In Provider, click the Ellipsis button to select a provider. The Lookup Provider 
dialog opens. 
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Figure 3-107: Lookup Provider dialog 

a. In Search Value begin typing the first few letters of the provider name. The 
list refreshes with providers. 

b. Click to select the provider, and then click OK. Your selection is populated in 
the Provider field. 

4. In Prov. Class, click the Ellipsis button to select a provider class. The Lookup 
Provider Class dialog opens. 
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Figure 3-108: Lookup Provider Class dialog 

a. In Search Value begin typing the first few letters of the provider's class. The 
list refreshes with provider classes. 

b. Click to select the provider class, and then click OK. Your selection is 
populated in the Prov. Class field. 

5. The SNOMED CT Subfile field is not editable, but shows the file the list is based 
from. For example, if a subset was imported, that subset shows in the 
SNOMED CT Subfile field. 

6. The Managers section is inactive until a pick list is created and edited. Refer to 
Section 3.4.4.3.2. 

7. Click Save. Your entries show in the Manage PickLists dialog. 

3.4.4.3.2 Edit 
1. Click to select a pick list to edit from the Manage PickList dialog. The Edit 

PickList dialog opens. 
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Figure 3-109: Edit PickList dialog 

2. If applicable, click the Add button in the Managers section to add a PickList 
manager. The Add Managers dialog opens. 
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Figure 3-110: All Managers dialog 

3. In Search Value begin typing the first few letters of the person's name. The list 
refreshes with your selection. 

4. Click the name, and then click OK. The Managers field populates with your entry. 

5. Make your changes, and then click Save. Refer to the Add PickList steps  for 
details on completing the fields. 

3.4.4.3.3 Delete 
1. Click to select a pick list to delete. 

2. Click the Delete button. A Delete Picklist information message appears. 
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Figure 3-111: Delete PickList Information Message 

3. Click Yes to delete the list, or no to cancel. If Yes, the pick list is deleted from the 
list. 

3.4.4.3.4 Import Subset 
1. Click to select a pick list, and then click the Import Subset button. The Import 

Subset dialog opens. 

2. In Subset, select a subset to import from the drop-down menu. The New Subset 
Name field populates with your selection. 

3. Click Import. 

4. Click Exit to exit the Manage PickLists dialog. 

3.4.5 Using the Education Information Button 
The Education Information search depends whether any records are present or not. 

• Condition 1: If there are records present, select one and click the Education 
Information button to go to the MedlinePlus Reference Web site for the topic 
associated with the selected record. 

• Condition 2: If there are no records present or no record is selected, click the 
Education Information button to display the Web Reference Search dialog. 

 
Figure 3-112: Web Reference Search 

Select a Reference Site, if needed; the default is the UpToDate site. After entering a 
term and clicking Search, you are taken to the selected Web site for the specified 
term. 
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Note: The Add Patient Education Event dialog also opens when 
the Education Information button is clicked. Patient 
education is tracked for Meaningful Use; therefore, the Add 
Patient Education Event dialog should be completed. Refer 
to the Patient Education Online Help for details on 
completing this dialog. 

 
Figure 3-113: MedlinePlus 

3.4.6 Using the Clinical Decision Support Button 
The Clinical Decision Support button functionality depends whether any records are 
present or not. 

• Condition 1: If there are records present, select one and click the Clinical 

Decision Support button ( ) to go to the UpToDate Reference Web site for the 
topic associated with the selected record. 

• Condition 2: If there are no records present or no record is selected, click the 
Clinical Decision Support button to display the Web Reference Search dialog. 

Note: You will also see this dialog if you site is not licensed for 
UpToDate. 
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Figure 3-114: Web Reference Search 

Select a Reference Site if needed. The default is the UpToDate site. After entering a 
term and clicking Search, you are taken to the selected Web site for the specified 
term. 

 
Figure 3-115: UpToDate Website 

You can change to another Web site by selecting from the Reference Site drop-down 
list (on the Web site). The drop-down list for the Reference Site field (on the Web 
Reference Search dialog) can be configured. 

3.4.7 Care Planning Feature 
Clicking Expand All on the main Integrated Problem List window shows the 
following Care Planning information. 

Note: The Expand All button changes to Collapse All if Care Plan 
information is already expanded. 
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Figure 3-116: Expanded Care Plan 

• Goal Notes with a status for each date entered. 

• Care Plan with a status for each date entered. 

• Visit Instructions for each visit. 

• Care planning activities for each visit. 

• Whether any of the items were modified, and if so, by whom and when 
(date/time). 

3.4.7.1 Latest Tab 
On the Latest tab of the Care Plan, the most recent active planning entries (all entries 
for most recent date for goal), patient instructions, last visit for visit instructions, and 
care planning activities are shown. 

 
Figure 3-117: Latest Care Plan 

Selecting a Provider View Using the PRVs Button: 

1. Click the PRVs button to select a provider for which to view data. The Provider 
List dialog opens. 
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Figure 3-118:Provider List dialog 

2. Click the check boxes to select one or more providers, and then click OK. 

A new tab is created for each provider selected. The new tab name is the provider 
name and enables easy viewing of that provider's entries for the patient and 
problems in the Goal Notes, Care Plan, Visit Instructions, and Services. 

 
Figure 3-119: Provider List Results 

3.4.7.2 All Tab 
On the All tab, all care planning activities (active, inactive, and replaced) are shown. 

 
Figure 3-120: All Care Plans 

3.4.8 Adding an IPL 
To add an IPL to a patient record, complete the following steps: 

1. On the main IPL screen, click the Add button. The Add Problem dialog opens. 
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Figure 3-121: Initial Add Problem dialog 

Note: A visit is not required to view the IPL details; however a 
visit must be selected to enable the Add button. 
The Problem ID field is system populated. 

2. Select the Use for Inpatient check box, if applicable. The Use for Inpatient check 
box is only available for inpatients. 

3. Select the Use as POV check box, if applicable. The POV check box is available 
only for outpatients. 

Note: If Use as POV is selected, and if any fields have been 
changed or added, an information message appears, 
advising the user that the problem has been stored, if new, 
or updated, if edited. The problem is stored as Reviewed 
and Updated in the V Reviewed/Updated file. Inactive 
problems may be POV. 

4. Populate the SNOMED CT field using one of the following methods: 

Ellipsis button: 
a. Click the Ellipsis button. The SNOMED CT Lookup dialog opens. 
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Figure 3-122: SNOMED CT Lookup dialog 

b. In the SNOMED CT lookup dialog, in the Diagnosis Lookup section, select 
either the Fully specified name or Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the Expand button next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 
c. In Maximum Results, click one of the following option buttons to limit the 

number of results (or click ALL): 

• 25 

• 50 

• 100 

• 200 

• ALL 
d. In Search, type the term by which you want to search. 

• In Subset, you can select a subset in which to search, if needed. 

• In Search Date, the field defaults to the current date. Click the drop-down 
arrow to open the calendar and select a different date to search, if needed. 
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• Click either the IHS SNOMED CT or ALL SNOMED CT button. The list 
of SNOMED CT terms is populated. 

• Select and highlight a term, and then click the Select button. The 
SNOMED CT field of the Add Problem dialog refreshes with the selected 
SNOMED CT term you selected. 

• If you attempt to assign the same SNOMED CT code as an existing 
problem, the following Error message displays. Click OK and select a 
different SNOMED CT code from the SNOMED CT Lookup dialog. 

 
Figure 3-123:Duplicate SNOMED CT Code Error Message 

Get SCT button: 

• Click the Get SCT button to open the ICD 9 to SNOMED CT Lookup dialog. 
Refer to the Using the Get SCT Button topic for details on completing this 
dialog. 

PL Pick List button: 

• Click the PL Pick List button to open the Pick List dialog. Refer to the Using 
the PL Pick List Button topic for details on completing this dialog. 

After you populate the SNOMED CT code, the Add Problem dialog expands with 
additional fields. 
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Figure 3-124: Expanded Add Problem dialog with Asthma 

5. In Priority, use the Up and Down arrows to select a priority level. 

6. If primary problem, click the Primary check box. 

7. In Status, click the applicable option button: 

• Chronic 

• Sub-acute 

• Episodic 

• Social/Environmental 

• Inactive 

• Personal Hx 

8. In Provider Text, type any applicable text. (Optional, 60-character limit.) 

Note: You can briefly rest your mouse pointer over this field to 
view an information pop-up. 
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9. In Severity, select one or more of the following: 

• Fatal 

• Life Threatening 

• Mild 

• Mild to moderate 

• Moderate 

• Moderate to severe 

• Severe 
10. Click the Clinical Course Ellipsis to populate the Clinical Course field. The Select 

Clinical Courses dialog opens. 

 
Figure 3-125: elect Clinical Courses dialog 

a. Select one or more courses. 

b. Click Save. The Clinical Course field updates with your selections. 

Note: If you selected an Asthma Subset or the mapped ICD is in 
the Asthma taxonomy, the Asthma Classification drop-
down menu appears below the Qualifiers section. 

11. The Episodicities drop-down menu is currently disabled. 

12. Select the applicable Asthma Classification from the drop-down menu. 

Note: The Asthma Classification drop-down menu only appears if 
an Asthma Subset is selected or the mapped ICD is in the 
Asthma taxonomy, AND the Use as POV check box was 
selected. 
Only one Asthma Control entry is allowed per visit. 

13. In the Date of Onset field (optional), type a date in xx/xx/xxxx format or click the 
Ellipsis button. The Select Date dialog opens. Select a date from the calendar, and 
then click OK. 

14. If applicable, select the Is Injury check box. The Injury section opens in the Add 
Problem (or Edit Problem) dialog. 
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Note: The Use as POV check box must be selected for the Is 
Injury check box to appear. If the problem ICD code points 
to an injury taxonomy or if an injury-related SNOMED CT 
is selected, the Is Injury check box is automatically selected 
and the Injury section expands when the Use as POV check 
box is selected. 

 
Figure 3-126: Injury Section 

a. Select either the First Visit or Re-visit option button, as applicable. 

b. In Injury Date, the date defaults to the current date. Click the Ellipsis button to 
open the calendar and select a new date or type a new date in the field. 

c. In Place, select a location for where the injury occurred: 

• Home - Inside 

• Home - Outside 

• Farm 

• School 

• Industrial Premises 

• Recreational Area 

• Street/Highway 

• Public Building 

• Resident Institution 

• Hunting/Fishing 

• Other 

• Unknown 
d. In Associated With, select one of the following from the drop-down menu: 

• Hospital Acquired 

• Alcohol Related 

• Battered Child 

• Employment Related 
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• Domestic Violence Related 
e. To populate the Cause by field, type an injury term in the field, and then click 

the Ellipsis button. The Injury Causes dialog opens, showing only E coded 
items. 

 
Figure 3-127: Injury Causes with E Codes dialog 

• In Lookup Option, click either the Lexicon or ICD option button. 

• In Search value, type a different search value if your initial search did not 
return the applicable injury item, and then click Search. The returned 
results list shows a list of E Code items with their description. 

• In the returned results list, select the applicable item, and then click OK. 
Your selection shows in Caused By in the Injury section. 

15. Type a comment in the Comments section, if needed. 

16. If the Use as POV check box was selected, the Add Visit/Care Plan/Goal 
Activities button is active. To add data, click the Add Visit/Care Plan/Goal 
Activities button. The Add Visit Instructions/Care Plan Activities dialog opens. 
Refer to the Adding Visit Instructions/Care Plan Activities topic for instructions 
on how to complete this dialog. 
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• Entries in this section preceded by an S indicate the Goal Note, Care Plan, or 
Visit Instructions have been signed. Entries preceded by a U indicate the entry 
is unsigned. 

17. Click Save in the top-right of the Add Problem dialog. Your data is saved to the 
Integrated Problem List grid. 

Note: Selecting the Use as POV check box (outpatients only) also 
saves (stores) the problem in the V Reviewed/Updated file. 

3.4.9 Editing an IPL 
To edit an IPL, follow these steps: 

1. Select a visit. 

2. Select a problem from the Problem List on the main IPL screen. 

Note: A visit and a problem must be selected in order for the Edit 
button to become active. 

3. Click the Edit button. The Edit Problem dialog opens. 

Note: Unsigned problems may be edited. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual New Components 
September 2014 

118 

 
Figure 3-128:Integrated Problem Maintenance – Edit Problem dialog 

4. Edit fields as applicable. Refer to the Adding an IPL topic for instructions on 
completing the fields. 

Note: A SNOMED CT code must be selected in order to save 
your changes. 

5. In the Comments section you can add or delete comments. To add comments: 

a. Click the Add button. The Add Comment dialog opens. 
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Figure 3-129: Add Comment dialog 

b. In the Comment field, type a comment of 3-160 characters. 

c. Click Save. Your comment appears in the Comments section, with a number 
automatically assigned and shown in the # column, your comment in the 
Narrative column, the date entered in the Date column, and the logged in user 
name in the Author column. 

 
Figure 3-130: Comments List 

To delete comments: 

a. Select one or more comments you want to delete. The line items are 
highlighted and the Delete button becomes active. 

b. Click the Delete button. The following message appears: 

 
Figure 3-131: Delete Comment Confirmation Message 

c. Click Yes. Your comment no longer appears in the list. 

6. Click Save in the top-right of the Add Problem dialog. 
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Note: Clicking the Use as POV check box (outpatients only) also 
saves (stores) the problem in the V Reviewed/Updated file. 
If data in any fields has been updated, a message displays 
warning that the problem has been stored if new or updated 
if edited. 
When editing a problem, clicking Save or selecting the Use 
as POV check box saves (stores) the problem only if any 
fields have been changed. 

3.4.10 Adding Visit Instructions/Goal Notes/Care Plan Activities 
When Adding or Editing an Integrated Problem List, if the Use as POV check box is 
selected, the Add Visit/Care Plans/Goal Activities button is enabled for adding visit 
instructions, goals, or Care Plan information. 

 
Figure 3-132: Add Visit Instructions/Care Plan/Goal Notes/Care Planning Activities dialog 

1. In the Visit Instructions, Goal Notes, or Care Plans sections: 

a. In the Visit Instructions, Goal Notes, or Care Plans field, type a free-text 
comment, or click the Template button to select a template. The Templates 
List opens. 
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Figure 3-133:Templates List 

b. Select a template. The template window opens. Make any necessary changes, 
such as font size, and click OK. Your selected template name appears in the 
Visit Instructions, Goal Notes, or Care Plans field, as selected. 

Note: The Functional Assessment Template in the Visit 
Instructions field is shown in the Add Visit 
Instructions/Goal Notes/Care Planning Activities dialog, . 

 
Figure 3-134: Template Window Functional Assessment Template Sample 

c. Repeat Steps a and b for the other fields, as needed. 

2. In the Patient Education provided section, complete the following: 

a. Select one or more of the education check boxes. 

b. In Comprehension Level, select one of the following from the drop-down 
menu: 

• Poor 

• Fair 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual New Components 
September 2014 

122 

• Good 

• Group – No Assessment 

• Refused 

c. In Length, type the length in minutes. 
d. In Readiness to Learn, select one of the following from the drop-down menu: 

• Distraction 

• Eager to Learn 

• Intoxication 

• Not Ready 

• Pain 

• Receptive 

• Severity of Illness 

• Unreceptive 
Your selections show in the Education Provided section. 

3. If treatment, regimen, or follow-up is needed, click the 
Treatment/Regimen/Follow-up button. The Treatment/Regimen dialog opens. 

 
Figure 3-135: Treatment/Regimen dialog 

a. Click the Expand button on an item in the list to expand the list. 

b. Select one or more treatment or regimen items. 

c. Click OK. Your selections show in the Treatment/Regimen/Follow-up section. 

4. Click OK. The Review/Sign Changes for Patient Name opens, showing a list of 
the items you added or changed. Sign by adding your Electronic Signature. 
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Note: Additional Visit Instructions may be added to the same 
visit after signing. 
Click Cancel from the Add Visit Instructions/Care 
Plan/Goal Notes/Care Planning Activities dialog or the 
Review/Sign Changes dialog to delete your changes. 

 
Figure 3-136: Review/Sign Changes for Patient Name 

3.4.11 Deleting an IPL 
• Only the Chief MIS or author can delete a problem. 

• The visit must be unlocked. 

• Problems with any Goal Notes, Care Plan, Visit Instructions, or 
Treatment/Regimen entries may not be deleted. However, they can be inactivated. 
Refer to the Orientation section for details. Problems cannot be deleted if marked 
as Use as POV or Use as Inpatient. 

Problems may be deleted by one of the following methods: 

• Right-clicking the line-item and then selecting Delete from the right-click menu. 

• Selecting the line item and then clicking the Delete button on the main screen. 

The problem is cleared from the Integrated Problem List grid. 

3.5 Stroke Tool 
The Stroke tool captures specific SNOMED CT stroke data, including possible stroke 
symptoms, date and time of onset if witnessed, last known well (baseline) state if not 
witnessed, and NIH Stroke Scale score. 
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This component is delivered disabled with the EHR p13release. This component will 
be enabled in the EHR p14 release. 
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4.0 Updated Components 
The following components are updated for p13. 

4.1 Consults 
Consults are requests from one clinician to a hospital, service, or specialty for a 
service; in addition, this tab enables hospital services to track the progress of a 
consult order from the point of receipt through its final resolution. The clinician can 
enter an order for a consultation from within the patient’s EHR on the Consults tab. 

Note: Because there is no Medicine Package in RPMS-EHR, any 
function involving Procedures is not used by the IHS. All 
procedures are included in the available consults. Also, the 
Medicine Results and Remove Medicine Results are not 
used. 

4.1.1 Basic Operation 
The Consults process involves the following steps. 

1. The clinician orders a consult. From within the patient’s EHR medical record, the 
clinician enters an order for a consultation. The ordering clinician may first need 
to enter Encounter Information. 

2. The consult service receives an alert and a printed report (SF 513). The receiving 
service can then accept the consult, forward it to another service, or send it back 
to the originating clinician for more information. 

3. The consult service accepts or rejects the consult request. To accept the consult, 
the service uses the receive action. The service can also discontinue or cancel the 
consult. Cancelled consults can be edited and resubmitted by the ordering 
clinician. A consult service clinician sees the patient. 

4. The Edit/Resubmit action is available for cancelled consults. The consult must be 
capable of being resubmitted and the user must be authorized to resubmit 
consults. 

5. The consult service enters results and comments. Resulting is primarily handled 
by writing a note to complete the consult. 

6. The originating clinician receives a CONSULT/REQUEST UPDATED alert that 
the consult is complete. The results can now be examined and further action can 
be taken on behalf of the patient. 

7. The SF 513 report becomes part of the patient’s medical record. A hard copy can 
be filed and the electronic copy is online for paperless access. 
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8. The Consults component presents a list of consults in a tree view. 

9. Right-clicking the Consults text enables the selection of Find in the Selected 
Consult option from the pop-up menu. This option enables a search of the 
displayed text. A Replace Text option is also available, but is only active when a 
consult is being edited. 

10. The field below the list of consults shows a list of documents related to the 
highlighted consult. These related documents are also in a tree view. 

4.1.2 Status of a Consult 
The following table describes the status of a consult. 

Abbreviation Name Description 
a ACTIVE Orders that are active or have been accepted by 

the service for processing. 

c COMPLETE Orders that require no further action by the 
ancillary service. 

dc DISCONTINUE Orders that have been stopped prior to expiration 
or completion. 

p PENDING Orders that have been placed but not yet 
accepted by the service filling the order. 

Pr PARTIAL RESULTS All or part of a consult completion report has 
been entered, but has not yet been signed. 

s SCHEDULED The receiving clinic has scheduled an 
appointment for the patient. 

x CANCELLED Orders that have been rejected by the ancillary 
service without being acted on. 

4.1.3 Defaults for Editing/Saving Consult Notes 
The defaults for editing and auto-saving consult notes can be configured. This action 
defines the interval to auto-save any notes, as well as identify any default cosigners. 

Follow these steps to set the defaults for editing and saving consult notes: 

1. From the Tools menu, select Options. The Options dialog opens. 
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Figure 4-1: Options dialog 

2. Click the Notes tab. 

3. Click Notes to display the Notes dialog. 

 
Figure 4-2: Notes dialog 

4. Change the interval for auto-saving your notes, if necessary. The units of measure 
are seconds. Type the new interval, or click the up and down arrows to change the 
settings in five second intervals. 

5. If a default cosigner is desired for consult notes, select the user from the drop-
down list for the Default cosigner field. This name appears in the Expected 
Cosigners field on the Identify Additional Signers dialog when the Identify 
Additional Signers is selected on the Consults tab. 

6. Check Ask Subject for Progress Note to enter a subject line when a new note is 
written. This groups your notes by particular subjects. The sort and search options 
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in TIU can use the subject line to find them. This means a subject line for 
bronchitis may exist and then be used to locate any notes written for patients with 
bronchitis. 

 
Figure 4-3: New Note for Entering a Subject Line 

7. Use the Verify Note Title if a default note title is selected. Create a selection list 
of titles used most often and then make one of them the default. This way the note 
title comes up automatically even if a different title is used. This is a reminder to 
ask the provider if this is the correct title to use. 

8. When the Notes dialog is complete, click OK. Otherwise, click Cancel. 

4.1.4 Document List Preferences for Consults 
Users can configure their document list preferences. This means that when a note title 
is selected, the users preferences are listed at the top. In addition, when a default title 
is selected; that note title comes up automatically if the Verify Note Title option box 
was selected on the Notes dialog. 

Follow these steps to set list preferences: 

1. From the Tools menu, select Options. The Options dialog opens. 

2. Click the Notes tab. 
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Figure 4-4: Options dialog 

3. Click Document Titles. The Document Titles dialog opens. 

 
Figure 4-5: Document Titles dialog 

4. Select Consults from the drop-list list for the Document class field. 

5. In Document Titles, select a title from the list. 

6. Click Add to add the selected title to Your List of Titles field. 

7. Multiple titles may be added your list, as needed. 

8. If there is a title you do not want in your list, highlight it and click Remove. 
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9. If needed, arrange the order of the list of titles by using the up and down arrows. 

10. Select a title in the list to be the default by highlighting it and clicking Set as 
Default. In this case, the title appears below the Default label on the dialog. If this 
is the correct default, click Save Changes. 

11. If needed, remove the default by selecting it and clicking Remove Default. 

 
Figure 4-6: Document Titles dialog to Remove Default 

12. When the Document Titles dialog is complete, click OK. 

4.1.5 Consult Participants 
• The Consult Originator initiates a new consult. The Consult Receiver takes the 

appropriate action concerning the consult. 

• The SERVICE INDIVIDUAL TO NOTIFY field (in the Set Up Consult Services 
command) identifies the person as having primary responsibility for receiving 
consults. 

• The SERVICE TEAM TO NOTIFY field determines the name of the Service 
Team to receive notifications of any actions taken on a consult. 

• The UPDATE USERS W/O NOTIFICATIONS field (in the Set Up Consult 
Services menu) identifies users who can perform update tracking, but will not 
receive a notification. 

• The UPDATE TEAMS W/O NOTIFICATIONS field (in the Set Up Consult 
Services menu) Identifies the OE/RR team who can perform update tracking, but 
will not receive a notification. 

• The UPDATE USER CLASS W/O NOTIFICATIONS field in the Set Up Consult 
Services menu) Identifies the TIU USER CLASS who can perform update 
tracking, but will not receive a notification. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

131 

• The ADMINISTRATIVE UPDATE USER field (in the Set Up Consult Services 
menu) allows users to perform administrative user updates. 

• The ADMINISTRATIVE UPDATE TEAM field (in the Set Up Consult Services 
menu) allows users to perform administrative team updates. 

4.1.6 Creating Consults 

4.1.6.1 Initiating Consults 
Consult requests can be initiated by using either the Consults or the Orders 
component. Both techniques are described. 

When the new consult is complete, this triggers a notification so that the recipient can 
take appropriate action. 

4.1.6.2 New Consults using Consults Component 
The following steps describe how to enter a generic consult. Your site may have 
quick orders to replace the generic consult. Refer to the New Consult Using Quick 
Orders for details. 

Make sure that a visit is selected. Follow these steps to enter a new consult on the 
Consults tab: 

1. Select the Consults component. 

2. Click the New Consult button or click the Action drop-down menu and select 
New, then Consult. The Order a Consult dialog opens. 
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Figure 4-7: Order a Consult dialog 

3. There are two ways to select a consult: 

• Method 1: Click the button to display the tree view of the consult services. 

 
Figure 4-8 Tree View of Consult Services 

After selecting a consult service from the tree view, complete the following 
steps. 

• Method 2: Select a consult from the list below the Consult to 
Service/Specialty field. 
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Figure 4-9: Consult Service to Select 

There may be template associated with the selected consult that will complete the 
Reason for Request field. 

After completing the template, complete the following steps, with the exception 
of the Reason for Request field, if it does not need to be edited. 

4. The Urgency field defaults to Routine. Select a different urgency from the drop-
down list, if needed. 

5. In Attention, select a name if someone was involved in the consult. 

6. If needed, change the Inpatient or Outpatient selection using the applicable option 
button. 

7. If needed, change the Place of Consultation field by selecting a different location 
from the drop-down menu. 

8. In the Reason for Request field (required), type a reason for the request. The field 
has a right-click menu to aid in editing the text. 

9. The message box in the lower-left panel gives critical information. This panel has 
a right-click menu to enable the user to select the text and paste it into another 
free-text field in the RPMS-EHR or into another application (like MS Word). 

10. In the Clinical Indicator field (required), select the applicable indication from the 
drop-down menu. 

If Other is selected, the SNOMED CT Lookup dialog opens. Complete the 
following steps: 
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Figure 4-10: SNOMED CT Lookup dialog 

a. In the SNOMED CT lookup dialog, in the Diagnosis Lookup section, select 
either the Fully specified name or Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the Expand sign next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 

b. In Search, type the term by which to search. 

c. In Subset, select a subset in which to search, if needed. 

d. The Search Date field defaults to the current date. Click the drop-down arrow 
to open the calendar and select a different date to search, if needed. 

e. Click the Find button. The list of SNOMED CT terms is populated. 

f. Click to select and highlight a term, and then click the Select button. The 
Clinical Indication field refreshes with the selected SNOMED CT term and 
code you selected. 

11. Click Accept Order. If there are no other consults for this patient, click Quit. 

12. The consult can be signed now or later. 

If signed later, it does not appear on the Consults tab. In addition, the application 
notifies the user that the consult requires his or her electronic signature. The status 
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of the consult is (p) for Pending (showing that it has not been accepted by the 
service filling the order). 

4.1.6.3 New Consult Using Orders Component 
The following steps describe how you enter a generic consult. Your site may have 
quick orders to replace the generic consult. Refer to the New Consult Using Quick 
Orders for details. 

Make sure that a visit is selected and that the view is Active Orders. Follow these 
steps to order a consult using the Orders component: 

1. Select the Orders component. 

2. Select Consult from the Write Orders list. The Consults dialog opens. 

 
Figure 4-11: Consults from Orders Tab dialog 

3. Select a consult type from the list. The Order a Consult dialog opens with your 
selection populated in the Consult to Service/Specialty field. 

 
Figure 4-12: Order a Consult dialog 

4. The Urgency field defaults to Routine. Select a different urgency from the drop-
down list, if needed. 

5. In Attention, select a name if someone was involved in the consult. 
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6. If needed, change the Inpatient or Outpatient selection using the applicable option 
button. 

7. If needed, change the Place of Consultation field by selecting a different location 
from the drop-down menu. 

8. In the Reason for Request field (required), type a reason for the request. The field 
has a right-click menu to aid in editing the text. 

9. The message box in the lower, left panel shows critical information. This panel 
has a right-click menu to allow you to select the text and paste it into another free-
text field in the EHR or into another application (like MS Word). 

10. In the Clinical Indicator field (required), select the applicable indication from the 
drop-down menu. 

If Other is selected, the SNOMED CT Lookup dialog opens. Complete the 
following steps: 

 
Figure 4-13: SNOMED CT Lookup dialog 

a. In the SNOMED CT lookup dialog, in the Diagnosis Lookup section, select 
either the Fully specified name or Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the Expand sign ( ) next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

137 

b. In Search, type the term by which to search. 

c. In Subset, select a subset in which to search, if needed. 

d. The Search Date field defaults to the current date. Click the drop-down arrow 
to open the calendar and select a different date to search, if needed. 

e. Click the Find button. The list of SNOMED CT terms is populated. 

f. Click to select and highlight a term, and then click the Select button. The 
Clinical Indication field on the Order a Consult dialog refreshes with the 
selected SNOMED CT term and code you selected. 

11. Click Accept Order. If there are no other consults for this patient, click Quit. 

12. If there are other consults, select another consult type from the Consults dialog. 
Otherwise, click Done to close the Consults dialog. 

13. The consult can be signed now or later. 

• If signed now, the consult appears on both the Orders tab and the Consults tab. 

• If signed later, the consult appears on the Orders tab (only) with a status of the 
consult as (p) for Pending. This shows that it has not been accepted by the 
service filling the order. 

4.1.6.4 New Consult Using Quick Orders 
Your site may choose to only use Quick Orders for consults or create menus of 
Consult Quick Orders. The Consult button on the Consults window is controlled by 
the following parameter: 

ORWDX NEW CONSULT 

At the new Consult dialog default: 

1 User USR Choose from NEW PERSON 

2 Location LOC Choose from HOSPITAL LOCATION 

3 System SYS DEMO.MEDSPHERE.COM 

4 Package PKG ORDER ENTRY/RESULTS REPORTING 
 

Enter selection 3, System DEMO.MEDSPHERE.COM. The following appears: 

--- Setting ORWDX NEW CONSULT for System: DEMO.MEDSPHERE.COM --- 

Setting this parameter replaces the generic consult dialog with your consult menu. 
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Figure 4-14: Generic Consult dialog 

Consult quick orders can have most or all of the fields already pre-populated with the 
data to do the consult order quickly. 

 
Figure 4-15: Quick Orders Pre-Populated Fields 
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4.1.7 Completing Consults 
A consult can be completed using either the Consults component or the Notes 
component. Both methods are described. 

The Complete action updates the CPRS status of a consult from Active to Completed. 
The Completed status links to TIU so findings can be entered. 

This action informs the system that the consult is finished.. An alert is sent to the 
Consult Originator and marks the record as complete. 

This action not only updates the current status on the consult but also updates the Last 
Activity field to COMPLETED. 

This topic contains the following information: 

• Completing a Consult using the Consults Component 

• Completing a Consult using the Notes Component 

• Administratively Complete a Consult 

4.1.7.1 Completing a Consult Using the Consults Component 
Select a visit, and then follow these steps to complete a consult using the Consults 
component: 

1. Select the Consults component. 

2. From the Action menu drop-down click Consult Results, and then 
Complete/Update Results. The Consult Note Properties dialog displays. 

 
Figure 4-16: Consult Note Properties dialog 

3. In the Progress Note Properties dialog, select a consult note title for the Progress 
Note Title field so the note can be auto-saved. 
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4. The application automatically populates the date and time of the note as well as 
the author. These fields can be corrected, if necessary. 

The note titles listed on the Consult Note Properties dialog come from the 
CONSULT document class. The Clinical Coordinator is responsible for this 
document class. 

5. Click OK 

6. Create a note by typing the text in the right panel, by using templates (click the 
Templates button), and by including any reminders (click the Reminders button). 
Be sure to include any test results. 

7. To change the title of the note, click the Change button (above the text of the note 
in the right panel) or select Consult Results from the Action menu drop-down, and 
then click Change Title. The Consult Note Properties dialog opens. 

8. The right panel has a right-click menu for editing the text of the note. These 
features are the top-most options on this menu. 

 
Figure 4-17: Edit Options on Right-Click Menu 

The Reformat Paragraph option can be used when there are two sentences that are 
separated by a return and one paragraph is desired. In that case, place the cursor 
before the first sentence and then select the Reformat Paragraph option. 

9. From the Action, and then Consult Results menu, select either Sign Note Now or 
Save without Signature. These features are also available from the right-click 
menu. 

• If you Save Without Signature, the status of the consult becomes (pr) for 
Partial Results. 

• If you Sign Note Now, the status of the consult becomes (c) for Completed. 

4.1.7.2 Completing a Consult Using the Notes Component 
Select a visit, and then follow these steps to complete a consult using the Notes 
component: 

1. Select the Notes component. 
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2. Click New Notes. Or select Action, and then New Progress Note. 

3. In the Progress Note Properties dialog, select a consult note title for the Progress 
Note Title field so the note can be auto-saved. 

4. In Progress Note Title, select which consult to which to attach the note. A consult 
must be selected. The options appear in a Progress Note Properties dialog below 
the other note data. 

 
Figure 4-18: Progress Note Properties Title List 

If there is no consult waiting for resolution, that title is not selectable and a 
warning message appears. 

 
Figure 4-19: No Consults Waiting Warning Message 

Additional items appear on the dialog for titles that require entry of a cosigner or 
an associated consult after the Consult Title is completed. 
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5. If necessary, change the note date by clicking the Ellipsis button next to the 
Date/Time of Note field and selecting a new date. 

6. If necessary, change the note author by making a selection from the Author: drop-
down list. 

7. Select the Consult, and then click OK. 

8. Type a note, including any test results. 

The Templates button may be used to insert template information in the text of the 
note. In addition, there is a right-click menu to aid in editing the text. 

 
Figure 4-20: Edit Options on Right-Click Menu 

9. From the Action menu, select either Sign Note Now or Save without Signature. 
These same options are available on the right-click menu in the text of the note. 

The note appears on the Notes tab, as well as on the Consults tab. 

If you Save Without Signature, the status of the consult becomes (pr) for Partial 
Results. If you Sign Note Now, the status of the consult becomes (c) for 
Completed. Refer to the Electronic Signature topic for more information about 
signing the note. 

4.1.7.3 Administratively Complete a Consult 
If a user is set up as either an Administrative User or on an Administrative User 
Team, this option exists to perform an Administrative Complete action. An 
Administratively Complete does not have results attached to it. 

Follow these steps to administratively complete a consult. 

1. Select the Consults component. 

2. Select the consult to administratively complete. 

3. From the Action drop-down, select Consult Tracking, and then Administratively 
Complete. The Administratively Complete dialog opens. 
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Figure 4-21: Administratively Complete dialog 

4. Select the appropriate option button in the Significant Findings panel. 

5. Type comments about the consult in the Comments field. This field has a right-
click menu to aid in editing the text. 

6. Enter the date and time in the Date/time of this action field, or click the Ellipsis 
button to select the date and time from a calendar. 

7. When the Administratively Complete dialog is finished, click OK. The Activity 
Grid of the text of the consult shows COMPLETE/UPDATE, along with any 
comments below that row in the grid. 

4.1.8 Using the Information in a Signed Consult 
The text can be selected in the consult. The right-click menu contains text-editing 
options (like copy). Then you can paste the selected text into another free-text field 
with the EHR application or into another application, like MS Word. 

4.1.9 Consult Tracking and Consult Results Features 
Individuals chosen as a service individual to notify an update user or an 
administrative user are able to track the consults using the RPMS-EHR. This means, 
if that user updates status for cardiology, that user is not be able to track ENT 
consults, for example. 
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The Consult Tracking menu in the Action drop-down contains several features for 
tracking a consult. 

 
Figure 4-22: Tracking Consult Options 

Only the active options available for a particular consult can be selected. Non-active 
options are disabled on the menu. 

The Consult Results menu in the Action drop-down contains several features for 
entering results for a consult. 

 
Figure 4-23:Consult Results Options 

The RPMS-EHR does not use the Attach Medicine Results nor the Remove Medicine 
Results options. These options require a medicine package currently unavailable in 
the IHS RPMS-EHR. 

The following table explains consult information and its function: 
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Information Type What it Does 
Comments Adds a note to the text of a consult regarding how to administer the 

consult. 

Note Updates the consult and changes its status from Active to 
Complete. The note becomes a Related Document of the consult. 

Addendum Allows one or more people to add their medical opinions about the 
consult. This becomes a Related Document of the consult. 

Significant Findings Allows the Consult Receiver to enter significant findings about a 
consult. This marks the consult with an asterisk (*). 

4.1.10 Add a Comment to a Consult 
The Add Comment action enables the user to append a comment to a consult when 
important information about the consult needs to be added to the original order, or 
when a caregiver needs to furnish information before the consult is ready to be closed 
out. 

Anyone can add comments to a consult. These differ from Addendums in that a 
comment contains information needed to administer the consult, while an addendum 
is a medical statement by a patient care professional about a specific note. 

Follow these steps to add a comment to a consult: 

1. Select the Consults component. 

2. Select the consult to which you want to add a comment. 

3. From the Action drop-down, select Consult Tracking. 

4. Click Add Comment. The Add Comment to Consult dialog opens. 
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Figure 4-24: Add Comment to Consult dialog 

5. Type the text of the comment in the Comments field. This field has a right-click 
menu to aid in editing the text. 

6. Enter the date and time in the Date/time of this action field, or click the Ellipsis 
button to select the date and time from a calendar. 

7. If you want to send an alert about this comment, check Send alert to display the 
Send Alert dialog. 

 
Figure 4-25: Send Alert dialog 

8. In the Select or enter name field, choose a name from the list or type a name. That 
name appears in the Currently selected recipients field. 
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9. To remove a name from the Currently selected recipients field, select it. 

10. When the Send Alert dialog is complete, click OK to have an alert sent. 

11. When the Add Comment to Consult dialog is complete, click OK. 

12. The added comment information is added to the text of the consult in the Activity 
grid, followed by any comments that were added. 

 
Figure 4-26: Added Comment in the Text of the Consult 

4.1.11 Cancel (Deny) a Consult 
The Consult Receiver uses this feature to cancel a consult for completion. You must 
enter a comment concerning the reason for this action. 

The Consult Originator is automatically sent an alert that the request has been 
cancelled. The Consult Originator then has the option of editing and resubmitting the 
request. 

Follow these steps to cancel a consult: 

1. Select the Consults component. 

2. Select the Consult to cancel. 

3. From the Action drop-down menu, select Consult Tracking. 

4. Select Cancel (Deny). The Cancel (Deny) Consult dialog opens. 
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Figure 4-27: Cancel (Deny) Consult dialog 

5. Type the reason for the denied consult in the Comments field. Be specific enough 
so that the Consult Originator can correct and resubmit the consult. This field has 
a right-click menu to aid in editing the text. 

6. Enter the date and time in the Date/time of this action field, or click the Ellipsis 
button to select the date and time from a calendar. 

7. If this action should be by another person, select a name from the drop-down list 
for the Action by field. 

8. When the Cancel (Deny) dialog is complete, click OK to have the cancelled 
consult information added to the text of the consult in the Activity grid, followed 
by any comments that were added. The status of the consult becomes (x) for 
Cancelled. 

4.1.12 Discontinue a Consult 
The Consult Originator uses this feature to stop a consult request after it has been 
signed (the Consult Receiver uses Cancel). A comment can be added concerning the 
reason for discontinuing the consult. For example, use this feature to cancel a 
duplicate consult order. 

The Discontinue action differs from the Cancel action in that there is no 
Edit/Resubmit action available on a discontinued order. 
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This action changes the status of the consult to (dc) for discontinued. A notification is 
automatically is sent to the Consult Service, with information about why the consult 
was discontinued. 

Follow these steps to discontinue a consult: 

1. Select the Consults component. 

2. Select the consult that you want to discontinue. 

3. From the Action drop-down, select Consult Tracking. 

4. Select Discontinue. The Discontinue Consult dialog opens. 

 
Figure 4-28: Discontinue Consult 

5. Type the reason for discontinuing the consult in the Comments field. This field 
has a right-click menu to aid in editing the text. 

6. Enter the date/time in the Date/time of this action field, or click the Ellipsis ( ) 
button to select the date and time from a calendar. 

7. If this action should be by another person, select a name from the drop-down list 
for the Action by field. 

8. When the Discontinue Consult dialog is complete, click OK. 
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The status of the consult changes to (dc) for discontinue. The discontinue consult 
information is added to the text of the consult in the Activity grid, followed by 
any comments that were added. 

 
Figure 4-29: Discontinued Information About the Consult 

4.1.13 Display Details of a Consult 
The details of a consult include: 

• Current Primary Care information 

• Current Eligibility information 

• Order information 

• Activity record 

• All signed notes 

• Information about unsigned notes 

• Notes, Results, and Addenda 

• All other fields associated with the consult 
Use this feature when to return to the details of a consult when the results of a consult 
are displayed. Follow these steps to display the details of a consult: 

1. Have the results of a consult displayed in the right panel. 

2. From the Action drop-down, select Consult Tracking. 

3. Select Display Details. The details about the consult display in the right panel. 

 
Figure 4-30: Details of a Consult 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

151 

4.1.14 Display SF 513 for a Consult 
Follow these steps to display the SF 513 information about a consult: 

1. Select the Consults component. 

2. Select the consult about which to display SF 513 information. 

3. From the Action drop-down, select Consult Tracking. 

4. Select Display SF 513. The SF 513 information displays in a pop-up. 

 
Figure 4-31: SF 513 Information About a Consult 

5. Click Close to dismiss the pop-up. 

4.1.15 Edit/Resubmit a Consult 
The Consult Originator or the Consult Receiver uses this feature to edit a cancelled or 
denied consult and then resubmit the consult. When a consult is cancelled or denied 
for clerical reasons (such as insufficient data), then the information on the consult can 
be edited and resubmitted with this action. Alternatively, the Consult Originator can 
perform this function from the alert. 

Follow these steps to edit and resubmit a consult: 

1. Select the Consults component. 

2. Select the cancelled or denied consult that you want to edit and resubmit. 

3. From the Action drop-down, select Consult Tracking. 
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4. Select Edit/Resubmit. The Edit/Resubmit a Cancelled Consult dialog opens. 

 
Figure 4-32: Edit/Resubmit a Cancelled Consult 

5. Click Cancellation to review the reason for denial on the Cancellation Comments 
pop-up. 

 
Figure 4-33: Cancellation Comments Pop-up 

6. Click Close to dismiss the pop-up. 

7. You can add a new comment in the Reason for Consult field. 

8. If needed, more comments can be added in the New Comments field. This field 
contains a right-click menu to aid in editing the text. 

9. When the Edit/Resubmit a Cancelled Consult dialog is complete, click Resubmit. 
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The edit/resubmit information is added to the text of the consult in the Activity 
grid. 

 
Figure 4-34: Edit/Resubmitted Information in Text of Consult 

4.1.16 Forward a Consult 
Use this feature when the incorrect service receives the consult. For example, this 
action could be used when Cardiology Service has mistakenly received a consult that 
should have been sent to Hematology Service. 

Follow these steps to forward a consult: 

1. Select the Consults component. 

2. Select the consult that you want to forward. 

3. From the Action drop-down, select Consult Tracking. 

4. Select Forward. The Forward Consult dialog opens. 

 
Figure 4-35: Forward Consult dialog 

5. Select the correct service in the To service panel. 

6. If applicable, type in or select the Attention care giver in the Attention field. 
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7. Type the reason for forwarding the consult in the Comments field. This field has a 
right-click menu to aid in editing the text. 

8. Enter the date/time in the Date/time of this action field, or click the Ellipsis button 
to select the date and time from a calendar. 

9. When the Forward Consult dialog is complete, click OK. 

10. The forward consult information is added to the text of the consult in the Activity 
grid, followed by any comments that were added. 

 
Figure 4-36: Forwarded Consult Information in Text of the Consult 

4.1.17 Make Addendum to a Consult 
An Addendum is a medical statement by the patient care professional about a specific 
Note; it supplies supplementary information on the patient. It differs from a Comment 
in that an Addendum is about medical matters, where Comments, which can be 
written by anyone, should contain information needed to administer the consult. 

This action allows one or more people to add their comments to the results of a 
consult. Contrast this to Add Comment, which adds a note to the consult before it is 
resulted. 

Follow these steps to add an addendum to a consult. 

1. Select the Consults component. 

2. Select the note about the Consult. 

3. From the Action drop-down, select Consult Results. 

4. Select Make Addendum. 

Note:  Alternatively, you can also select Make Addendum on the 
right-click menu. 

5. Type the supplementary information about the patient’s condition in the right 
panel. 

6. As with other TIU objects, information can be added to the addendum by clicking 
the Templates button and/or the Reminders button. Both buttons add boilerplate 
information to the addendum text. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

155 

7. To change the properties of the addendum, click the Change button, or select 
Consult Results from the Action drop-down, and then Change Title. The 
Addendum Properties dialog opens. 

 
Figure 4-37: Addendum Properties dialog 

8. Change the information on the Addendum Properties dialog as needed. Then click 
OK. The information above the text of the addendum shows your changes. 

9. When the addendum is complete, it can be saved without a signature or signed 
now. 

• To save it without a signature, from the Action drop-down select Consult 
Results, and then Save Without Signature, or select Save Without Signature 
on the right-click menu. 

• To sign it now, from the Action drop-down, select Consult Results, and then 
Sign Note Now, or select Sign Note Now on the right-click menu. Add your 
electronic signature to the next dialog. 

4.1.18 Print SF 513 for a Consult 
Follow these steps to print the SF 513 information about a consult: 

1. Select the Consults component. 

2. Select the consult about which you want to print SF 513 information. 

3. Select from the Action drop-down, select Consult Tracking. 

4. Select Print SF 513. The Print SF 513 dialog opens. 
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Figure 4-38: Print SF 513 dialog 

5. Enable the appropriate option button in the Print panel. 

6. Normally, the right margin and the page length values (measured in characters) 
are already defined by the print. Select a printer to which you want to output the 
information. 

7. Whatever is selected adds a label to the dialog, such as: Print Chart Copy on: 
<selected device>. 

8. Check Save as user’s default printer, if appropriate. 

9. Click OK to have the information output to the selected printer. 

4.1.19 Receive a Consult 
The Consult Receiver uses this feature to acknowledge receipt of a new consult in the 
Service and to change the current CPRS status of the consult from Pending to Active. 

This action puts the receiving service on record as accepting responsibility for 
completing the consult. 

Follow these steps to receive a consult: 

1. Select the Consults component. 

2. Select the Consult to receive. 

3. From the Action drop-down, select Consult Tracking. 

4. Select Receive. The Receive Consult dialog opens. 
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Figure 4-39: Receive Consult dialog 

5. Enter comments about receiving the consult in the Comments field, for example, 
if there is anything unusual about the consult. This field has a right-click menu to 
aid in editing the text. 

6. Change the date and/or time, if needed. Enter the date/time in the Date/time of 
this action field, or click the Ellipsis button to select the date and time from a 
calendar. 

7. If this action should be by another person, select a name from the drop-down list 
for the Action by field. 

8. When the Receive Consult dialog is complete, click OK. The status of the consult 
becomes (a) for Active. 

The received consult information is added to the text of the consult in the 
Activity grid, followed by any comments added. 

 
Figure 4-40: Received Consult in the Text of the Consult 
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4.1.20 Schedule a Consult 
The Consult Receiver uses this action. The Schedule a Consult does not actually 
schedule an appointment or link to a scheduling package. It does allow a convenient 
way to annotate a consult after an appointment has been scheduled by some other 
means. The Comments most likely will explain when the consult is scheduled. 

This action changes the status of the consult to (s) for Scheduled. 

Follow these steps to schedule a consult: 

1. Select the Consults component. 

2. Select the Consult to receive. 

3. From the Action drop-down, select Consult Tracking. 

4. Select Schedule. The Schedule Consult dialog opens. 

 
Figure 4-41: Schedule Consult dialog 

5. Type the comments about the scheduled consult in the Comments field. This field 
has a right-click menu to aid in editing the text. 

6. Enter the date/time in the Date/Time of this action field, or click the Ellipsis 
button to select the date and time from a calendar. The date/time here must 
established by the healthcare facility as to its meaning. Either it is the date the 
Schedule a Consult dialog was completed or it is the date for which the consult is 
scheduled. 
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7. If this action should be by another person, select a name from the drop-down list 
for the Responsible Person field. 

8. If you want to send an alert about the scheduled consult, check Send alert to 
display the Send Alert dialog. 

 
Figure 4-42: Send Alert dialog 

a. Select a name in the Select or enter name field. That name will appear in the 
Currently selected recipients field. 

b. To remove a name from the Currently selected recipients field, select it. 

c. When the Send Alert is complete, click OK to have an alert sent. Otherwise, 
click Cancel to not send an alert. 

9. When the Schedule Consult dialog is complete, click OK. The status of the 
consult changes to (s) for Scheduled. 

10. The scheduled consult information is added to the text of the consult in the 
Activity grid, followed by comments that were added. 

 
Figure 4-43: Scheduled Consult in Text of the Consult 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

160 

4.1.21 Significant Findings for a Consult 
The Consult Receiver uses this action to mark a consult has having significant 
findings. When this action is completed, an asterisk (*) precedes the name of the 
consult. 

The significant findings action allows a clinic or service to append a significant 
findings flag onto a consult, whether completed or not. 

Follow these steps to enter significant findings for a consult: 

1. Select the Consults component. 

2. Select the consult to which you want to add significant findings. 

3. From the Action drop-down menu, select Consult Tracking. 

4. Select Significant Findings. The Update Significant Findings dialog opens. 

 
Figure 4-44: Update Significant Findings dialog 

5. Enable the appropriate option button in the Significant Findings panel. 

6. Type information about the findings in the Comments field. This field has a right-
click menu to aid in editing the text. 

7. Enter the date/time in the Date/time of this action field, or click the Ellipsis button 
to select the date and time from a calendar. 
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8. To send an alert about the significant findings, check Send alert to display the 
Send Alert dialog. 

 
Figure 4-45: Sent Alert dialog 

a. Select a name in the Select or enter name field. The name is added to the 
Currently selected recipients field. 

b. To remove a name from the Currently selected recipients field, select it. 

c. When the Send Alert is complete, click OK to have an alert sent. Otherwise, 
click Cancel to not send an alert. 

9. When the Update Significant Findings dialog is complete, click OK. 

An asterisk (*) shows before the consult containing significant findings. 

 
Figure 4-46: Consult with Significant Findings in Left Panel 

The signification findings information is added to the text of the consult in the 
Activity grid, along with comments that were added. 

 
Figure 4-47:Significant Findings in the Text of the Consult 
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4.1.22 Viewing Consults 
When a specific consult is selected, an area that lists any notes associated with the 
consult is shown. Alternatively, a note entry may be clicked to view the full text of 
the note. 

An asterisk (*) preceding the title indicates that there are significant findings for that 
consult. See the section Status of a Consult to review the meaning of the status of 
each consult. 

 
Figure 4-48: Text of Selected Consult 

Follow these steps to view consults for the selected patient: 

1. Select the Consults tab. 

2. Select the consult to view from the All Consults list. 

3. The text of the consult appears in the right panel. Any notes associated with that 
consult appear in the Related Documents panel. To view the text of a related note, 
select the note. 

4. The contents of a selected consult may be printed by selecting File, and then Print. 
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4.1.23 Changing Views 
Changing the view of the Consults list enables the viewing of the list of consults 
based on one of several criteria which speeds up the selection process. 

The Consults view can be set to only include the following problems: 

• All Consults (displays all consults for the current patient) 

• Consults by Status (select a status and sort order) 

• Consults by Service (select a service and sort order) 

• Consults by Date Range (select a date range and sort order) 
To change the view, select the View menu and then select the desired list items. This 
action changes what consults are listed in the upper-left panel of the Consults tab. 

Select the Custom View option on the menu to further focus the list of consult notes 
which to view. 

 
Figure 4-49: Selecting the Custom View Option 

From the List Selected Consults dialog, opt to display consults by any combination of 
service, status, date range, group, and sort order. 
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Figure 4-50: List Selected Consults dialog for Custom View 

After clicking OK, the consults with the specified features display in the upper, left 
panel of the Consults tab. 

4.1.24 Consult Notes 

4.1.24.1 Notes Associated with a Consult 
The notes associated with a consult appear in the lower left panel of the Consults tab 
under Related Documents. 

The  icon indicates a note, while the  icon indicates an addendum. 

 
Figure 4-51: Related Documents for a Consult 
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There are several edit features associated with notes. They are found on the Consult 
Results menu as well as on the right-click menu in the text of the note. 

 
Figure 4-52: Edit Features for Notes 

4.1.24.2 Add to Signature List for Notes of Consult 
The Add to Signature List feature places the unsigned note with other orders and 
documents which need signatures for the current patient on the Notification tab. 

Follow these steps to add the note of a consult to your signature list: 

1. Select the Consults component. 

2. Select the consults having the unsigned note. 

3. Select an unsigned note. 

4. From the Action drop-down menu, select Consult Results. 

5. Select Add to Signature List. Alternatively, select the Add to Signature List 
option on the right-click menu. 

The selected note appears on the Notifications tab (along with other documents and 
orders). 

4.1.24.3 Delete Note of Consult 
The delete note applies to a note or addendum associated with a consult that is not 
complete. 

Follow these steps to delete a note: 

1. Select the Consults component. 

2. Select the note (or addendum) of a consult that is not complete. 

3. From the Action drop-down menu, select Consult Results. 

4. Select Delete Note. Alternatively, select Delete Note from the right-click menu. 
The Confirm Deletion message appears. 
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Figure 4-53: Confirm Deletion of Note 

5. Click Yes to delete the note. Otherwise click No. If you selected to delete the 
note, it is removed from the Related Documents of the selected consult. 

4.1.24.4 Edit Note of Consult 
The edit note applies to a note or addendum associated with a consult that is not 
complete. 

Follow these steps to edit a note: 

1. Select the Consults component. 

2. Select the note (or addendum) of a consult that is not complete. 

3. From the Action drop-down menu, select Consult Results. 

4. Select Edit Note. Alternatively, select Edit Note from the right-click menu. The 
text of the note appears in the right panel where you can change the note. 

5. Use the Templates button or the Reminders button to add text to the note. 

6. When the note is complete, sign now or save without signature. 

• To save it without a signature, from the Action drop-down menu, select 
Consult Results, and then select Save Without Signature. Alternatively, select 
Save Without Signature from the right-click menu. 

• To sign it now, from the Action drop-down menu, select Consult Results, and 
then Sign Note Now. Alternatively, select Sign Note Now from the right-click 
menu. Add your electronic signature to the next dialog. 

4.1.24.5 Identify Additional Signers for Consult Note 
Use the Identify Additional Signers feature to need additional signers, such as for 
users in a training capacity. 

Follow these steps to identify additional signer for a signed note associated with a 
consult: 

1. Select the Consults component. 

2. Select the note of the consult for additional signers. 
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3. From the Action drop-down menu, select Consult Results. 

4. Select Identify Additional Signers. Alternatively, select Identify Additional 
Signers from the right-click menu. The Identify Additional Signers dialog opens. 

 
Figure 4-54: Identify Additional Signers dialog for Notes to Consults 

5. Select the additional signers from the scroll list of the Select or enter additional 
signers panel. 

6. The additional signer names appear in the Current additional signers panel. To 
remove a particular name in this panel, select it and the name is removed from the 
panel. 

7. When this dialog is complete, click OK. In the text of the progress note near the 
bottom, the following is shown: 

* AWAITING SIGNATURE * <selected names> 

4.1.24.6 Print Note 
The print note action prints the information about the selected note. 

Follow these steps to print the information within a note: 

1. Select the Consults component. 

2. Select the note of the consult to print. 

3. From the Action drop-down menu, select Consult Results. 
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4. Select Print Note. Alternatively, select Print Note from the right-click menu. The 
Print dialog opens. 

 
Figure 4-55: Print dialog 

5. Select the appropriate option button in the Print panel. 

6. Select a printer. 

7. Normally the right margin and the page length values (measured in characters) are 
already defined by the printer. Your selections add a label to the dialog, such as: 
Print Chart Copy on: <selected device>. 

8. Select the Save as default printer check box, if applicable. 

9. Click OK. The information about the note outputs to the selected printer. 

4.1.25 Consult Addendum 
An Addendum is a medical statement by the patient care professional about a specific 
Note; it supplies supplementary information on the patient. It differs from a Comment 
in that an Addendum is about medical matters, where Comments, which can be 
written by anyone, contain information needed to administer the consult. 

This action enables one or more users to add comments to the results of a consult. 
Contrast this to Add Comment, which adds a note to the consult before it is resulted. 

Follow these steps to add an addendum to a consult. 

1. Select the Consults component. 

2. Select the note about the Consult. 
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3. From the Action drop-down menu, select Consult Results. 

4. Select the Addendum option. Alternatively, select Make Addendum from the 
right-click menu. 

5. Type the supplementary information about the patient’s condition in the right 
panel. 

6. As with other TIU objects, information can be added to the addendum by clicking 
the Templates button and/or the Reminders button. Both buttons add boilerplate 
information to the addendum text. 

7. To change the properties of the addendum, click the Change button. Alternatively, 
from the Action drop-down menu, select Consult Results, and then Change Title. 
The Addendum Properties dialog opens. 

 
Figure 4-56: Addendum Properties dialog 

8. Change the information on the Addendum Properties dialog as needed, and then 
click OK. The information above the text of the addendum reflects your changes. 

9. When the addendum is complete, save it without a signature or sign it now. 

• To save it without a signature, from the Action drop-down menu, select 
Consult Results, and then select Save Without Signature. Alternatively, select 
Save Without Signature from the right-click menu. 

• To sign it now, from the Action drop-down menu, select Consult Results, and 
then Sign Note Now. Alternatively, select Sign Note Now from the right-click 
menu. Add your electronic signature to the next dialog. 

4.2 Exams 
The Exams panel is used to add, edit, or delete a patient exam. To view information 
regarding the meaning of the results, click the Result heading. 
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Figure 4-57: Exams Panel 

When viewing the Location of the exam (not historical), it is defaulted to the 
provider’s location (in the Exams grid). 

This component can be configured so that a particular user or class cannot add/edit an 
exam. 

4.2.1 Adding an Exam 
The Add function creates a current or historical exam, or creates a refusal for an 
exam. To add an exam: 

1. Select a visit. 

2. Click Add in the Exams panel (or select the Add Patient Exam option on the 
right-click menu) to display the Exam Selection dialog. 

Note: Use the scroll bar to view all available exams. You can sort 
either column by clicking its heading. 

 
Figure 4-58: Exam Selection dialog 

3. Highlight the exam you want to add. 

4. Click Select. The Document an Exam dialog opens. (Otherwise, click Cancel.) 
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Figure 4-59: Document an Exam dialog 

Note: To re-display the Exam Selection dialog, click the Ellipsis 
button next to the Exam field. 

5. Select one of the following option buttons: 

• Current Exam 

• Historical Exam 

• Not Done 

4.2.1.1 Current Exam 
To view an exam that is current: 

1. Select the Current option button when the exam is for the current visit. 

 
Figure 4-60: Document an Exam dialog 

2. In Result, select the result for the exam from the drop-down list: 

• Abnormal 

• Normal/Negative 

• Referral Needed 
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3. In the Comment field, type a comment about the exam (if applicable). This field 
has a right-click menu to aid in editing the text. Use this field to note abnormal 
findings, for example. 

4. If the provider of the exam is different from what is displayed in the Provider 
field, click the Ellipsis button to display the Lookup Utility. There you can select 
the proper provider. See Using the Lookup Utility dialog for Provider for more 
information. 

5. Complete the Document an Exam dialog. Refer to Completing the Document an 
Exam dialog for details. 

4.2.1.2 Historical Exam 
You can add a historical exam by having no visit selected and clicking the Add 
button. The Document an Exam dialog displays with the Historical option button 
selected. 

1. Select the Historical option button when the exam is for an historical visit. 

 
Figure 4-61: Historical Event Panel 

2. In Result, select the result for the exam from the drop-down list: 

• Normal/Negative 

• Positive 

• Referral Needed 
3. In Comment, type a comment about the exam (if applicable). This field has a 

right-click menu to aid in editing the text. You use this field to note abnormal 
findings, for example. 
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4. If the provider of the exam is different from what is displayed in the Provider 
field, click the Ellipsis button to display the Lookup Utility, where you can select 
the proper provider. See Using the Lookup Utility for Provider for more 
information. 

5. Complete the Historical group box: 

• Enter a date in the Event Date field by either manually typing it or by clicking 
the Ellipsis button to select from a calendar. It must be a past date. 

• The Location field has a right-click menu to aid in editing the information. 

• If the location is an official IHS facility, select the IHS/Tribal Facility Option 
button. 

You can select the location from the Lookup Utility dialog by clicking the 
Ellipsis button. If you manually enter a facility name, it must be an official 
IHS facility. If not, when you leave the field the Lookup Utility dialog 
displays. See Using the Lookup Utility dialog for Location for more 
information. 

• If your site has been configured with a default outside location, type OTHER 
in the Location field. Then, when the View Visit Detail dialog displays, the 
default outside location displays at the LOC. OF ENCOUNTER field. 

• If the location is not an official IHS facility, select the Other option button. 
Enter the non-official location (for example, Dr. Example Doctor). 

6. Complete the Document an Exam dialog. Refer to Completing the Document an 
Exam dialog for details. 

4.2.1.3 Exam Not Done 
1. Select the Not Done option button when the exam was not performed. 

 
Figure 4-62: Exam Not Done dialog 

2. In Reason, select the reason for the exam was not performed from the drop-down 
list. 
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3. In Comment, type a comment regarding the exam not being done (if applicable). 
This field has a right-click menu to aid in editing the text. 

4. If the provider of the exam is different from what is displayed in the Provider 
field, click the Ellipsis button next to display the Lookup Utility where you can 
select another provider. See Using the Lookup Utility dialog for Provider for 
more information. 

5. Complete the Document an Exam dialog. Refer to Completing the Document an 
Exam dialog for details. 

4.2.1.4 Completing the Document an Exam dialog 
After all fields have been completed, click Add to add the exam to the Exams panel. 
(Otherwise, click Cancel.) 

• After clicking Add on the current or historical dialog, the record, including any 
associated SNOMED CT or LOINC, is added to the Exams component. 

• After clicking Add on the refusal dialog, the record, including any SNOMED CT 
or LOINC, is added to the Exams component as well as to the Personal Health 
component. 

4.2.1.5 Using the Lookup Utility dialog for Provider 
Access the Lookup Utility by clicking the Ellipsis button at the end of the Provider 
field. Use this dialog to search for and select a name for the Provider field. 

Follow these steps to complete the Lookup Utility dialog for Provider. 

1. Type a few characters in the Search Value field and click Search. 

2. The appropriate names display in the lower panel of the dialog. If this is not the 
data you are searching for, repeat Step 1. 
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Figure 4-63: Lookup Provider dialog After Search 

3. Highlight the appropriate name in the lower panel and click OK. The selected 
record populates the Provider field. (Otherwise, click Cancel.) 

4.2.1.6 Using the Lookup Utility dialog for Location 
Access the Lookup Utility by clicking the Ellipsis button at the end of the Location 
field. Use this dialog to search for and select a location for the Location field. 

Follow these steps to complete the Lookup Utility dialog for Location. 

1. Scroll the list to the location and select it. Or, you can search for a location. 

2. To search for a location, type of few characters in the Search Value field and click 
Search. 

The appropriate locations display in the lower part of the dialog. If this is not the 
location you are searching for, repeat Step 2. 
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Figure 4-64: Lookup Location dialog After Search 

3. Highlight the appropriate record in the lower panel and click OK. The selected 
record populates the Location field. (Otherwise, click Cancel.) 

4.2.2 Editing an Exam 
An exam can only be edited until the visit attached to it is locked. At that time the edit 
option is grayed out and not selectable. 

1. You can edit a selected exam by clicking the Edit button (or by selecting the Edit 
Patient Exam option on the right-click menu). The Document an Exam dialog 
displays, with the option button selected (you cannot change) and the fields 
populated with data entered during the Add process. 

2. Edit any of the fields on the dialog. See Adding an Exam for more information 
about the fields. 

3. After all fields have been edited, click Save. (Otherwise, click Cancel.) 

4.2.3 Deleting an Exam 
Exams can only be deleted while the visit is unlocked. After that date, the delete 
option is not selectable. 

1. Click the Delete button (or select the Delete Patient Exam option on the right-
click menu) to display the Remove Patient Exam? information message. 
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Figure 4-65: Remove Patient Exam Information Message 

2. Click Yes to have the selected exam deleted from the Exam component. 
(Otherwise, click No.) 

Clicking Yes removes the record from the Exam component. This also removes it 
from the Personal Health component. (The reverse is also true.) 

4.3 Family History 
The Family History component displays any family history information about the 
patient. 

 

Figure 4-66: Family History Component 

This information comes from the Family History of the PCC patient record. It can 
appear on the Health Summary report. The Family History actually stores data in two 
files, one is a relationship file and the other is the Family History diagnoses. You can 
enter, edit, and delete both relationships and diagnoses in this one component. Just be 
aware of which you are working with. 

The view contains one line for each condition, so there may be multiple lines for the 
same Relation. 

No visit is needed to use this component. 

To view the UpToDate or other Web information about a Condition, refer to the Web 
Reference topic. 

To search for SNOMED CT codes mapped to an ICD, refer to the Get SCT Button 
topic. 
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4.3.1 Get SCT Button 
The Get SCT button takes the ICD code from a historical entry that is not 
SNOMED CT coded, launches to Apelon, and displays a list of SNOMED CT codes 
that are mapped to that ICD. 

An entry that is not SNOMED CT coded yet displays with an asterisk (*) in the 
Provider Narrative/Condition column of the Family History component main 
window. If the Provider Narrative/Condition column is empty, this also indicates the 
entry has not been SNOMED CT coded yet. 

The Get SCT button is only active when a Family History line item does not have a 
SNOMED CT code assigned yet. 

 
Figure 4-67: Family History Main Screen with SNOMED CT Coded and Not Coded Entries 

To add a SNOMED CT code to a family history entry, follow these steps: 

1. From the Family History component main window, select a family history line 
item where the Provider Narrative/Condition column either contains an asterisk or 
is blank, and then click the Get SCT button. The ICD 9 To SNOMED CT Lookup 
dialog opens. 
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Figure 4-68: ICD 9 to SNOMED CT Lookup dialog 

2. The Search Date field automatically defaults to the current date. Click the drop-
down arrow to open the calendar where a new date can be selected. 

3. The ICD 9 Value field is automatically populated with the ICD code from the 
Family History condition selected when the Get SCT button is clicked. You can 
change this by typing in a new code. 

Note: The Subset field automatically defaults to Family History 
and cannot be unselected. No other subsets are allowed. 

4. Click the Find button. The list of SNOMED CT terms is populated. 

5. Select and highlight a SNOMED CT concept term, and then click the Select 
button. The SNOMED CT code is saved to the entry and shows in the Provider 
Narrative/Condition column and the asterisk on the main Family History 
component is cleared. 
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4.3.2 Adding Family History 
To add Family History, follow these steps: 

1. From the Family History component main window, click the Add Relation button 
(or select Add Relation on the right-click menu) to display the Family History 
form where you can add family history data. 

 
Figure 4-69: Family History 

1. In Relation, select the applicable relation from the drop-down menu. 

Note: Only one relation can be added at a time. However, 
multiple problems can be added for one relation. 

2. In Name, type the relation's name. 

3. In Status, select the applicable status from the drop-down menu: 

• Living 

• Deceased 

• Unknown 

• Patient refused to answer 
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4. In Age at Death, if Deceased was selected in Status, select the applicable age at 
the relation's death from the drop-down menu: 

Note: If Deceased was not selected in Status, the Age at Death 
field is disabled. 

• In Infancy 

• Before age 20 

• At age 20-29 

• At age 30-39 

• At age 40-49 

• At age 50-59 

• 60 and older 

• Age Unknown 

5. In Cause of Death, type the cause of the relation's death. 

6. In Multiple Birth, select Yes or No from the drop-down menu. 

7. In Multiple Birth Type, if Yes was selected in Multiple Birth, select the applicable 
multiple birth type from the drop-down menu: 

Note: If No was selected in Multiple Birth, the Multiple Birth 
Type field is disabled. 

• Twin, Unspecified 

• Identical Twin 

• Fraternal Twin 

• Triplet 

• Other Multiple 
8. Add a Condition by clicking the Add button in the Condition section of the 

Family History dialog. The SNOMED CT Lookup dialog opens. 
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Figure 4-70: SNOMED CT Lookup 

a. In Diagnosis Lookup, select either the Fully specified name or Synonym 
option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the plus sign ( ) next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 
b. In Maximum Results, select the applicable option button to select the number 

of returned search results: 

• 25 

• 50 

• 100 

• 200 

• All 
c. In Search Date, the field defaults to the current date. Click the drop-down 

arrow to open the calendar and select a different date to search, if needed. 
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d. In Search, type the term by which you want to search. 

Note: The Subset field automatically defaults to Family History 
and cannot be unselected. No other subsets are allowed. 

e. Click the ALL SNOMED CT button. The list of SNOMED CT terms and their 
corresponding mapped ICD codes is populated. 

f. Select and highlight a term, and then click the Select button. The Family 
History Condition dialog opens with the SNOMED CT Description field of 
the Family History Condition dialog containing the SNOMED CT term 
description you selected. 

 
Figure 4-71: Family History Condition 

• If you need to change ICD Code, click the Change button to re-open the 
SNOMED CT Lookup dialog and repeat Steps a. through e. 

g. In Provider Text, type any notes or comments. 

h. In Age at Diagnosis, type the relation's age at the time of their diagnosis. 

• If the actual age is unknown, type an approximate age and click the 
Approximate check box. 

i. Click Save. The Family History Condition dialog closes and your entries are 
populated in the Condition section of the Family History dialog. 

9. In the Family History dialog, click Save. Your entry shows in the Family History 
list. 

 
Figure 4-72: Family History with Relation Added 
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To edit or delete a relation, refer to the Editing Family History or the Deleting Family 
History topics for details. 

4.3.3 Editing Family History 
To edit an existing family history relation, follow these steps: 

1. In the Family History tab, select the record you want to change, and then click 
Edit Relation. The Family History dialog opens. 

Note: You can also right-click in the line item and select Edit 
Relation from the menu. 

2. Make the changes, as applicable. Refer to the Adding Family History topic for 
details about each field. 

3. Add, edit, or delete Condition, in the Family History Condition dialog, select the 
line item of the condition, and then: 

• To add a Condition, refer to the Add a Condition section of the Adding 
Family History topic. 

• To edit a Condition, select the line item of the condition you want to edit, and 
then click the Edit Relation button (or right-click in the line item and select 
Edit Relation). The SNOMED CT Lookup dialog opens. 

• To delete a Condition, select the line item of the condition you want to delete, 
and click the Delete Relation button (or right-click in the line item and select 
Delete Relation). The Condition is deleted. 

4. Click Save in the Family History dialog. Your changes show in the Family 
History list. 

4.3.4 Deleting Family History 
To delete an existing family history relation, follow these steps: 

1. In the Family History tab, select the record you want to delete, and then click the 
Delete Relation button. The Delete Relation? information message appears. 

Note: You can also right-click in the line item and select Delete 
from the menu. 
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Figure 4-73: Confirm Relation Delete Information Message 

2. Click one of the following: 

• Click Yes to delete the selected record. 

• Click No to not delete the selected record. 

• Click Cancel to immediately leave the information message (no action taken). 

Note: When you delete a Relation, it also deletes ALL conditions 
for that relation. 

4.3.4.1 Deleting a Condition 
If you only want to delete a condition: 

1. Select the Relation line item, and then click Edit Relation. The Family History 
dialog opens. 

2. In the Condition section of the Family History dialog, select the Condition you 
want to delete, and then click the Delete button (or right-click and then select 
Delete). 
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Figure 4-74: Delete Condition Line Item 

The Delete Family? information message appears. 

 
Figure 4-75: Delete Family (Condition) Information Message 

3. Click Yes to delete the condition (or click No to cancel the action). 

4.3.5 Web Reference 
The Web Reference Search for the Family History component depends whether any 
records are present or not. 

4.3.5.1 Web Reference Condition 1 

If there are records present, select one and click the Information button ( ) to go to 
the UpToDate Reference Web site for the topic associated with the selected record. 
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4.3.5.2 Web Reference Condition 2 
1. If there are no records present or no record is selected, click the Information 

button to display the Web Reference Search dialog. 

 
Figure 4-76: Web Reference Search 

2. Select a Reference Site, if needed. The default is the UpToDate site. 

3. After entering a term and clicking Search, you are taken to the selected Web site 
for the specified term. 

4. You can change to another Web site by selecting from the Reference Site drop-
down list (on the Web site). The drop-down list for the Reference Site field (on 
the Web Reference Search dialog) can be configured. 

4.4 Historical Diagnosis 
The Historical Diagnosis is a view-only component that shows the historical visits for 
the current patient and information regarding the diagnosis for the visit. 

 
Figure 4-77: Historical Diagnosis Panel 

View visit information by selecting a record and then selecting View Visit Detail on 
the right-click menu. The Visit Detail dialog opens. 
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4.4.1 Web Reference Search Function 
There are two Web Reference search options available from the Historical Diagnosis 
component that enables the user to look up information on a highlighted diagnosis 
from the Provider Narrative column on the Historical Diagnosis dialog: 

• Education Information button 

• Clinical Decision Support button 
The Web Reference search depends on if any records are present or not when you 
click either button. 

• Condition 1: If there are records present, select a record and click either the Ed 
Information or the Clinical Decision Support button. 

Note: You can change to a different Web site, if desired, by 
selecting from the Reference Site drop-down list. 

• Condition 2: If there are no records present or if no record is selected, click either 
the Education Information button or the Clinical Decision Support button to 
display the Web Reference Search dialog. The UpToDate Web site is the default. 

 
Figure 4-78: Web Reference Search dialog 

Select a different Reference Site from the drop-down menu, if needed. After entering 
a term and clicking Search, the selected Web site opens for the specified term. 

4.4.1.1 Education Information Button 
When a patient diagnosis is selected, click the Education Information button. This 
sends a call to the MedlinePlus Web site to provide information regarding the 
selected topic and the MedlinePlus Web site opens to the related page. 

Note: The Add Patient Education Event dialog also opens when 
the Education Information button is clicked. Patient 
education is tracked for Meaningful Use, therefore, the Add 
Patient Education Event dialog should be completed. Refer 
to the Patient Education Online Help for details on 
completing this dialog. 
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Figure 4-79 Medline Plus Web Site 

4.4.1.2 Clinical Decision Support Button 
When a patient diagnosis is selected, click the Clinical Decision Support button. This 
sends a call to the UpToDate Web site to provide information regarding the selected 
topic and the UpToDate Web site opens to the related page. 

 
Figure 4-80: UpToDate Web Site 
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4.5 Immunizations 
The Immunizations component enables the viewing, editing, and adding of 
immunization information for patients into the RPMS. It requires that version 8.0, or 
later, of the RPMS Immunization package be installed. This component enables the 
provider to see immediately which vaccines the patient has received and which ones 
are needed. 

 
Figure 4-81: Immunization Panel 

• The Forecast field contains the vaccinations that the patient needs, as derived 
from the ImmServe Forecasting System. 

• The Contraindications field displays the patient’s contraindications, such as a 
history of chicken pox or refusals for specific vaccines. 

• The Vaccinations grid displays all vaccinations that have been entered into the 
RPMS. The vaccinations can be sorted by selecting a column heading. If no 
Vaccination information is present in the RPMS for a patient, the grid is empty. 

• This component can be configured so that particular user or class cannot add/edit 
the immunization record. 

• The Vaccinations panel has the Display Visit Detail option on the right-click 
menu. Use this option to display the Visit Detail for a selected record. See Display 
Visit Detail for more information 
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4.5.1 Selecting a Vaccine 

 
Figure 4-82: Selecting a Vaccine dialog 

Follow these steps to select a vaccine: 

1. The selection list on the Vaccine Selection dialog is initially populated with all 
vaccines. This can be changed to Show Only Active Vaccines with a Lot Number 
or Show All Active Vaccines by clicking that option button. 

Note: If you select an Inactive vaccine, it is marked as a historical 
vaccination entry. 

2. You can filter the list by entering a search value. The search value can either be 
the first few letters of an Immunization name, HL7-CVX code, or a Brand name. 
A long description of the vaccine can be displayed by briefly resting your mouse 
pointer on a vaccine entry in the grid. 

3. To select an entry, double-click the vaccine entry in the grid, highlight it, and 
click OK, or highlight it and press Enter. (Otherwise, click Cancel). 

4.5.2 Web Reference 
The Web Reference Search for the Immunization component depends on whether any 
records are present or not. 

• Condition 1: If there are records present, select one and click the Information 
button (or select the Web Reference option on the right-click menu) to go to the 
MedlinePlus Web site for the topic associated with the selected record. You can 
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change to another Web site by selecting from the Reference Site drop-down list 
(on the Web site). 

• Condition 2: If there are no records present or if no record is selected, click the 
Information button (or select the Web Reference option on the right-click menu) 
to display the Web Reference Search dialog. 

 
Figure 4-83: Web Reference Search dialog 

Select a Reference Site, if needed. The default is the MedlinePlus Web site. After 
entering a term and clicking Search, the selected Web site for the specified term 
appears. You can change to another Web site by selecting from the Reference Site 
drop-down list (on the Web site). 

4.5.3 Vaccinations Group Box 
You can add new or historical immunizations regardless of whether the patient is a 
child or adult, or is included in the immunization registry or not. New immunizations 
are those that are given for a visit, whereas historical or those that were given in the 
past and typically would be for an outside facility or place. It is important to note that 
for non-historic visits, the date and location of the immunization correspond to the 
currently selected encounter in the EHR, which can be for past dates. 

4.5.3.1 Adding a Vaccination 
Follow these steps to add a Vaccination: 

1. Click Add on the Vaccinations group box (or select Add Vaccination on the right-
click menu) to display the Vaccine Selection dialog. Here you select a vaccine. 
See Selecting a Vaccine for more information. 

2. The selected vaccine populates the Vaccine field on the Add Immunization 
dialog. 

If you choose to add an Immunization for which the patient has a related 
contraindication, the application displays an alert and asks if you want to 
continue. 
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Figure 4-84: Contraindication Alertuser123u 

The following topics address information about the Current, Historical, and Not Done 
option buttons. 

4.5.3.1.1 Current 
1. If a compound vaccine is selected, then a separate immunization record is added 

for each component. 

 
Figure 4-85: Add Immunization dialog 

2. You can change the Administered By field, if necessary. Click the Ellipsis button 
to select another person. 
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3. In the Lot field, select the applicable lot and manufacturer from the drop-down 
menu. 

4. Populate the Injection Site field by selecting from the drop-down list. 

5. For common vaccines, the application automatically loads default values for the 
Volume, Vaccine Information Sheet, and Given fields. You can change any of 
these fields. 

Note: If you select an expired lot number, a warning message is 
displayed in bold red lettering above the Lot field. 

6. The Given field contains the exact date and time that the immunization was 
administered. The default is the current date and time. You can change the date by 
clicking the Ellipsis button and selecting from a calendar. 

7. If you counseled the patient/family about the immunization, select the 
Patient/Family Counseled by Provider check box. If you selected this check box 
and saved the record, the EHR populates the Vaccinations component with a 
record and populates the Education component with a record. 

8. In the Vac. Eligibility field, select an applicable vaccination eligibility from the 
drop-down menu. 

9. In the Admin Notes field, type any applicable notes. 

10. When the Add Immunization dialog is complete, click OK to add the vaccination 
to the Vaccinations group box. (Otherwise, click Cancel.) 

4.5.3.1.2 Historical 
Historical immunizations are those that were given in the past and typically would be 
for an outside facility or place. 

Adding a historic immunization results in an historic visit being created that cannot 
be billed or exported. 

Note: You can add a historical record by not selecting a visit and 
clicking the Add button on the Vaccinations group box. 
The Add Historical Immunization dialog displays. 

To add a historical record: 

1. Select the Historical option button on the Add Immunization dialog to display the 
Add Historical Immunization dialog. 
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Figure 4-86: Add Historical Immunization dialog 

2. Manually type the event date (must be historical) or click the Ellipsis button to 
select from a calendar. 

3. Populate the Location field. This field has a right-click menu to aid in editing the 
information. 

• If the location is an official IHS facility, make sure the IHS/Tribal Facility 
option button is checked. You can select the location from the Lookup Utility 
dialog by clicking the Ellipsis button. If you manually enter a facility name, it 
must be an official IHS facility. If not, when you leave the field, the Lookup 
Utility dialog displays. 

• If the location is not an official IHS facility, check the Other option button. 
Enter the non-official location (for example, Dr. Name Example). 

• If your site has been configured with a default outside location, type OTHER 
in the Location field. Then, when the View Visit Detail dialog displays, the 
default outside location displays at the LOC. OF ENCOUNTER field. 

4. In the Admin Notes field, type any notes, as needed. 

5. When the Add Historical Immunization dialog is complete, click OK to add the 
historic vaccination to the Vaccinations group box. (Otherwise, click Cancel.) 
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4.5.3.1.3 Not Done 
Enter the immunization refusal information on the Add Immunization dialog by 
selecting the Not Done option button to display the Add Immunization Not 
Provided/Refused dialog. 

 
Figure 4-87: Add Immunization Refusal dialog 

1. If the Vaccine is incorrect, click the Ellipsis button to select another one. See 
Selecting a Vaccine for more information. 

2. If needed, change the Documented By field by clicking the Ellipsis button to 
select another person. 

3. The Event Date defaults to the current date. If needed, change the event date by 
clicking the Ellipsis button to select from a calendar. 

4. Select the Reason from the drop-down list. 

5. Click OK when the dialog is complete. This adds an immunization refusal record 
to the Vaccinations group box, as well as adding a Not Done record to the 
Personal Health component. (Otherwise, click Cancel.) 
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4.5.3.2 Editing a Vaccination 
Make sure a visit is selected. Follow these steps to edit a vaccination: 

1. Highlight a vaccination record on the Vaccinations grid that you want to edit. 

Note: Vaccinations can only be edited until the visit is locked. 

2. Click Edit on the Vaccinations group box (or select Edit Vaccination on the right-
click menu) to display the Edit Immunization dialog. The existing information 
about the selected record displays. 

 
Figure 4-88: Edit Immunization dialog 

3. To edit the fields above the Reaction field, see Adding a Vaccination. 

4. You can edit the Dose Override field only if you have been assigned the BIZ 
EDIT PATIENTS security key and would typically not be specified. 

5. The Dose Override field affects the forecasting. It ignores invalid doses and 
counts forced valid doses. The field is used to force a dose valid (if given a day or 
so early but will not affect school) or invalid (due to expired vaccine, and so on). 

6. Enter a reaction by selecting from the drop-down list for the Reaction field. 

7. When a reaction is entered, if it is either: ‘Anaphylaxis, Convulsions, Lethargy, or 
Fever>104’, then a corresponding contraindication is automatically added. 

8. Otherwise, you are asked if it should be added as a contraindication for the 
patient. If you answer yes, a contraindication of Other Allergy is added. 
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Figure 4-89: Information Message when Saving Contraindication 

9. Click Yes to save the reaction as a contraindication. (Otherwise, click No.) 

10. When the Edit Immunization dialog is complete, click OK to change the 
information about the selected record. (Otherwise, click Cancel.) 

4.5.3.3 Deleting a Vaccination 
To delete a vaccination: 

1. Highlight a vaccination record in the Vaccinations group box that you want to 
delete. 

Note: Vaccinations can only be deleted on an unlocked visit. 

2. Click Delete (or select Delete Vaccination on the right-click menu) to display the 
Remove Vaccination? information message. 

 
Figure 4-90: Remove Vaccination Information Message 

3. Click Yes to remove the vaccination from the Vaccinations grid. (Otherwise, click 
No.) 

4.5.4 Vaccinations Group Box Buttons 
The following information provides information about the buttons on the 
Vaccinations group box. 

4.5.4.1 Print Record Button 
1. Click the Print Record button (or select Print Official Record on the right-click 

menu) in the Vaccinations group box to display/print the Official Immunization 
Record information for the current patient. 

The Print Record button requires that a letter template has been selected (in 
RPMS). 
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Figure 4-91: Official Immunization Record 

2. You can change the font size of the text displayed in this dialog by adjusting the 
size in the Font Size field (enter manually or use the Up and Down arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

3. Click Print to choose a printer and to output the (entire) contents of this dialog to 
the specified printer. The dialog has a right-click menu where you can copy 
selected text and paste it into any free-text field within the EHR or into another 
application (like MS Word). 

Note: The Print button may not appear. It depends on how your 
application is configured. 

4. Click Close to dismiss the dialog. 

4.5.4.2 Due Letter Button 
1. Click the Due Letter button (or select Print Due Letter on the right-click menu) in 

the Vaccinations group box to display/print the Due Letter. This letter is a 
reminder to make an appointment for the patient for the needed immunizations. 

The Due Letter button requires that a letter template has been selected (in RPMS). 
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Figure 4-92: Due Letter 

2. You can change the font size of the text displayed in this dialog by adjusting the 
size in the Font Size field (enter manually or use the up and down arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

3. Click Print to choose a printer and to output the (entire) contents of this dialog to 
the specified printer. The dialog has a right-click menu where you can copy 
selected text and paste it into any free-text field within the EHR or into another 
application (like MS Word). 

Note: The Print button may not appear. It depends on how your 
application is configured. 

4. Click Close to dismiss the dialog. 

4.5.4.3 Profile Button 
1. Click the Profile button (or select Print Profile on the right-click menu) in the 

Vaccinations group box to display/print the Immunization Profile dialog. This 
provides information about the patient’s immunization profile. 

This button requires that the forecaster is installed and the immunization site 
parameters need to be configured to point to the forecaster. 
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Figure 4-93: Immunization Profile Information 

2. You can change the font size of the text displayed in this dialog by adjusting the 
size in the Font Size field (enter manually or use the up and down arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

3. Click Print to choose a printer and to output the (entire) contents of this dialog to 
the specified printer. The dialog has a right-click menu where you can copy 
selected text and paste it into any free-text field within the EHR or into another 
application (like MS Word). 

Note: The Print button may not appear. It depends on how your 
application is configured. 

4. Click Close to dismiss the dialog. 

4.5.4.4 Case Data Button 
Click the Case Data button (or select Case Data on the right-click menu) in the 
Vaccinations group box to view/edit the Immunization Register data for the patient. 
The user must have the BIZ EDIT PATIENTS key turned off in order to use this 
button. 
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Since the Immunization Register is a very actively managed register and reports only 
those patients that have an ACTIVE status, the panel is used to case manage the 
immunization register. 

Click the Case Data button to display the Edit Patient Case Data dialog. 

 
Figure 4-94: Edit Active Patient Case Data 

4.5.4.4.1 Active/Inactive (Option Buttons) 
This indicates the status of the patient in the immunization register. All children from 
birth to 36 months that live in Government Performance and Results Act of 1993 
(GPRA) communities are automatically ACTIVE. On review of children, some are 
changed to INACTIVE is they fit the MOGE (Moved or Going Elsewhere) criteria. 

When you choose to change to INACTIVE status, you need to justify or explain why. 
In the Moved To/Elsewhere field, you indicate where the patient went, such as El Rio 
Clinic, for example. The Inactive Date is very important because the child is included 
in all reports up to that inactive date. Since children and their parents do not report 
that they have moved away (they just stop coming to the clinic), this function gives 
those producing GPRA reports a way to have a more accurate denominator to track 
and do the GPRA reports. 
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Figure 4-95: Inactive Data Group Box Fields 

• If you include the name in the Parent/Guardian field, that information is included 
in the reminder letters. 

• The Other Info field is where the case manager can enter anything that might be 
valuable. 

1. You can populate the remaining field by selecting from the drop-down lists. 

2. Click OK to update the immunization register with the entered data. (Otherwise, 
click Cancel.) 

4.5.5 Contraindications Group Box 
If the patient has had a contraindication or refusal to an immunization, you can record 
it with the corresponding reason being specified. Any contraindications entered for 
the patient are displayed in the Immunization component, and you are alerted if the 
associated vaccine is subsequently selected. 

4.5.5.1 Adding a Contraindication 
Make sure a visit is selected. To add patient contraindications, follow these steps: 

1. Click Add on the Contraindications group box (or select Add Contraindication on 
the right-click menu) to display the Enter Patient Contraindication dialog. 
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Figure 4-96: Adding a Contraindication dialog 

2. Click the Ellipsis button at the end of the Vaccine field to display the Vaccine 
Selection dialog. Here you select a vaccine. See Selecting a Vaccine for more 
information. The selected vaccine displays in the Vaccine field of the Enter 
Patient Contraindication dialog. 

3. Click Yes to continue on the Enter Patient Contraindication dialog. (Otherwise, 
click No). 

4. Highlight the Contraindication Reason. You may need to use the scroll bars to 
find the correct reason. 

5. When the Enter Patient Contraindication dialog is complete, click Add to add the 
contraindication to the Contraindication panel. (Otherwise, click Cancel.) 

The contraindication shows in the Contraindications group box and in the patient's 
Official Immunization Record. 

4.5.5.2 Deleting a Contraindication 
To delete a contraindication: 

1. Highlight a contraindication record in the Contraindications group box that you 
want to delete. 

2. Click Delete (or select Delete Contraindication on the right-click menu) to display 
the Remove Contraindication? information message. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

205 

 
Figure 4-97: Remove Contraindication Information Message 

3. Click Yes to remove the contraindication from the Contraindication field. 
(Otherwise, click No.) 

4.5.6 Display Visit Detail 
The Immunization component has the Display Visit Detail option on the right-click 
menu. 

1. Select any record and select the Display Visit Detail option. The Visit Detail 
displays. 

 
Figure 4-98: Visit Detail 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

206 

2. You can change the font size of the text displayed in the Visit Detail dialog by 
adjusting the size in the Font Size field (enter manually or use the Up and Down 
arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

3. Click Print to choose a printer and to output the (entire) contents of the Visit 
Detail to the specified printer. 

Note: The Print button may not be there. It is according to how 
your application is configured. 

4. The Visit Detail has a right-click menu where you can copy selected text and 
paste it into any free-text field within the EHR or into another application (like 
MS Word). 

5. Click Close to dismiss the Visit Detail dialog. 

4.5.7 Using the Lookup Utility dialog for Location 
Access the Lookup Utility by clicking the Ellipsis button at the end of the Location 
field. This dialog can be used to search for and select a location for the Location field. 

 
Figure 4-99: Initial Lookup Location dialog 

To complete the Lookup Location dialog: 

1. You can scroll the list to the location and select it. Otherwise you can search for a 
location. 

2. To search for a location, type of few characters in the Search Value field and click 
Search. 
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The appropriate locations display in the lower part of the dialog. If this is not the 
location you are searching for, repeat Step 2. 

 
Figure 4-100: Lookup Location dialog After Search 

3. Highlight the appropriate record in the lower panel and click OK. The selected 
record populates the Location field. (Otherwise, click Cancel.) 

4.6 Infant Feeding 
The Infant Feeding component is only active for children less than five years old. 
Otherwise, the Not Applicable message displays. 

 
Figure 4-101: Active Infant Feeding Component 

• The Infant Feeding History grid displays the feeding choices, the event dates 
already entered for the current (infant) patient, and any secondary fluids given to 
the infant. The records are listed in date order, with the most recent on top. This 
component requires that a visit is selected in order to update the data. 

• A red 1 in the column before the Feeding Choice column indicates the visit is 
locked (and the record cannot be edited), and a zero indicates the visit is not 
locked and can be edited. 

• This data is collected because it is used in conjunction with the Childhood Weight 
Control GPRA measure. This is a long-term measure to support the reduction of 
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the incidence of childhood obesity. Breastfeeding rates are used in the PART 
report for congress and Office of Management and Budget (OMB). Additionally, 
facilities can use this data to track infant feeding patterns and breastfeeding rates 
within their own patient populations. 

4.6.1 Add/Update Feeding Choice 
Click the Add or Edit button on the Infant Feeding component, or right-click and 
select Add or Edit to add or update the feeding choice record. The Infant Feeding 
Choice dialog opens. 

 
Figure 4-102: Infant Feeding Choice dialog 

The list allows only one selection. To change a selected option button, click the new 
option button to de-select the previous selection. 

The selections are defined as follows: 

• Exclusive Breastfeed: Formula supplementing less than three times per week (<3x 
per week). 

• ½ Breast, ½ Formula: Half the time breastfeeding, half the time formula feeding. 

• Formula only: Baby receives only formula. 

• Mostly Breastfeed: Formula supplementing three or more times per week (>3x 
per week) but otherwise mostly breastfeeding. 

• Mostly Breastfeed, some Formula. 

• Mostly Formula, some Breastfeed. 

• Mostly Formula: The baby is mostly formula fed, but breastfeeds at least once a 
week. 
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4.6.1.1 Secondary Fluids 
The Secondary Fluids section becomes active when any option besides Exclusive 
Breastfeed, 1/2 Breast 1/2 Formula, or Formula only is selected. Select one or more 
of the following, as applicable: 

Note:  An optional comment can be typed in the field next to your 
selection (for example, to specify the fat content of the milk 
given). 

• Milk 

• Fruit juice 

• Carbonated drink 

• Sports drink 

• Glucose 

• Water 
Click OK to add the record to the Infant Feeding component (otherwise, click 
Cancel). The application displays the feeding choice, the event date (today’s date), 
and any secondary fluids for the record in the Infant Feeding component and stores 
the SNOMED CT codes associated with the feeding choices in the V Infant Feeding 
Choices file. 

4.6.2 Right-Click Menu 
A right-click menu is available in the Infant Feeding component. 

 
Figure 4-103: Infant Feeding Right-Click Menu 

• Add: Select to add infant feeding data. Refer to Add/Update Feeding Choice for 
details. 

• Edit: Select to edit infant feeding data. Refer to Add/Update Feeding Choice for 
details. 

• Delete: Select to delete the record. Refer to Delete Feeding Choice for details. 

• Display Visit Detail: Opens the Visit Detail dialog which can be used to view and 
print visit information. 
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4.6.3 Delete Feeding Choice 
If the visit associated with the particular record is not locked, the Delete button can be 
used to remove a particular record in the Infant Feeding component. 

Select a record in the grid and then click Delete, or right-click and select Delete. The 
Remove Record? information message opens. 

 
Figure 4-104:Remove Record? Information Message 

Click Yes to delete the record. (Otherwise, click No.) 

4.7 Lab 

4.7.1 Viewing Laboratory Test Results 
To view lab test results, follow these steps: 

1. Select the Labs component. 

2. In the Lab Results box, click the type of results you want to see. 

Note:  A  sign by a lab test means it has a schedule. 

3. Some of the results need you to determine which test results you want to see. If 
the Select Lab Test dialog appears, you need to choose the tests you want to see. 

a. If necessary, select the tests for which you want to see the results. 

b. Also, you may need to choose a date range (Today, One Week, Two Weeks, 
One Month, Six Months, One Year, Two Years, or All Results). 

4.7.1.1 Most Recent 
The Most Recent lab result view shows you the lab tests in reverse chronological 
order. You can then Step through one at a time using the forward and backward 
buttons or go to the first or last using the buttons with the double arrows. 
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Figure 4-105: Most Recent Laboratory Results Window 

4.7.1.2 Cumulative 
The cumulative report is the most comprehensive lab report. It displays all of the 
patient’s lab results. When selecting a large data range, this report may take some 
time before being displayed. The results are organized into sections. You can 
automatically scroll to that section by selecting it in the Headings list box. 

 
Figure 4-106: Cumulative Report 

4.7.1.3 All Tests by Date 
This report displays all lab results (except anatomic pathology and blood bank). The 
data is displayed in the order of the time of collection. 
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Figure 4-107: All Tests by Date Laboratory Results Report 

4.7.1.4 Selected Tests by Date 
This report is useful when you only want to review only specific tests. Microbiology 
results can also be selected. You will be prompted to select any lab tests: 

 
Figure 4-108:Select Laboratory Tests dialog 

In the  example, if you select CBC, Chem 7, Lithium, and Liver Functions, only the 
results for those tests would be displayed: 
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Figure 4-109: Select Lab Results 

4.7.1.5 Worksheet 
The Worksheet is similar to the Selected Test by Date report. It does not display 
microbiology results, but it has many features for viewing lab results. It is very useful 
for displaying particular types of patterns of results. 

Tests can be selected individually or by test groups. Any number of tests can be 
displayed. When selecting a panel test, such as CBC, the panel will be expanded to 
show the individual tests. Tests can be restricted to only display results for a specific 
specimen type. For example, displaying glucose results only on CSF can be 
accomplished by selecting the specimen CSF and then selecting the test Glucose. 
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Figure 4-110: Select Laboratory Test Worksheet 

Test groups enable you to combine tests in any manner. For example, a test group 
could combine CBC, BUN, Creatinine, and Platelet count. You can save those test 
groups for later use. You can also select test groups that other users have created. You 
cannot exchange or delete other’s test groups, only your own. Test groups are limited 
to seven tests, but you may have an unlimited number of test groups. 

To define your own test groups, select those tests you want and click the New button. 
If more than seven tests are selected, the New button will be disabled. If you want to 
delete a test group, deselect it and click the Delete button. If you want to replace an 
existing test group with other tests, select the test group, make any changes to the 
tests to be displayed and click the Replace button. 

Note:  These test groups are the same as those you may have 
already created using the Lab package. The seven-test 
restriction is a limitation of the Lab package. 

The Worksheet display is a table of results that can be displayed vertically or 
horizontally. Since only results are displayed in a table, comments are footnoted with 
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a ** and shows in the panel below the table. You can filter the results to only show 
abnormal values. This will quickly show tests that have results beyond their reference 
values. 

 
Figure 4-111: Worksheet Display 

4.7.2 Graphing Lab Results 
You can choose to view lab test results as a graph. Each occurrence of a test is a point 
on the graph. EHR draws lines between the points to form a visual representation that 
can help you see trends. The results are shown in blue. Dotted red lines show the high 
and low reference values for the test. 

You can use the following features by clicking the check box when viewing the 
graph: 

• Zoom: Enables the enlargement of a part of the graph by clicking and dragging 
from above and to the left of the area to below and to the right of it. 

• 3D: Makes the graph into a simple three-dimensional representation. 

• Values: Places the numerical results next to each point on the graph. 
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The following figure shows an example of the graph feature being used. 

 
Figure 4-112: Laboratory Graph Feature 

If you have created the clinical indexes, the updating graphing will be available on 
the Lab tab. 

 
Figure 4-113: Updated Lab Graphing 

Users can select multiple labs at a time and either view them separately or all 
together. Lab results can also be graphed with other data elements such as 
medications and vital signs. 
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Figure 4-114: Separate Graphs for Tests 

 
Figure 4-115: Combined Graph for Tests 
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Figure 4-116: Split Views with Multiple Graphs 

Users can set which items they want to appear in the graph and save them as a 
personal default. Only users with specific graphing keys can make public views. 

 
Figure 4-117: Graph Settings dialog 

Users can still make their own Lab groups and then use them for graphing. 
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Figure 4-118: Lab Groups 

Refer to Graphing for additional information. 

4.7.3 Microbiology 
Microbiology shows you the results from microbiology for the specified time period. 

 
Figure 4-119: Microbiology Laboratory Results 

4.7.4 Anatomic Pathology 
Anatomic Pathology shows you the results in this section for the specified time 
period. 
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Figure 4-120: Anatomic Pathology Laboratory Results 

4.7.5 Blood Bank 
Blood Bank shows any blood that was requested. It also shows the results of any 
screening and if the patient has any blood products in the blood bank. 

 
Figure 4-121: Blood Bank Laboratory Results 
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4.7.6 Lab Status 
As the name implies, you can use this option to check on the status of labs that have 
been ordered for the selected patient. The orders are grouped by date and show the 
order number, the type of lab ordered, the provider, the urgency, and the status. 

 
Figure 4-122: Lab Status Laboratory Results 

4.7.7 Graphing 
Enhanced Graphing is incorporated in the Labs and Reports tabs. This Graphing 
requires the Clinical Indexes, which are part of PXRM 1009. Once EHR 11 is 
installed, the site will build all the Clinical Indexes for Graphing to work 
appropriately. 

Not all of the data sources that the VA graphs are available at this time in the EHR. 
This is mainly due to differences between the two systems, with different files and 
fields being utilized. 
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Figure 4-123: Graphing Tool 

4.7.7.1 Types of Graphing 
EHR Graphing displays all items that are not Laboratory tests, vitals, or medications 
(Inpatient, non-VA, or Outpatient) as single events. Representations for single events 
use only the horizontal axis. EHR Graphing uses triangle-shaped representations to 
mark these items. 

 
Figure 4-124: POV Graphing 
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4.7.7.1.1 Medication Graphing 
EHR Graphing displays medications as bars that indicate a period of time. In the case 
of Outpatient medications, the bars begin on the horizontal axis at the release date of 
the medications. End dates are based on the following calculation: 

medication release date + number of days supply = end date 

For Inpatient and non-VA medications, the bars begin at medication Start Times and 
Dates, and end at medication Stop Times and Dates. In the case of non-VA 
medications, if no Stop Date exists, CPRS Graphing uses the Current Date as the Stop 
Date. 

EHR Graphing differentiates multiple medications by color and vertically offsets 
them to ensure the visibility of overlapping bars. 

Important:  Healthcare professionals have no reliable way to 
determine whether patients do or do not take their 
Outpatient medications. Use caution when graphing 
relationships between Outpatient medications and other 
items. 

 
Figure 4-125: Graphing Multiple Medications 

EHR Graphing displays Vitals Measurements as points on two axes. If more than one 
measurement exists for a given date and time, EHR Graphing connects measurements 
for like items with a line. 
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Figure 4-126: Vital Graphing 

EHR Graphing also displays as points on two axes laboratory tests that have results 
with numerical values. Lines connect like items. 

It displays Lab tests with non-numerical results (positive and negative results, for 
example) as points on the horizontal axis. It does not connect like items that have 
non-numerical results. To keep them out of the way of numerical data, EHR Graphing 
displays non-numerical results above or below the numerical values and line. 

Values beginning with > are located at the top margin; others are graphed at the 
bottom margin. Free-text values display by default as do comments. To hide or show 
free-text values, click the Free-Text Values: label. 

Comments are displayed in yellow boxes on the date axis, while the **comments 
label shows that there are comments. Clicking this label will show details of all items 
on the graph. 
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Figure 4-127: Lab Values 

4.7.7.2 Viewing Graphs 
Patients' information is listed on the left side of the graph. The time search can be 
changed in the bottom-left corner. Graphs can be viewed singly by selecting an item 
to view. The following is the TMP over the last year: 

 
Figure 4-128: One Item 

You can select multiple items to view by select an item in the selection box, holding 
the Ctrl key, and selecting other options. Next are the TMP, WT, and Pulse over one 
year. 
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Figure 4-129:Multiple Items to Graph 

You can also view them on the same graph by clearing the Individual Graphs check 
box at the top of the graph. 

 
Figure 4-130: Multiple Items on the Same Graph 

4.7.7.3 Setting up Graphing 
You can set up graphing on the Labs tab, the Reports tab, or under Options on the 
tool bar. 
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Figure 4-131:Setting Up Graphing Window 

4.7.7.3.1 Settings 
The Settings button enables you to view and change the different items you want to 
graph. 

1. Select the Settings button from the left side of the Graphing dialog. 

 
Figure 4-132: Settings Button 
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Figure 4-133:Settings dialog 

2. Choose the sources, remembering that not all of them are available in IHS or at 
your site (for example, your facility may not do AP reports). 

3. Select options. You can change the appearance of the graphs by selecting or 
clearing the items in the Options list. Users must review the items to determine 
which ones they prefer. 

4. Select the maximum number of graphs and the height. 

5. Select default dates if desired. 

6. Users can save this as their default view. The Show Defaults field displays both 
the personal and public default. Only users with the correct keys can set up a 
public view. 

4.7.7.3.2 Views 
There are two tabs on the graphing tool, Items and Views. 

The Items tab is information that the patient has in the time frame selected. All of the 
items appear in your setting for the chosen patient. 
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Figure 4-134:Items Tab 

The Views tab includes your personal views and any laboratory worksheets that you 
have created and saved. There are two personal views and three Lab groups for the 
user logged on. 

 
Figure 4-135:Views Tab 
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Users can create new views through Lab groups, but the user must log off and back 
on before it will appear in the Graph view. 

1. To create a new View, click Select/Define. This brings up the dialog enabling you 
to create a new view and save it. 

 
Figure 4-136:Select/Define Button 

 
Figure 4-137:View Creation dialog 

2. Select the sources for your view (for example, Measurements). 

3. After you select a source, then select which items in that source you want to view. 
Add them by clicking the arrows. 

You can select items from multiple sources 
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Figure 4-138:Personal View Defined 

4. When finished, you can save it as a personal view. However, If you have the 
correct security keys, it can be saved as a public view. 

 
Figure 4-139: Ready to Save 
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5. Name the view to save it as a personal view. 

 
Figure 4-140: Personal View Name 

6. You can click the View Definitions to get a listing of what is in all the views that 
are available. 

 
Figure 4-141:View Definitions 

This view is then available to be selected 
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Figure 4-142:New View 

Clicking the Split Views Box enables the user to see two different views at the same 
time. 

 
Figure 4-143: Click Split Views 
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In the following case, the first view is a Cholesterol panel and the second view is the 
new one containing Labs and Vitals. In one case it is one graph and in the other 
individual graphs. 

 
Figure 4-144: Split Views 

4.7.8 Web Reference Search Function 

4.7.8.1 Education Information Button 
When a lab result is selected from the Most Recent list, click the Education 
Information button. This sends a call to the MedlinePlus Web site to provide 
information regarding the selected topic and the MedlinePlus Web site opens to the 
related page. 

Note: The Add Patient Education Event dialog also opens when 
the Education Information button is clicked. Patient 
education is tracked for Meaningful Use, therefore, the Add 
Patient Education Event dialog should be completed. Refer 
to the Patient Education Online Help for details on 
completing this dialog. 
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Figure 4-145:Medline Plus Web Site 

4.7.8.2 Clinical Decision Support Button 
When a lab result is selected from the Most Recent list, click the Clinical Decision 
Support button. This sends a call to the UpToDate Web site to provide information 
regarding the selected topic and the UpToDate Web site opens to the related page. 
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Figure 4-146: UpToDate Web Site 

4.8 Lab POC Data Entry 
The Lab Point of Care (POC) Data Entry component provides the user with the ability 
to capture Laboratory POC test results through the RPMS-EHR application. 

The POC Lab Entry button requires that a visit and patient are selected before it 
becomes active. If this button does not exist, see your local CAC to have the button 
added. 
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4.8.1 Lab Point of Care Data Entry Form 
Click the POV Lab Entry button to display the Lab Point of Care Data Entry Form. 

 
Figure 4-147: Lab Point of Care Entry Form 

4.8.1.1 Form Features 
The Lab Point of Care Data Entry Form has the following features. 

• The Patient name is the same as the selected patient. 

• The Hospital Location is the same as the location selected (visit). 

• The Provider is the same as the visit provider (not the login user). 

• The list of tests is in the control file (the BLR BEHO POC CONTROL file). 

• The Collection Date and Time information is the same as the visit date and time. 

• Test is a required field and displays in bold. 

• Collection Date and Time information is required and displays in bold. 

• Sign or Symptom information is required and displays in bold. 

• Nature of Order/Change information is required and displays in bold. 

• When you first access the form, Cancel is active and OK is inactive. 
Once the form is open, the following happens: 

• You cannot change the patient context and the visit. 

• All buttons and tabs in the EHR are inactive. 

• You cannot minimize or close the EHR main window. 
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Any user without initials on the new person file causes the No initials in file 200 
warning message to display after clicking the POC Entry Form button. 

 
Figure 4-148: No Initial in File 200 Warning Message 

Click OK to close the message. You can assign yourself your initials using Tbox in 
RPMS, the same way that you assign yourself an Electronic Signature. 

4.8.1.2 Fields on the Lab POC Entry Form 
The following figure shows where the test has been selected and the form is ready for 
input. 

 
Figure 4-149: Test Form for Selected Test 

Note: All of the fields on the form (except for the Comment/Lab 
Description) must be completed in order for the Save 
button to become active. 

The Test Results Grid displays the appropriate fields for Results. 
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The following fields are required in order to save the form: 

• Ordering Provider – The name of the ordering provider of the particular test. You 
can change the name by selecting from the drop-down list. 

• Test – The drop-down list contains the tests that are listed in the BLR BEHO POC 
CONTROL file. After you choose a test name, data populates the Test Results 
part of the form. 

• Collection Date and Time – The default is the same as the visit date and time. 
You can change the data by selecting from the calendar (on the drop-down list). 

• Nature of the Order – The default indicates the nature of the order. You can 
change this by selecting from the drop-down list. 

• Sample Type – The system automatically populates this field (cannot be 
changed). 

• Sign or Symptom – The drop-down list contains the active problems of the 
patient, plus an Other... option. 

− If you select Other... , the SNOMED CT dialog opens. 

 
Figure 4-150: SNOMED CT Lookup dialog 

a. In the SNOMED CT lookup dialog, in the Diagnosis Lookup 
section, select either the Fully specified name or Synonym option 
button. 

 Fully specified name returns a collapsed list of 
SNOMED CT terms. Click the plus sign ( ) next to the 
term to expand and view the child entries. 
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 Synonym returns the full list of SNOMED CT terms. 

b. In Maximum Results, select one of the following to limit the 
number of returned results (or select ALL): 

 25 

 50 

 100 

 200 

 ALL 

c. In Search Date, the field defaults to the current date. Click the 
drop-down arrow to open the calendar and select a different date to 
search, if needed. 

d. In Search, type the term by which you want to search. 

e. In Subset, you can select a subset in which to search, if needed. 

f. Click either the IHS SNOMED CT or the ALL SNOMED CT 
button. The list of SNOMED CT terms is populated. 

g. Select and highlight a term, and then click the Select button. The 
Sign or Symptom field of the Lab Point of Care Data Entry Form 
refreshes with the selected SNOMED CT term you selected. 

• In Comment/Lab Description (optional field), you can either: 

o Enter text, using up to 80 characters. 

Note: If you enter more than 80 characters, the application 
truncates the text to 80 characters. 

o Click the Add Canned Comment button. The Choose a Lab Comment 
dialog opens. 

a. In the Choose a Lab Comment dialog, select a line item. These are 
defined in the control file. 
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Figure 4-151: Choose a Lab Comment dialog 

b. The No Lab Comments Found warning message displays when the 
lab description is not defined in the control file. Click OK to exit 
the message. 

 
Figure 4-152: No Lab Comments Found Message 

c. Click OK. The Comments/Lab Description field on the Lab Point 
of Care Data Entry Form is populated with your selection. 

4.8.1.2.1 Test Results Grid 
After you populate the Test field, the application automatically displays the 
appropriate fields for Results. The required fields depend upon how the test was setup 
in the Lab package. 

 
Figure 4-153: Test Results Grid 
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1. Enter a test result for a particular test in the Result field. 

• If this is an acceptable result, you are allowed to go to another field. 

• If the entered value is not valid, the application displays the Invalid Entry 
warning message. Click OK to exit the message. 

 
Figure 4-154: Invalid Entry Warning Message 

• If you do not know the acceptable result for the particular field, type a 
question mark (?) in the field (on the form) and the application displays the 
Result Entry Help information message. 

 
Figure 4-155: Result Entry Help Message 

2. Click OK to return to the field where the ? is positioned. 

4.8.2 Completing the Lab POC Data Entry Form 
1. After all required fields on the Lab Point of Care Data Entry form are populated, 

click Save. The form closes and the data appears on the Labs window as the Most 
Recent Lab Results. 

Note: You must click outside the Results grid for the Save button 
to be active. 

If you do not want to save the data, you can exit this form at any time by clicking 
the Cancel button. If you click Cancel, the Confirm exit without save information 
message displays. 
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Figure 4-156: Confirm Exit Without Save Information Message 

2. Click Yes to exit the form without saving any data. Otherwise, click No to return 
to the form. 

4.9 Medications 
The Medications Management window lists the outpatient and inpatient medications 
that have been ordered for the current patient as well as any documented outside 
medications. 

 
Figure 4-157: Medications Window 

The following are features of the Medications window: 

• The label of the type of medication in the toolbar determines what actions you can 
take on this window. For example, if the label reads Inpatient Medications, then 
the Inpatient Medications group box on the window is the active one. Note that 
Inpatient Medications only displays for the inpatient visit. 

• You can use the buttons at the top of the window to perform various functions in 
the active medication group box. 

• There is the capability of indicating the Clinical Indication (when configured 
correctly) for the outpatient/inpatient medication order. 
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• The order of the Outpatient Medication columns can be configured in the RPMS. 

4.9.1 Activating Medication Type 
You can activate a medication type by clicking within the particular group box. 
Another way is to select from the drop-down list for the listed medication type (in the 
toolbar). The Inpatient Medications only appears for inpatient records only. 

 
Figure 4-158: Drop-Down List for Medication Type 

4.9.2 Outpatient Medications Group Box 
The Outpatient Medication group box displays the outpatient medications that have 
been ordered for the current patient within the number of days shown in the Restrict 
Medications Activity button. 

 
Figure 4-159: Outpatient Medications Group Box 

4.9.2.1 Columns (Outpatient Medications) 
You can sort any column by clicking the heading column. 

The order of the columns in this group box can be configured in RPMS. 

In addition, you can determine the columns that display in the Outpatient Medication 
group box by right-clicking any column heading. This feature assists those with 
smaller monitors to view only the needed information. 
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Figure 4-160: Column Heading Right-Click Menu 

The top options on the right-click menu list the column's heading names that you can 
check or uncheck. Only the checked options display (along with the minimum 
Outpatient Medications data). 

• Show All: If you currently have a special display and want to display all of the 
columns, highlight this option. 

• Hide All: If you want to display only the minimum Outpatient Medications data, 
highlight this option. Only the Action, Chronic, Outpatient Medications, and 
Status columns display. 

• Restore Defaults: This returns you to the default view of the Outpatient 
Medication (established when Save Settings was selected). 

• Save Settings: This saves the current view of the Outpatient Medications as the 
default. Each time you access the Medications window, this (saved) view is the 
default view. 

4.9.2.2 Action Menu (Outpatient Medications) 
The options on the Action menu determine what actions you can take on the 
Outpatient Medications group box. 

 
Figure 4-161: Options on Action Menu for Outpatient Medications Group Box 

• New Medication: Use this option to order a new medication. See Outpatient and 
Inpatient Medication Orders for more information. 
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• Change: Enables you to change something pertaining to an already prescribed 
medication. See the Change section for more information. 

• Copy to New Order: Use this option to copy the selected medication to a new 
order. See the Copy to New Order section for more information. 

• Discontinue/Cancel: Use this option to discontinue or cancel a selected 
medication. See the Discontinue/Cancel Outside Medications section for more 
information. 

• Process: Use this option to process the selected medication orders. See the 
Process section for more information. 

• Transfer to Inpatient: Use this option to transfer a selected outpatient 
medication to inpatient. See the Transfer to Inpatient section for more 
information. 

• Refill: Use this option to refill the selected medication. See the Refill section for 
more information. 

• Renew: Use this option to renew the selected medication. See the Renew section 
for more information. 

• Chronic Medication: Select Yes, No, or Select All form the menu. See the 
Chronic Medication section for more information. 

4.9.2.3 Icons (Outpatient Medications) 
The Process column has new icons indicating how the prescription was processed. 

• The Printer icon ( ) is used for prescriptions that are printed for the patient to 
take to an outside pharmacy. A check mark appears in front of the Printer icon (

) once the prescription has been printed. 

• The Hospital icon ( ) indicates prescriptions filled in-house. 

• The Lightning Bolt icon ( ) indicates prescriptions sent electronically. 

 
Figure 4-162: Example of Icons in Use 
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4.9.3 Inpatient Medications Group Box 
The Inpatient Medication group box displays the outpatient medications that have 
been ordered for the current patient within the number of days shown in the Restrict 
Medications Activity button. 

 
Figure 4-163: Inpatient Medications Group Box 

You sort any column in the Inpatient Medications group box by clicking the heading 
column. 

4.9.3.1 Columns (Inpatient Medications) 
The right-click menu for any column heading has the following options: 

• Restore Defaults: Use this option when you change the column width and you 
want to restore the view to the default. 

• Saving Settings: Use this option to save your settings for the column widths. 
When you access the Medications window, this will be the settings used for the 
Outside Medications group box. 

4.9.3.2 Action Menu (Inpatient Medications) 
The options on the Action menu determine what actions you can take on the Inpatient 
Medications group box. 

 
Figure 4-164: Options on Action Menu for Inpatient Medications Group Box 

• New Medication: Use this option to order a new medication. See Outpatient and 
Inpatient Medication Orders for more information. 

• Change: Enables you to change a detail pertaining to an already prescribed 
medication. See Change for more information. 
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• Copy to New Order: Use this option to copy the selected medication to a new 
order. See the Copy to New Order section for more information. 

• Discontinue/Cancel: Use this option to discontinue or cancel a selected 
medication. See Discontinue/Cancel for more information. 

• Transfer to Outpatient: Use this option to transfer a selected Inpatient 
Medication to an Outpatient Medication. See the Transfer to Outpatient section 
for more information. 

• Renew: Use this option to renew the selected medication. See Renew for more 
information. 

4.9.4 Outpatient and Inpatient Medications Order 
The process for ordering outpatient medications and inpatient medications are similar. 
You must have a visit selected to perform the order process. 

Select Action > New Medication (or select the New Medication option on the right-
click menu or click the New button) to display the Medication Order dialog where 
you select a medication. 

 
Figure 4-165: Medication Order for Selecting an Outpatient Drug 

• For Inpatient status, the list contains medications designed at Unit Dose 
medications. 

• For Outpatient status, the list contains Outpatient Medications (only). 

• For Outpatient locations set up to provide Inpatient Medications, the Medications 
setup for Inpatient use and the Inpatient Order dialog is provided. 

• For Outpatient status, the list contains Outpatient Medications (only). 
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• For a patient who has Inpatient status, but has an ambulatory visit, the list 
contains Inpatient Medications (because the patient still is an Inpatient, thus the 
medications would be given through the Inpatient Medications, then transferred to 
Outpatient Medications at discharge). 

Note: You can determine the patient status by clicking the View 
Patient Detail ( ) button in the toolbar, and looking for the 
STATUS field on the Detail dialog. 

Find the appropriate item by scrolling the medication list. Otherwise, type enough 
letters of the medication’s name in the top field to have the application search for the 
name. Be careful to choose the correct item because some lists can have similarly 
named items associated with the desired medication or medication quick order. 

The application searches the quick orders first and then the medication list. Select the 
quick order or medication name and click OK. 

Note: If the selected medication is a controlled substance that 
requires the signature of a provider with a DEA number, 
the DEA# Required warning message displays. Before an 
order for a controlled substance can be entered, the 
provider selected for the encounter must be able to sign the 
order. You may need to exit the Medication Order dialog, 
change the provider, and then reenter the Medication Order 
dialog. 

 
Figure 4-166: DEA# Required Warning Message 

The ADRs button appears on many of the medication order dialogs. Click this button 
to show the Patient Postings information about the current patient (allergies as well as 
Crisis Notes, and so on). 
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4.9.4.1 Simple Dose Outpatient Medication Order 
To create a simple dose Medication Order: 

 
Figure 4-167: Outpatient Medication Order dialog (Simple Dose) 

1. If necessary, you can change the type of medication by clicking Change. 

Note: The patient's weight and the date of the last weighing is 
shown below the Change button. 

2. Various Medication Order dialogs might have the Display Restrictions/Guidelines 
link. Click this link to view the Restrictions/Guidelines dialog. 

a. You can print the text of the dialog by clicking Print. 

b. Click Close to dismiss the dialog. 

3. Highlight the dosage. (The associated cost is displayed to the right of the dosage.) 

4. Select a route from the Route field. 

5. Choose a schedule from the Schedule scroll list (select PRN, if desired). 

• The application completes the Days Supply field and calculates the Quantity 
field based on the formula: days supply x schedule = quantity. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

251 

• If you select OTHER for Inpatient Medications, the application displays the 
Order with a schedule OTHER dialog. 

 
Figure 4-168: Other dialog 

6. If necessary, highlight and change the numbers in these fields. 

Note: If you change a number, the application attempts to 
recalculate the OTHER field. If you check PRN, be sure 
that the Quantity field is correct before accepting the order. 

The maximum allowable days supply for the Days Supply field can be configured 
for your site (by using the Maximum Allowable Days Supply option in RPMS). 

7. In the Patient Instructions field, type any directives for the patient. If the field is 
already populated, you can edit the instructions by typing over them. 

8. Enter the number of refills. 

9. Select a clinical indication from the drop-down list for the Clinical Indication 
field. The parameter BEHOORPA controls the display of this field. The drop-
down list comes from the Problem List of the patient. 

10. Select OTHER from the drop-down list and the application displays the 
SNOMED CT Lookup dialog. 
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Figure 4-169: SNOMED CT Lookup dialog 

11. In the Diagnosis Lookup section of the SNOMED CT Lookup dialog, select either 
the Fully specified name or the Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click the 
plus sign ( ) next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 

12. In Search, type the term you want to search for. 

13. In Subset, you can select a subset in which to search, if needed. 

14. In Search Date, the field defaults to the current date. Click the drop-down arrow 
to open the calendar and select a different date to search, if needed. 

15. Click the Find button. The list of SNOMED CT terms is populated. 

16. Select and highlight a term, and then click the Select button. The Clinical 
Indication field refreshes with the selected SNOMED CT term you selected. 

17. Select the Chronic Med check box for medications that are ongoing for chronic 
medical issues (diabetes, hypertension, etc.). 
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18. Select the Dispense as Written check box indicating that the medication must be 
dispensed as written. For example, the pharmacy must dispense the brand name, 
exact tab size, etc. Most states require that the pharmacy substitute generic 
equivalents and/or tablet size (unless the provider checks the Dispense as Written 
check box). 

19. Select the location where the patient should pick up the medication from the Pick 
Up group box. 

20. Use the Outside Pharmacy Print button to generate a paper prescription. 

 
Figure 4-170: Print Option Buttons 

After the prescription is signed, the Queue Print button becomes active and the 
flag icon is highlighted. 

 
Figure 4-171: Queue Print 

21. Click the Queue Print button to confirm that you are ready to print. A 
confirmation message appears. 

22. Click Yes to select the template and printer for the prescription 

 
Figure 4-172: Prescription Print Template dialog 

23. Sites can configure their own prescription formats. In the case , since one of them 
is a narcotic, a different prescription format may have been created at the site for 
that type of prescription. 

24. For Outpatient Medications ONLY, you can transmit the prescription order 
electronically by selecting the Electronic option button (available when the APSP 
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AUTO RX parameter is set to YES). Once you select the Electronic option 
button, the Pharmacy field appears on the dialog. 

 
Figure 4-173: Electronic Option Button and Pharmacy Field 

25. Click the Ellipsis button by the Pharmacy field to display the Select a Pharmacy 
dialog. The parameter APSP ZIPCODE PROXIMITY RADIUS determines how 
far away to search for pharmacies. 

 
Figure 4-174: Select a Pharmacy dialog 

This dialog pulls entries from the new APSP PHARMACY LIST file based on a 
reference zip code, which can be that of the originating facility, the patient, or a 
manually entered one, and a defined radius. 

You can sort each column by selecting its corresponding header to ease the task of 
locating the correct pharmacy. Select the desired pharmacy from the list or from 
the quick pick list and click OK. This selection is retained for each additional 
medication order until the patient selection is changed or the session is 
terminated. In addition, the selection is added to the Quick-Pick list for that 
patient, which maintains the last three selected pharmacies for a patient in order of 
usage. Quick-Pick entries are retained across EHR sessions. 

Note: If a patient has no quick pick entries, the list will not be 
visible. 
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The APSP PHARMACY LIST file is delivered unpopulated. It is populated 
dynamically from the SureScripts service, but currently must be populated 
manually. 

After signing the order, the prescription is automatically finished and transmitted 
to the selected pharmacy. If the transmission is unsuccessful, the provider 
receives an alert and can then choose to either retransmit the message or print out 
the prescription: 

 
Figure 4-175: Medication Details Showing Electronic Transfer 
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26. You can change the Priority by selecting from the drop-down list. The following 
are the options for selection: 

• ASAP: Give as soon as possible 

• Routine: The default 

• STAT: Give immediately 

• DONE: Medication administration that is completed without order checks or 
reviewed by a pharmacist. Based on policies, this option is not recommended. 

27. The Discharge Medication check box is checked if the patient is currently 
admitted or if the ordering location has a clinic stop code of 30. De-select, or 
select the check box, if needed. 

28. Add comments in the Notes to Pharmacist field (if desired). What you add to this 
field is added to the lower-left field (for the sig). The Notes to Pharmacist field 
has a right-click menu to aid in editing the text. When the prescription is being 
transmitted to an outside pharmacy, the Comments field must be less than 210 
characters. If more than 210 characters, when you click Save, the application 
displays the Unable to Save Order alert. 

 
Figure 4-176: Unable to Save Order Warning Message 

29. Under certain circumstances, a check box may appear under the Days Supply 
field. If the medication is service-connected, make sure the box is selected. 

30. The Give Additional Dose Now check box may display for inpatient medications. 
The application displays when the first dose is expected to be given. When you 
click this check box, a new order is created and sent to Inpatient Medications. 
Make sure the new order and the original schedule you entered do not 
overmedicate the patient. 

31. There may be other information for you to complete on the medication order. 

32. Click Accept Order. 

33. If you are finished ordering the medications, click Quit. 

Note: The order must be signed before it can be forwarded to the 
Pharmacy service. You can either sign the order now or 
wait until later. 
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• If the Patient Status is Inpatient, the record displays in the Inpatient 
Medications group box. 

• If the Patient Status is Outpatient, the record displays in the Outpatient 
Medications group box. 

4.9.5 Complex Dose Medication Order 
Make sure you are on the Complex tab of the Medication Order. 

 
Figure 4-177: Outpatient Medication Order (Complex Dose) 

Important: Once a complex medication order is started, remain on 
the Complex tab until the order is finished. If you switch 
tabs, the application displays a Warning message that 
states: 
By switching to the Dosage tab, all data on this screen is 
lost. Click OK to continue to Cancel. Click OK to input 
information on the Dosage tab. Click OK to continue 
input on the Complex tab. 

Use the instructions in the Simple Dose Outpatient Medication Order to complete the 
fields (except Dosage, Route, Schedule) on this type of order. 
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The following provides information about populating the fields in the grid at the top 
of the form. 

 
Figure 4-178: Grid at Top of Form 

1. Click the Dosage field (to display the available dosages) and then select the 
appropriate dosage. 

2. Click the Route field and select a route. 

3. Select a schedule from the drop-down list for the Schedule field. (Select PRN if 
desired.) 

 
Figure 4-179: Available Selections for Schedule 

4. Enter a duration in the Duration field. If you want to change the time units of 
measure (for example from Day to Week), select the units of measure first, then 
enter the duration number. 

 
Figure 4-180: Available Selections for Duration 

5. Select one of the following (appropriate) modifiers: 

• And 

• Then 

• Except (leave this cell blank for the final dose) 
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6. Repeat Steps 1 through 5 until you have completed the complex dose. This 
process adds rows to the complex dosage instructions (in the grid). 

The only addition for inpatient medications is a column that displays the 
administration times for the doses. 

 
Figure 4-181: Inpatient Complex Dose 

The parameter OR ADMIN TIME HELP TEXT displays information on how to 
change the administration times. 
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4.9.6 Simple Dose Inpatient Medication Order 
To create a simple Inpatient-Medication order: 

 
Figure 4-182: Inpatient Medication Order dialog 

1. If necessary, you can change the type of medication by clicking Change. 

Note: The patient's weight and the date of the last weighing is 
shown below the Change button. 

2. Various medication order dialogs may have the Display Restrictions/Guidelines 
link on them. Click this link to view the Restrictions/Guidelines dialog. 

a. You can print the text of the dialog by clicking Print. 
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b. Click Close to dismiss the dialog. 

3. Highlight the dosage. 

4. Select a route from the Route field. 

5. Select a schedule from the Schedule scroll list (select PRN, if desired). Inpatient 
Medications require a standard schedule. 

If a non-standard schedule, it is created as follows: 

 
Figure 4-183: Non-Standard Schedule Selected 
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The following error appears: 

 
Figure 4-184: Non-Standard Error Message 

6. Select OTHER from the schedule list. 

 
Figure 4-185: Creation a Schedule dialog 

7. The provider selects which day of the week (or all) and the time, and then adds it 
to the standard schedule list. It can then be chosen once it has been added to the 
saved list. 

4.9.6.1 Expected First Dose Information 
The time of the expected first dose is displayed. The provider can then choose to give 
an additional dose NOW by clicking the check box if the expected first dose is too far 
into the future. 
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Figure 4-186: Expected First Dose 

4.9.6.2 Administrative Times 
All schedules that have administration times set up in the Pharmacy files show those 
times displayed for the provider after the schedule is chosen. This appears in a text 
box below the Give Additional Dose Now check box. 
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Figure 4-187: Administrative Times 

4.9.7 Outside Medications 

4.9.7.1 Document Outside Medications 
You can document outside medications for the current patient. This means that the 
prescription was sent to an outside Pharmacy (e-prescribing). 

You can document Outside Medications for the current patient. Outside medications 
are those medications that the patient is taking that are over the counter, supplements, 
or medications prescribed by a physician not affiliated with the facility. 
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Figure 4-188: Active Outside Medications Group Box 

The Outside Medication records normally appear on the Order window when the 
records have a status of Active. They can be removed by removing the NON-VA 
MEDS from the pharmacy display group in the file DISPLAY GROUP. 

Select DISPLAY GROUP NAME:    PHARMACY 
NAME: PHARMACY// 
Select MEMBER: CLINIC ORDERS// ? 
   Answer with MEMBER, or SEQUENCE 
   Choose from: 
   1     INPATIENT MEDICATIONS 
   2     OUTPATIENT MEDICATIONS 
   3     NON-VA MEDICATIONS 
   4     CLINIC ORDERS 

In certain cases, your local CAC can disable medication order enter/edit. In this case 
the user can only view the medications. 

The label (name) of the Outside Medications is controlled by the BEHORX NONVA 
LABEL parameter. This means that Outside Medications might have a different 
name. 

4.9.7.2 Columns (Outside Medications) 
The right-click menu for any column heading has the following options: 

• Restore Defaults: Use this option when you change the column width and you 
want to restore the view to the default. 

• Saving Settings: Use this option to save your settings for the column widths. 
When you access the Medications window, these settings are used for the Outside 
Medications group box. 

4.9.7.3 New Medication (Outside Medications) 
Make sure that the Outside Medications group box is active. The Outside Medications 
option shows on the toolbar of the Medications window. 
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Make sure a visit is selected. Follow these steps to document an outside medication: 

1. Select Action > New Medication (or select the New Medication option on the 
right-click menu or click the New button) to display the Document 
Herbal/OTC/Home Medications dialog (showing a list of available medications). 

 
Figure 4-189: List of Drugs for Outside Medications Order 

2. Find the appropriate item by scrolling the medication list. Otherwise, type enough 
letters of the medication’s name in the top field to have the application search for 
the name. Be careful to choose the correct item because some lists can have 
similarly named items associated with the desired medication or medication quick 
order. 

3. The application searches the quick orders first and then the medication list. Select 
the quick order or medication name and click OK. The application applies order 
checks on the selected medication. 
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4. Document the outside medication on the Document Herbal/OTC/Home 
Medications dialog. 

 
Figure 4-190: Document Herbal/OTC/Home Medications dialog 

If UNKNOWN MED MISCELLANEOUS was selected on the medication 
selection window, then the Dosage, Route, and Schedule fields are not required. 

5. To change the medication, click the Change button and then select another 
medication. 

6. The check boxes in the Statement/Explanation group box can be configured and 
controlled by the ORWD NONVA REASON parameter. 

7. Complete the relevant sections and click Accept Order. After all outside 
medications are documented, click Quit. 
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The Outside Medication does NOT require the electronic signature. 

Note: Outside medications cannot be selected when you sign 
orders for the patient. All outside medications with a status 
of New display on the electronic signature form. 

 
Figure 4-191: Electronic Signature Showing Outside Medications 

4.9.7.4 Details for Outside Medications 
You can view the details of a selected outside medication by selecting View > Details 
(or by selecting the Details option on the right-click menu) to display the Outside 
Medication Details dialog. See Details for more information about this dialog. 

4.9.7.5 Unknown Outside Medications 
Occasionally a patient tells a provider they take a daily medication and can describe 
it, but do not know what it is. This medication must be documented and later verified. 
To do this: 

1. The site must define a dose form to use for these medications and enter it in the 
parameter BEHORX OUTSIDE MED DOSAGE FORM. 

2. The site must create a drug tied to this dose form for unknown medication or 
something similar. 
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Figure 4-192: Miscellaneous Drug Dose Form 

3. The medication and its description is then entered in the Dosage field. 

4. Click Accept Order. 

 
Figure 4-193: Unknown Medication for Validation 

The medication now appears with an action of VALIDATE. 

5. Once the medication is identified, the provider uses the Change action. Select the 
correct medication and accept the order. 

The unknown medication is discontinued and the correct medication made active. 
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4.9.7.6 Discontinue/Cancel Outside Medication 
You can cancel a selected outside medication by selecting Action > 
discontinue/Cancel (or by selecting the Discontinue/Cancel option on right-click 
menu). See Discontinue/Cancel for more information about this action. 

4.9.7.7 Change Outside Medication 
You can edit a selected outside medication by selecting Action > Change (or by 
selecting the Change option on right-click menu) to display the Document Outside 
Medication dialog. 

Change the relevant sections and then click Accept Order. The Action column for the 
changed Outside Medication contains Change. 

4.9.8 Buttons on Medications Window 
These actions only apply to the active medication type group box. For example, if 
Outpatient Medications group box is active, then any action applies to that group box 
(only). 

4.9.8.1 Active Only 
The Active button appears on Outpatient, Inpatient, and Outside Medication group 
boxes. 

 
Figure 4-194: Active Only Button 

Click the Active Only button to display the medications for the current patient that 
have a status of ‘active’ in the Pharmacy package. These are the medications that the 
patient is actively taking. 

4.9.8.2 Chronic Only 
The Chronic Only button appears on Outpatient, Inpatient, and Outside Medication 
group boxes. 

 
Figure 4-195: Chronic Only Button 

Click the Chronic Only button to change the display to show only chronic 
medications for the current patient (applies to Outpatient medications only). 
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4.9.8.3 Restrict Medication Activity 
The Restrict Medication Activity button appears on Outpatient, Inpatient, and Outside 
Medication group boxes. 

 
Figure 4-196: Restrict Medication Activity Button 

Click the Restrict Medication Activity button to display the Restrict Medication 
Activity dialog. 

 
Figure 4-197: Restrict Medication Activity dialog 

You can change the number in the free text field, if needed, in the range 1 to 9999. 
After you click OK, the Medications window shows only medications that were 
active with the last specified days (for the current patient). 

The default time can be configured in the RPMS. 

4.9.8.4 Print 
The Print button appears on Outpatient, Inpatient, and Outside Medication group 
boxes. 

 
Figure 4-198: Print Button 

Select one or more medication orders to print, and then click the Print button (or 
select File > Print) to display the Print Medications dialog. 
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Figure 4-199: Print Medications dialog 

The Prescription option button displays only after being configured in RPMS. See 
your CAC about this configuration. 

4.9.8.5 Report Format 
This group box determines the format of the output. 

 
Figure 4-200: Report Format Group Box 

• The Brief option outputs the information in the Medication, Prescriber, Status, 
and Refills Left columns (not just the ones in the current view). 

• The Detailed option outputs the information in all of the columns (not just the 
ones in the current view). 

• To print a Prescription, your local CAC can set the default printer for the 
medication report. Also, the CAC must set the Enable Printing of Prescription 
option to YES. Both of these options are accessed in RPMS. 

• In order to use the Label option button, your site must be configured to print 
labels (using the Enable Printing of Sample Labels option in RPMS). 

• Prescription (new format): If a site is printing prescriptions using the queue, 
there may be times when the prescription does not print. This requires a reprint of 
the prescription. 

• The Order option prints the order from a pre-defined template. Refer to the Rx 
Print Format (Template) Editor – Export and Import Files book for additional 
information. 
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Users must select a reason for the reprint, and this data is tracked in the prescription. 

 
Figure 4-201: Select Reprint Reason dialog 

4.9.8.5.1 Inclusion Criteria 
1. This group box determines what is included on the output. Select one of the 

following: 

• Select the Active Only check box to include Active Only medication orders. 

• Select the Chronic Only check box to include the Chronic Only medication 
orders. 

• Select the Selected Only check box to include the selected medication orders. 
2. Click Print on the Print Medications dialog to initiate the print process. The Print 

Setup dialog displays. This is where you select the printer and other settings. 

3. Click OK on this dialog to output the information to the selected printer. 
(Otherwise, click Cancel to cancel the print process.) 

4.9.8.5.2 Queue Print 
The Queue Print icon is lit when there are items waiting to be printed. When clicked, 
the Prescription Template and Printer Selection dialog is displayed. 

 
Figure 4-202: Queue Print Button 

4.9.8.6 Process 
The Process button appears on Outpatient group boxes. This function is NOT 
available for Outside Medications. 

 
Figure 4-203: Process Button 

The Process button enables you to select more than one medication order to process. 
The process enables you to change, refill, renew, and so, each medication in turn. 
Otherwise, you can choose the medication order individually and select the 
appropriate process (change, refill, and so on). 
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Select one or more medications and then select Action > Process or click the Process 
button to display the Medication Order dialog. 

 
Figure 4-204: Medication Order Showing Process Actions 

The Action you select determines the label on the button above the Quit button in the 
lower right corner of the dialog. 

The Active Process Action option button determines the button label (the button 
above the Quit button). The following table provides information about that process 
and actions you can take. 

Option Button Button Label Action on the Button 
None Skip Skips to the next medication 
Change Change Changes the medication.  
Renew Renew Renews the medication order.  
Refill Refill Orders a refill for the medication.  
Hold Hold Puts the medication order on hold.  
D/C D/C Cancels the medication order.  

Click the ADRs button to display the Patient Postings information about the current 
patient. 

If you click the Details button, the system displays the Medication Details dialog. 
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4.9.8.7 New 
The New button appears on Outpatient, Inpatient, and Outside Medication group 
boxes. 

 
Figure 4-205: New Button 

Click the New button to display the Medication selection dialog. (This is the same as 
selecting the New Medication option on the Action menu.) After making a selection, 
the Medication Order dialog displays. 

4.9.8.8 Check 
The Check button appears on Outpatient, Inpatient, and Outside Medication group 
boxes. 

 
Figure 4-206: Check Button 

Click the Check button to execute on-demand order checking. This causes the Order 
Checks dialog to display. 

This performs order checks on all active and pending medications in the medication 
profile for both outpatient and outside medications and cites the source of the drug 
interaction information. You must dismiss the window in order to continue. 

 
Figure 4-207: Order Checks 
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If no order checking transpired, the Order Checks information message displays 
informing you that there are no contraindications or warnings. 

Click OK to dismiss the message. 

4.9.8.9 Clinical Decision Support Button 
The Clinical Decision Support button enables you to look up information on a 
highlighted medication order. 

 
Figure 4-208: Information (Info) Button 

It creates a search on UpToDate Web site for that medication and displays data for 
the provider. 

 
Figure 4-209: UpToDate Web Site 

4.9.8.10 Education Information Button 
The Education Information (formerly Information Ed) button enables you to look up 
information on a highlighted medication order. 

 
Figure 4-210: Education Information (Ed) Button 
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It creates a search on MedlinePlus for that medication and displays data for the 
provider. 

 
Figure 4-211: MedlinePlus Web Site 

Note: The Add Patient Education Event dialog also opens, where 
you can add patient education information. 

4.9.9 Options on Right-Click Menu 
The following sections provide information about the options on the right-click menu. 

4.9.9.1 Details 
This option appears on the Outpatient, Inpatient, and Outside Medication group 
boxes. Use this option to display the Medication Details pop-up window. 
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Figure 4-212: Medication Detail Window 

4.9.9.2 Administration History 
This option appears on the Outpatient and Inpatient group boxes. Use this option to 
display the administrative history of a selected medication (does not apply to IV 
Fluids). The Administrative History window displays. 
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Figure 4-213: Administrative History dialog 

Each window that displays by using the Details or Administration History option 
enables you to change the font size of the text displayed in this window by adjusting 
the size in the Font Size field (enter manually or use the Up and Down arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

Each window has a right-click menu where you can copy selected text and paste it 
into any free-text field within the EHR or into another application (like MS Word). 

1. Click Print to choose a printer and to output the (entire) contents of this window 
to the specified printer. 

Note: The Print button may not appear. It is according to how 
your application is configured. 

2. Click Close to dismiss the window. 

4.9.9.3 Medication 
This option appears on the Outpatient, Inpatient, and Outside Medication group 
boxes. 
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4.9.9.4 Change 
This option appears on the Outpatient, Inpatient, and Outside Medication group 
boxes. 

You can change the dosage, route, schedule, etc. of an existing medication order. This 
option does not allow you to change the medication itself (the Change button will not 
be active). 

Follow these steps to change a medication order: 

1. Select the medication you want to change (cannot be a cancelled order). 

2. Select Action > Change (or select the Change option on the right-click menu) to 
display the Medication Order dialog. If you select an Outside Medication, the 
Document Outside Medication dialog displays with the Change button inactive. 

 
Figure 4-214: Medication Order to Change 

3. Complete the changes as appropriate on the Medication Order dialog. See 
Outpatient and Inpatient Medication Orders for more information about 
completing the Medication Order dialog or see Document Outside Medications 
for more information about completing the Document Outside Medications 
dialog. 

4. Click Accept Order to change the medication order. 
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You can sign the changed order now or later. 

4.9.9.5 Copy to New Order 
This option appears on the Outpatient and Inpatient group boxes. 

You might use this feature to create a new medication order from an expired one. 

Make sure a visit is selected for the current patient. Follow these steps to copy an 
order to a new order. 

1. Select the medication you want to copy to a new order. 

2. Select Action > Copy to New Order (or select the Copy to New Order option on 
the right-click menu) to display the Copy Medication Order dialog. 

 
Figure 4-215: Copy Medication Order dialog 

If the order does not have a Clinical Indication associated with it, the Unable to 
Save Order information message opens. A Clinical Indication must be added 
before proceeding. Refer to the appropriate Medication Orders topic based on the 
type of order you are copying, or the Using the SNOMED CT Lookup dialog if 
the Other option is selected in the Clinical Indication field. 

3. Click the Release Copied Orders Immediately option button to create the same 
order over again. 

The Delay release of copied orders until option requires that there has been the 
setup for delayed orders. You use the Delay option if the patient is being 
transferred and you have all of the orders set to auto-dc on the transfer. This 
option is not discussed in this topic. 

4. Click OK to display the New Order dialog. 
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Figure 4-216: New Order dialog 

• If you click Edit, you get the Medication Order dialog for the particular 
medication. See Outpatient and Inpatient Medication Orders for completing 
the dialog. 

• If you click Accept, a new order is created using the medication information 
displayed on the New Order dialog. (Otherwise, click Cancel.) 

5. The specified medication has New in the Action column. You can sign the order 
now or later. 

4.9.9.6 Discontinue/Cancel 
This option appears on the Outpatient, Inpatient, and Outside Medication group 
boxes. 

When an order is discontinued, the application changes the order’s Stop Date/Time to 
the date/time the action is taken. Pending and Non-verified orders are deleted when 
the medication order is discontinued and no longer appears on the patient’s profile. 
An entry is placed in the order’s Activity Log recording who discontinued the order 
and when the action was taken. 

Make sure a visit is selected for the current patient. Follow these steps to discontinue 
an order: 

1. Select the medication orders you want to discontinue. 

2. Select Action > Discontinue/Cancel (or select the Discontinue/Cancel option on 
the right-click menu) to display the Discontinue/Cancel Orders dialog. 
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Figure 4-217: Discontinue/Cancel Orders dialog 

3. Select the appropriate reason to discontinue from the Reason to Discontinue field 
and click OK. (Otherwise, click Cancel.) 

The list of reasons to discontinue can be configured in RPMS (using the Edit DC 
Reasons option). 

The specified medication displays DC in the Action column. 

4.9.9.7 Hold 
This option appears on the Outpatient and Inpatient group boxes. 

Only active orders can be placed on hold. Orders placed on hold continue to show 
under the ACTIVE heading on the profiles until it is removed from hold. An entry is 
placed in the order’s Activity Log recording the person who placed/removed the order 
from hold and when the action was taken. 

The Hold/Unhold actions can be configured in RPMS. If the Disable Hold/Unhold 
Actions in EHR option is set to YES, this prevents orders from being placed on Hold. 

Make sure a visit is selected for the current patient. Follow these steps to place a 
medication on hold: 

1. Select the medication order you want to be placed on hold. 

2. Select Action > Hold (or select the Hold option on the right-click menu) to 
display the Hold Order dialog. 
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Figure 4-218: Hold Order dialog 

3. Enter a reason in the free text field (required). 

4. Click OK. The word Hold appears in the Order column for the selected order and 
the Status = Unreleased. 

5. You must sign the Hold order now or later. After signing, the Status = Hold. 

Once the medication is on Hold, you can remove it from Hold by selecting the 
medication and selecting Action > Release Hold to display the Release Order from 
Hold dialog. 

This Hold is not a replacement for the Pharmacy Hold. It is designed to only be used 
on Inpatient Orders. The Hold Medication is normally done because the patient has a 
procedure scheduled and the medication cannot be given until after the procedure is 
finished. Outpatient pharmacy has their own hold action for medications given to 
patients to take home. 

4.9.9.8 Process 
This option appears on the Outpatient and Inpatient group boxes. See Process for 
more information about this option. 

4.9.9.9 Refill 
This option appears on the Outpatient Medications group box. 

You can refill only outpatient medications that are active and have refills available 
(and NOT a medication that has been renewed). 

You cannot refill a narcotic prescription. 

Make sure a visit is selected for the current patient. Follow these steps: 

1. Select the medication you want to refill. 

2. Select Action > Refill (or select the Refill option on the right-click menu) to 
display the Refill Order dialog. 
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Figure 4-219: Change Refills for Outpatient Medication dialog 

3. Click the appropriate option button in the Pick Up group box. 

4. Click OK to have the medication refilled. (Otherwise click Cancel.) 

The selected medication has Refill in the Action column. 

4.9.9.10 Renew 
This option appears on the Outpatient and Inpatient group boxes. 

Only active orders or those that have been expired in a certain number of days can be 
renewed. The maximum number of days following the expiration can be configured 
for your site (using the Renewal Limit for Expired Meds option in RPMS). You must 
have Outpatient Pharmacy 7.0 loaded in order to renew a medication order. 

After a renewed order is accepted, the Start Date/Time for the renewed order becomes 
the Stop Date/Time of the original order. 

Once an order has been renewed, it cannot be renewed again or edited. 

You cannot renew or refill narcotics. If you try to renew or refill, the application 
displays the Unable to Renew Order information message. 

 
Figure 4-220: Unable to Renew Order Information Message 

Make sure a visit is selected for the current patient. Follow these steps to renew a 
medication order: 

1. Select the medication you want to renew. 
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2. Select Action > Renew (or select the Renew option on the right-click menu) to 
display the Renew Order dialog. 

 
Figure 4-221: Renew Order dialog 

3. If you need to change the Refill/Pick Up information, click inside the green box 
and the label on the button changes: 

 
Figure 4-222: Renew Order dialog with Changed Button Label 

a. Click the Change Refill/Pick Up button to display the Change Refills dialog. 

 
Figure 4-223: Change Refills dialog 

b. You can manually change the number of refills and change the Pick Up 
information by selecting from the drop-down list. 

c. When the Change Refills dialog is complete, click OK. You return to the 
Renew Order dialog. (Otherwise, click Cancel.) 

If the order does not have a Clinical Indication associated with it, the Unable to 
Renew Order information message opens. A Clinical Indication must be added 
before proceeding. Refer to the appropriate Medication Orders topic based on the 
type of order you are renewing. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

287 

4. Click OK on the Renew Order dialog. (Otherwise, click Cancel.) 

The specified medication shows Status = Unreleased and Action = Renew. After 
signing the order, this changes the order to have Status = Pending. 

4.9.9.11 Transfer to Inpatient 
This action transfers a selected Outpatient Medication to an Inpatient Medication for 
a patient with the status of Outpatient. The application tells you if the medication 
cannot be changed to an Inpatient Medication. Follow these steps: 

5. Select the Outpatient Medication you want to transfer (you can select more than 
one, if needed). 

6. Select Action > Transfer to Inpatient (or select the Transfer to Inpatient option on 
the right-click menu). The application checks the status of the patient. 

The Transfer Medication Order dialog displays. 

If your patient is still an outpatient, then delaying the order until after admission is 
the only choice. The following dialog displays enabling you to enter delayed 
orders. 

 
Figure 4-224: Transfer Medication Order dialog 

7. Select one of the options in the lower field, such as Admit to Ward. 

8. Click OK to display the Admit Patient dialog. 
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Figure 4-225: Admit Patient dialog 

9. Complete the fields on this dialog by selecting from the drop-down lists. The 
Attending field is the only required field. The Instructions field is a free-text field. 

10. Click Accept Order to display the Medication Order. 

 
Figure 4-226: Outpatient Medication Order 

11. Complete the medication order and click Accept Order. See Outpatient and 
Inpatient Medication Orders for more information about completing the dialog. 
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The selected medication appears in the Inpatient Medications group box with 
New in the Action column. 

If your patient is already admitted, the Inpatient Order dialog opens for you to 
process. However, any med selected must have been setup to be an inpatient 
medication. 

12. Sign the order. The Status becomes Pending. 

4.9.9.12 Transfer to Outpatient 
This action transfers a selected Inpatient Medication to an Outpatient Medication for 
a patient with the status of Inpatient. Follow these steps: 

1. Select the medication from the Inpatient Medications panel that you want to 
transfer to outpatient (you can select more than one, if needed). 

2. Select Action > Transfer to Outpatient (or select the Transfer to Outpatient option 
on the right-click menu). The application checks the status of the patient. 

The Transfer Medication Orders dialog displays. 

 
Figure 4-227: Transfer Medication Order dialog 

3. Click OK. The Medication Order displays. 

4. Complete the Medication Order dialog and click Accept Order. See Outpatient 
and Inpatient Medications Orders for more information about completing the 
dialog. 

The selected medication order appears in the Outpatient Medications group box 
with New in the Action column. 

5. Sign the order. The Status becomes Pending. 

4.9.9.13 Chronic Medication 
The Chronic Medication option/feature appears on the Outpatient Medication group 
box, and marks selected medications as chronic or as not chronic. 
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Chronic medications apply to outpatient medications only. They have a Chronic 
Medication check mark ( ) in the Chronic column. Once the medications are marked 
as chronic, you can sort the list by clicking on the Chronic column heading until all of 
the chronic medications are listed at the top. 

Follow these steps to use the Chronic Medication features: 

1. To mark (outpatient) medications as chronic, select the medications. 

• To select all chronic medications, select Chronic Medication > Select All on 
the right-click menu (or on the Action menu). 

• Use the Shift or Ctrl key in combination with the left mouse button to select 
the medications. 

2. Select Chronic Medication > Yes on the right-click menu. The selected 
medications show a check mark ( ) in the Chronic column. 

3. To mark medications as not chronic, select the chronic medications. 

• To select all chronic medications, select Chronic Medication > Select All on 
the right-click menu (or on the Action menu). 

• Use the Shift or Ctrl key in combination with the left mouse button to select 
the medications. 

4. Select Chronic Medication > No on the right-click menu. The selected 
medications have no check mark ( ) in the Chronic column. 

4.10 Orders 

4.10.1 Orders Window 
Orders are placed using options from the Write Orders field. You can place orders for 
a variety of items and procedures, such as medications, consults, lab tests, and so on. 

 
Figure 4-228: Orders Window 
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The Orders window displays information about each order. For example, which 
service the orders are associated with, the start and stop date of each order, the name 
of the provider who entered the order, and the status of the order. 

The Orders window has the following features: 

• The View Orders category field contains the name of the order category being 
viewed (in the right panel). In addition, it can contain the name of the order within 
that category. 

• The Write Orders type field contains the list of order types that can be selected. 

• The right-hand panel contains a list of the orders being viewed. 

• Order checks are performed on all orders (after you click Accept Order and before 
you sign the order) to prevent errors (such as duplicate orders) from occurring. 

• You can specify that an order become active immediately, or specify that an order 
be event delayed (inpatient only) and activated when the selected patient is 
admitted, transferred, or discharged. 

Note: The orders listed in the Write Orders field vary from site to 
site. Because of this, some of the orders discussed in the 
following sections may not be available.  
 
The Write Orders field is determined by one of two 
parameters, the ORWOR WRITE ORDERS LIST or the 
ORDWDX WRITE ORDERS LIST. The ORWDX WRITE 
ORDER LIST points to an order menu that can be used and 
if this parameter is set, it takes precedence. 

4.10.2 Viewing Orders 
You can control which orders appear on the Orders window by defining specific 
criteria. For example, you can specify that only unsigned orders associated with a 
specific service or section appear. Unsigned orders appear on the Orders window in 
bold, blue lettering. 

To view orders: 

1. On the View menu, select one of the following view options (in top of the menu): 
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Figure 4-229: View Menu Options 

The appropriate orders appear in the right-hand panel. 

2. Select the Refresh option if you want to update the current Orders window. 

3. If you would like to filter the orders further, continue with Custom Order View. 

4.10.2.1 Custom Order View 
1. Select View > Custom Order View (or select Custom Order View on the right-

click menu) to display the Custom Order View dialog. 

 
Figure 4-230: Custom Order View dialog 

2. Select the criteria for the orders that you want to display on the Orders window by 
doing one or more of the following: 
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a. Select an order status from the Order Status scroll list. (Click the  sign to 
expand a heading.) 

b. Select a service or section from the Service/Section scroll list. (Click the  
sign to expand a heading.) 

c. If you would like to limit the orders to a specific date range, check the Only 
List Orders Placed During Time Period check box, and enter the From and 
Through dates. 

d. Click the Ellipsis button to choose a date from a calendar. 

e. Check the Reverse Chronological Sequence check box if you want the oldest 
orders to appear at the top of the orders list. 

f. Check the Group Orders by Service check box if you want the orders to be 
sorted according to the service with which they are associated. 

3. Click OK. The orders that meet the criteria you specified on the Custom Order 
View dialog display on the Orders window. 

Criteria for the displayed orders appears above the Service column (in the 
right panel). 

If all of the active orders are not displayed on the Orders window, the  icon 
appears above the last column on the right side of the screen. 

 
Figure 4-231: Active Orders Not Displayed 

If you choose Active Orders, you will see the Active and Pending orders that 
have had activity in the past number of hours that your site specifies in a 
parameter. 

Note: Some sites use this to see all activity in the past 24, 48, or 
72 hours. The CAC sets the number of hours. 

4.10.2.2 Default View for Orders 
A default view for your orders is one you particularly use the most and want it to be 
the view that displays when you enter the Orders window. To use the Default View 
for orders: 

1. Establish the view that you want as your default view. 

2. Select View > Save as Default View to display the Save Default Order View 
information message. 
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Figure 4-232: Save Default Order View Information Message 

3. Click Yes to save the view as your default view. (Otherwise, click No.) 

Note: If you are in another view on the Orders window, you can 
return to your default view by selecting View > Return to 
Default View. 

4.10.3 Medication Orders 
When ordering medications, you can order Outpatient or Inpatient Medications, 
including IV Fluids and Unit Doses. Outpatient medications and Inpatient 
medications are defined by Pharmacy. 

Note: If a medication is preceded by an asterisk (*), the asterisk 
indicates that the order was changed by the pharmacy 
service. 

If you would like to view additional information about a medication order, double- 
click the order or select a medication order and choose View > Details to display the 
Order Details dialog. See Order Details for more information. 

To order outpatient medications, select the Outpatient Medications function on the 
Orders window. The ordering activities are the same ordering them on the 
Medications window. Refer to the online Help for the Medications window for more 
information. 

To order inpatient medications, select the Inpatient Medications function on the 
Orders window. The ordering activities are the same ordering them on the 
Medications window. 

4.10.3.1 ADRs Button 
The ADRs button appears on many of the medication dialogs within the Orders menu. 
Click the ADRs button to show the Patient Postings information about the current 
patient (contains the patient’s allergies as well as Crisis notes, and so on). 
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Figure 4-233: Patient Postings Information 

4.10.3.2 Holding Pharmacy Orders 
Only active pharmacy orders can be placed on hold. Orders placed on hold will 
continue to show under the ACTIVE heading on the profiles until they are removed 
from hold. An entry is placed in the order’s Activity Log recording the person who 
placed/removed the order from hold and when the action was taken. The HOLD 
action in orders was designed to be for Inpatient orders such that the patient will not 
receive the medication because they are having a procedure done. 

There is a pharmacy application to place outpatient medications on hold. 

Note: The Hold option might not active on your system. This 
option is controlled by a parameter that must be turned on 
in the RPMS. 

Make sure a visit is selected. To place an order on hold: 

1. On the Orders window, select the pharmacy order you want to be placed on hold. 

2. Select Action > Hold (or select Hold on the right-click menu) to display the Hold 
Order dialog. 

 
Figure 4-234: Hold Order dialog 

3. The Enter a reason for the hold field is a required, free-text field. 

4. Click OK. 
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The pharmacy order now has Status = Hold on the Orders window. You can sign the 
order now or later. See Sign Selected for more information. 

4.10.3.3 Releasing a Pharmacy Order from Hold 
The Release Hold option might not be available on your system. This option is 
controlled by a parameter that must be turned on in the RPMS. 

Make sure a visit is selected. To release a pharmacy order from hold: 

1. On the Orders window, select a pharmacy order with a Status = Hold. 

2. Select Action > Release Hold to display the Release Order from Hold dialog. 

 
Figure 4-235: Release Order from Hold dialog 

3. Click OK. (Otherwise, click Cancel.) The selected pharmacy order now has Status 
= Unreleased on the Orders window. 

4. You can sign the order now or later. See Sign Selected for more information. 

4.10.3.4 Renewing Medications 
The CAC can set the renew limit for expired medication orders. This is the maximum 
number of days following the expiration of a prescription that it can still be renewed. 

Only active orders or those that have been expired less than the renew limit 
(discussed previously) can be renewed. The Duration for the order (to renew) must 
have a Stop Date after the current visit date. You cannot renew narcotic medication 
orders. 

After a renewed order is accepted, the Start Date/Time for the renewed order becomes 
the Start Date/Time of the original order. The original order’s status is changed to 
Renewed (after signing the order). 

Once an order has been renewed, it cannot be renewed again or edited. 

Make sure a visit is selected. To renew a medication: 

1. Select the pharmacy order to be renewed. You can select more than one order. 
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2. Select Action > Renew (or select Renew on the right-click menu) to display the 
Renew Orders dialog. 

 
Figure 4-236: Renew Order dialog for Two Orders 

3. If you need to change the Refill/Pick Up information, select the order’s text in the 
Renew Orders dialog and the button label changes: 

 
Figure 4-237: Renew Order with Change Refills/Pick Up Button 

4. Click the Change Refills/Pick Up button to display the Change Refills dialog. 

 
Figure 4-238: Change Refills dialog 

5. You can manually change the number of refills and can change the Pick Up 
information by selecting from the drop-down list. 

6. Click OK on the Change Refills dialog to return to the Review Orders dialog. 
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7. You can repeat the previous process, if needed. Click OK on the Renew Orders 
dialog. (Otherwise, click Cancel.) 

The renewed pharmacy order appears on the Orders window with Status = 
Unreleased. 

If the order does not have a Clinical Indication associated with it, the Unable to 
Renew Order information message opens. A Clinical Indication must be added 
before proceeding. Refer to the appropriate Orders topic based on the type of 
order you are renewing, or Using the SNOMED CT Lookup dialog if the Other 
option is selected in the Clinical Indication field. 

8. You must either sign the order now or later. See Sign Selected for more 
information. 

After signing the order, this changes the order to have Status 

4.10.4 Ordering Infusions 
IV infusions can only be ordered on the Orders tab. 

 
Figure 4-239: Infusion dialog 

1. Select the solution to be administered from the list set up by pharmacy. 

As soon as one is selected, it is moved to the Order dialog. Since the volume is 
normally part of the solution name, it is filled in automatically. 
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Figure 4-240: Solution Selected 

2. Select any additives, as needed. The Additives tab automatically opens once a 
solution is selected. Multiple additives or solutions can be selected. 

3. In the Volume/Strength fields, add the amount for the additives. 

4. Select the applicable route from the Route drop-down list. If OTHER is chosen, a 
new dialog with a drop-down menu appears with all medication routines flagged 
as IV types. 

 
Figure 4-241: Other IV Med Routes 

5. Select the type from the Type drop-down list. 

• If Continuous is selected, an Infusion Rate must be entered. 
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• If Intermittent is selected, an entry in the Schedule field is required. A time 
period to run the infusion can be entered, if needed. 

 
Figure 4-242: Continuous Type 

• The Duration or Total Volume fields are optional. 

• The Comments field is optional for comments to the pharmacist or nursing 
staff. 

 
Figure 4-243: Completed Infusion Order dialog 
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6. Click Accept Order when finished. 

4.10.5 Ordering Lab Tests 
When ordering lab tests, a parameter in RPMS establishes the number of previous 
days to search for duplicate lab orders. This is part of the order checking process. 

Make sure a visit is selected and that the current view is Active Orders. To place an 
order for a lab test (this is the generic lab order method): 

1. Select the Lab Tests function on the Orders window. The Order a Lab Test dialog 
displays. 

 
Figure 4-244: Order a Lab Test dialog 

Note: Lab test names in the upper part of the list are in numerical 
order, while the names in the lower part of the list are in 
alphabetical order. 

2. You can search for a lab test by entering a few characters in the free-text field 
below the Available Lab Tests label. In this case, the list scrolls to the first lab test 
containing those characters, if no quick orders begin with those characters. 
(Remember the system searches the quick orders first, then the list of available lab 
tests.) 

3. Select the desired lab test in the Available Lab Tests list box. 

4. The field in the lower part of the dialog shows information about the selected lab 
test. This field has a right-click menu for copying selected text. You can paste this 
text into another free-text field in the EHR or into another application (like MS 
Word). 
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Figure 4-245: Lab Order Showing Information in Lower Part of dialog 

In some cases, a warning message displays in the lower part of the dialog. (Click 
outside the message to dismiss it.) 

 
Figure 4-246: Warning Message for Lab Order 

5. You can change the default values for the Collect Sample, Specimen, and/or 
Urgency fields. If you cannot change a field, the text label (to the left of the field) 
is not active. 

6. You can change the collection type by selecting an option from the Collection 
Type drop-down list. Inpatients have the lab collect and possibly Intermediate 
Type if lab collections have been set up in the Laboratory files. 

7. You can manually change the Collection Date/Time (cannot be earlier than the 
Current Date/Time). Otherwise, click the Ellipsis button to select from a calendar. 

8. The How Often? field displays the lab administration scheduled. This is set up in 
the Laboratory application. 

9. The How Long? field indicates a time. For example, 3 = 3 days, or occurrence 3X 
= 3 times. 
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Figure 4-247: Lab Collect for Inpatients 

10. The Clinical Indication field is required (in order to save). Select an option from 
the drop-down list to populate this field. (You must have Lab Patch 22 loaded to 
have this field active.) 

The default list is the patient’s problem list. 

 
Figure 4-248: Problem List as Clinical Indication 
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If you select Other in the Clinical Indication field, the SNOMED CT Lookup 
dialog displays for you to select a problem. Refer to Using the SNOMED CT 
Lookup dialog for more information. 

After selecting a SNOMED CT term, the Clinical Indication field becomes 
populated with the selected problem. 

 
Figure 4-249: Clinical Indication Field 

11. Click Accept Order. 

12. When finished ordering lab tests, click Quit. 

Note: The Lab Test order must be signed before it is sent. You 
can either sign the order now or wait until later. 

4.10.6 Ordering Imaging/Radiology 
Make sure a visit is selected and that the current view is Active Orders. To order any 
type of imaging or radiology (like nuclear medicine) order: 

1. Select the Imaging function on the Orders window. The Order an Imaging 
Procedure dialog displays. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

305 

 
Figure 4-250: Order an Imaging Procedure dialog 

2. Select the imaging type from the Imaging Type drop-down list (required field). 
Small sites may only have one imaging type and it is automatically selected. 

3. Select a procedure from the Imaging Procedure scroll list (required field). 

4. In the Reason for Study (REQUIRED) field, enter a reason. 

5. In Clinical History, enter a clinical history to provide more data on the reason for 
study. This field has a right-click menu to aid in editing the text. 

6. Select one or more modifiers from the Available Modifiers field, if needed. 

The modifiers you select are displayed in the Selected Modifiers field. 

Note: You can remove a modifier by selecting it and clicking 
Remove. 

7. If necessary, change the Requested Date, Urgency, Transport, and Category 
fields. 

8. Complete the Submit To field (if necessary). 

9. Check the Isolation check box (if necessary). 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

306 

10. If necessary, select the time that the PreOp Scheduled field by doing one of the 
following: 

a. Enter a date (for example, 6/21/01 or June 21, 2001). 

b. Enter a date formula (for example, T-2). 

c. Click the Ellipsis button to select from a calendar. 

11. Select an option button in the Pregnant group box (required). 

Note: The Pregnant group box only displays for female patients 
of reproductive age (12 to 55 inclusive). 

12. Click Accept Order. 

13. When you are finished ordering imaging/radiology procedures, click Quit. 

14. You can either sign the order now or wait until later. See Sign Selected for more 
information. 

4.10.7 Text Orders 
Text only orders such as Parameters, Activity, Patient Care, and Free Text orders are 
different kinds of orders that are placed for nursing and ward staff to take action on. 
They print only at the patient’s ward/location, and are not transmitted electronically 
to other services. 

Examples of text only orders include: 

Order Type Order 
Parameters Vital signs 
Activity Bed rest, ambulate, up in chair 

Patient Care Skin and wound care, drains, 
hemodynamics 

Free Text Immunizations 

Predefined nursing orders (quick orders) might be available under various sub-menus. 

4.10.7.1 Entering Text Orders 
Make sure a visit is selected and that the current view is Active Orders. To place a 
text-only order: 

1. Select the Text Only Order function on the Orders window. The Text Only Order 
dialog displays. 
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Figure 4-251: Text Only Order dialog 

2. Complete the text for the order in the top field. The field has a right-click menu to 
aid in editing the text. 

3. Enter a start date and time and a stop date and time by doing one of the following: 

a. Enter a date (for example, 6/21/01 or June 21, 2001). 

b. Enter a date formula (for example, T-2). 

c. Click the Ellipsis button to select from a calendar. 

4. Click Accept Order. 

5. When finished ordering, click Quit. 

Note: The Text Only order must be signed before it is sent. You 
can either sign the order now or wait until later. See Sign 
Selected for more information. 

4.10.7.2 Complete Text Order 
You can cause a (signed) text order to be dropped from the Active Order list. To 
complete a text order: 

1. Select the signed Text Order. 

2. Select Action > Complete to display the Complete Order dialog. 
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Figure 4-252: Complete Order dialog 

3. Enter your electronic signature and click OK. The text order is dropped from the 
Active Order list. (Otherwise, click Cancel). 

4.10.8 Generic Orders 
Generic orders appear very similar to text orders, but they can have multiple specific 
fields for users to enter data. They are created by the CACs and may contain TIU 
objects and template fields. 

 
Figure 4-253: Generic Order with TIU Template Field 

Generic orders may contain multiple fields, drop-down menus, and can even point to 
other files. Generic orders can provide a way to put together an order so that all the 
needed elements are present. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

309 

 
Figure 4-254: Generic Order with Multiple Fields Including Drop-Downs 

4.10.9 Quick Orders 
Providers often need to order the same items for specific diseases or procedures. 
Therefore, it may be advantageous to bring up an order where all the fields and 
selections are already filled in using quick orders. Quick orders are created by the 
CAC and can be any type of order, such as Medication, Radiology, Laboratory, 
Nursing or Consult. 

The common element is that the fields are already filled in, so the provider only needs 
to review and sign them. They can still be edited, if needed, as in the clinical 
indication for a lab order. 

The CAC should make the name of the quick order clear enough so that the provider 
knows exactly what they are ordering when they select that order. 

If you select Other in the Clinical Indication field, the SNOMED CT Lookup dialog 
displays for you to select a problem. Refer to the Using the SNOMED CT Lookup 
dialog topic for more information. 
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The following are some examples of quick orders. 

 
Figure 4-255: Lab Quick Order with Clinical Indication Completed 
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Figure 4-256: Output Med Quick Order 

4.10.10 Order Menus 
Quick orders are normally placed on order menus that appear in the left column to 
select when ordering. 

Menus can have sub-menus, as well. 
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Figure 4-257: Menu with Sub-Menu 

The user can select one or more items from a menu. To select multiple items, hold 
down the Ctrl key, and then select the items to be ordered. The items appear in blue. 

After you release the Ctrl key, the first item appears, and the remaining items appear 
in a dialog. 

 
Figure 4-258: Start of Multiple Order Selection 

The Stop Order Set button allows the user to quit ordering. Otherwise, it progresses 
through each item in the list until finished. 

If the item(s) you selected contains a menu, you can then select items from that menu. 

Clicking Next indicates you are moving on from that menu. 
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Figure 4-259: Next Button on Respiratory Meds dialog 

As you progress through the items, the finished items contain a check box. 

 
Figure 4-260: Order Selection in Progress 

4.10.10.1 Personal Quick Orders 
Providers can create personal Quick Orders. This is not recommended because then 
that particular individual is responsible for editing and changing the Quick Order if 
the medication goes off formulary or the Lab or Radiology test is inactivated. 
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Another problem is that the clinical indication may not be appropriate for the next 
selected patient or the pharmacy selected for an eRX may not be the one the next 
patient wants to use. 

Also, the CAC does not have access to these Quick Orders and cannot fix them for 
the provider. Therefore, the provider needs to be extremely careful is using this 
option. 

1. Complete the Order dialog. 

 
Figure 4-261: Making a Personal Quick Order 

2. Select Options > Save as Quick Order. 
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Figure 4-262. Add Quick Order (Lab) dialog 

3. Enter a name for the Quick Order and arrange it in the list by moving it up and 
down with the arrow keys. 

Note: A Quick Order can be renamed or deleted at a later time. 

4. Click OK when finished. 

When going into the generic dialog again, the Quick Orders are at the top of the list. 

4.10.10.2 Editing the Common List 
To make changes later to the personal Quick Order list, the provider needs to bring up 
an active dialog (Lab, Med, or Radiology). The easiest way is to select one of their 
Quick Orders. 

1. Select Options > Edit Common List. 

This brings up the list of personal Quick Orders of that ordering type. 
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Figure 4-263: Editing Personal Quick Orders 

The provider can move any Quick Orders up and down in the list using the arrow 
keys, and rename a Quick Order or delete one. 

2. Click OK when finished. 

 
Figure 4-264: Renaming a Personal Quick Order 

4.10.11 Change Orders 
You can change the elements of an existing order. For example, you might need to 
change the dosage of a Pharmacy order. This function cannot be used for controlled 
substances. 

An order that remains unsigned can be changed at any time. Once an order is signed, 
the change discontinues the old order and creates a new one. 

Make sure a visit is selected and that the view is set to Active Orders. To change an 
order: 

1. Select the order (cannot be a cancelled order) to change. 
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2. Select Action > Change (or select Change on the right-click menu) to display the 
order dialog for the selected record. 

3. Complete the changes, as appropriate, on the Order dialog. 

4. Click Accept Order. 

5. You can sign the changed order now or later. See Sign Selected for more 
information. 

4.10.12 Discontinue Order 
When an order is discontinued, the application changes the order’s Stop Date/Time to 
the date/time the action is taken. Pending and Non-verified orders are deleted when 
the medication order is discontinued and will no longer appear on the patient’s 
profile. An entry is placed in the order’s Activity Log recording who discontinued the 
order and when the action was taken. 

The list in the Reason to Discontinue field is controlled by a parameter in the RPMS. 

Make sure a visit is selected for the current patient. To discontinue an order: 

1. Select the order you want to discontinue. 

2. Select Action > Discontinue/Cancel (or select Discontinue on the right-click 
menu) to display the Discontinue/Cancel Orders dialog. 

 
Figure 4-265: Discontinue/Cancel Orders dialog 

3. Select the appropriate reason to discontinue from the Reason to Discontinue field 
and click OK. 
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The word Discontinue appears in the Order column for the selected order, and the 
Status = Unreleased on the Orders window (for medication orders). 

 
Figure 4-266: Discontinued Medication Order 

Other types of orders, like imaging, have Status = Discontinue and the reason 
appears in the Order column. 

 
Figure 4-267: Discontinue Imaging Order 

4.10.13 Event Delayed Orders 
Providers may want to write orders either from the ER or the clinic before a patient is 
admitted. Or, they may want to write transfer orders before the transfer occurs. This 
can be done in the EHR using event delayed orders. 

The CAC must set up event delayed orders and the rules that accompany them. 

1. Click the delayed orders type in the Write Orders List box. This element is setup 
by a parameter so that clinic sites only do not have to display it. 
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Figure 4-268: Delayed Orders in Write Orders Window 

2. Determine the type of Delayed Order. Sites can set up various delayed orders for 
each location, as needed. 

• For Outpatients, only admission types display 

• For Inpatients, only transfer types display 

3. Click OK. Admission order type is used in this example. 
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Figure 4-269: Admission Delayed Orders 

4. The provider enters the admission order. The Treating Specialty field is especially 
important, as the admission clerk also enters this information and they must 
match. This order becomes active as soon as it is signed. 

 
Figure 4-270: Admit Patient Delayed Admit to Ward 
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5. If the Delayed Order has an assigned admission menu, it appears. If not, the user 
must enter the order from the normal Write Orders list. 

 
Figure 4-271: Delayed Order Done 

The Event Delayed Orders are highlighted in the View Orders window. 
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Figure 4-272: Event Delayed Order in View Orders Window 

6. The provider is notified they are writing Delayed Orders. 

Medication orders are for Inpatient medications. These orders appear as delayed. 
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Figure 4-273: Unsigned Delayed Orders 

Once signed, the Delayed Orders remain in delayed status until the patient is 
admitted to that location or treating specialty. Then the delayed orders go to 
pending or active status. 

If the admission occurs to a different unit, the nursing staff can manually release 
the delayed orders. 

7. Select Action and look for Release Delayed Orders. This option only appears if 
there are unreleased orders. 

 
Figure 4-274: Manual Release 
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Under View, then Auto DC/Release Event, users can also review which orders 
were auto-DC'd or released in ADT action. 

8. Selecting an action from the list displays all of the orders that were affected by 
that action. 

 
Figure 4-275: Auto DC/Release Event Orders 

4.10.14 Copy to New Order 
You can copy an existing order to a new order. This process lets you do one of the 
following: 

• Copy the exact elements of the existing order to create a new order 

• Change the order elements to create a new order 

Note: Make sure a visit is selected. 

To copy an order to a new order: 

1. Select the order to be copied. 

2. Select Action > Copy to New Order (or select Copy to New Order on the right-
click menu) to display the Copy Orders dialog. 
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Figure 4-276: Copy Orders dialog 

If the order does not have a Clinical Indication associated with it, the Unable to 
Save Order information message displays. A Clinical Indication must be added 
before proceeding. Refer to the appropriate Orders topic based on the type of 
order you are copying, or refer to Using the SNOMED CT Lookup dialog if the 
Other option is selected in the Clinical Indication field. 

3. Make sure the Release copied orders immediately option button is selected. (The 
Delay release of copied orders option button is used for inpatients only. 

4. Click OK. The New Order dialog displays. 

 
Figure 4-277: New Order dialog 

You can do one of the following on this dialog: 

• If you click Accept, this means the order elements are the ones you want to 
use. 

• If you click Cancel, this stops the Copy to New Order process. 

• If you click Edit, the order dialog displays. You can change the elements of 
the order on this dialog. After you complete the edit process, click Accept 
Order. 

5. You can sign the order now or wait until later. 
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4.10.15 Order Comments 
This function allows you to add comments to an order. The comments appear on the 
Order Details dialog. 

Note: Make sure a patient is selected. 

To add order comments: 

1. Select the order to which you want to add comments. 

2. Select Action > Order Comments to display the Comments for Order dialog. 

 
Figure 4-278: Comments for Order dialog 

Note: Comments cannot be edited on active orders. If an active 
order is selected, the Unable to Edit Comments message 
appears. Click OK and select a different order on which to 
enter comments. 

 
Figure 4-279: Unable to Edit Comments 

3. Enter the comments in the Comments field. 
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Note: There is a right-click menu to aid in editing the text. 

4. Click OK when the dialog is complete. 

You can view the comments on the details for the order. (See Order Details for 
more information). 

4.10.16 Order Details 
You can view the details of an order that provides information about the order. To 
view the details of an order: 

1. Select an order on the Orders window. 

2. Select View > Details (or select Details on the right-click menu). 

The Details dialog displays the following: 

• Patient data, including height and weight at last measurement 

• Whether the medication is a discharge medication 

• Any comments 
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Figure 4-280: Order Details dialog 

You can change the font size of the text displayed in this dialog by adjusting the 
size in the Font Size field (enter manually or use the up and down arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

The dialog has a right-click menu enabling you to copy selected text and paste it 
into any free-text field within the EHR or into another application (like MS 
Word). 

3. Click Print to choose a printer and to output the (entire) contents of this dialog to 
the specified printer. 
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Note: The Print button may be available. It is according to how 
your application is configured. 

4. Click Close to dismiss the dialog. 

4.10.17 Results History 
To view the results history of a Laboratory order: 

1. Select an order with results you want to view. 

2. Select View > Results History (or select Results History on the right-click menu). 
The Order Results History window displays. 

3. You can print the text of the results by clicking Print. 

4.10.18 Miscellaneous Ordering Features 
Several convenience features described in this section are available to facilitate order 
entry and tracking. 

4.10.18.1 Alerting User when Order Results are Available 
You can select a recipient to receive a notification when order results are available. 

Note: A recipient must have the Flag Order For Clarification alert 
set to ON to receive the alert. To set this, select Tools > 
Options. Use the Notification tab. 

Follow these steps to notify a user when the results of an order are available: 

1. Select an order. 

2. Select Action > Alert when Results to display the Alert when Results Available 
dialog. 

 
Figure 4-281: Alert when Results Available dialog 

3. Choose an alert recipient from the Alert Recipient: drop-down list. 

4. Click OK. 
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4.10.18.1.1 Flagging an Order 
You can flag an order to draw attention to it. When an order is flagged, the order 
appears on the Orders window with a Red Flag ( ) icon before the Service column. 
The application records the name of the person who flagged the order, and the date 
and time that it was flagged. The order remains flagged until it is unflagged by the 
user. 

You can select an alert recipient to receive a notification about the flagged order. 

Note: A recipient must have the Flag Order For Clarification alert 
set to ON in order to receive the alert. To set this, select 
Tools > Options. Use the Notification tab. 

Follow these steps to flag an order: 

1. Select the order that you would like to flag. 

2. Select Action > Flag. 

The Flag Order dialog displays. 

 
Figure 4-282: Flag Order dialog 

3. Enter a reason for the flag in the Reason for Flag field. This field has a right-click 
menu to aid in editing the text. 

4. Choose an alert recipient from the Alert Recipient drop-down list, if necessary. 

5. Click OK to complete the flagging process. The corresponding order now has a 
flag indicator: 

 
Figure 4-283: Flagged Order on Orders Window 
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4.10.18.1.2 Unflagging an Order 
It is easy to remove the flag from an order. You can enter a reason for removing the 
flag, but this is not required. 

In the Order Detail display for the unflagged order, the name of the person who 
removed the flag and the date and time that it was removed is recorded. 

 
Figure 4-284: Order Detail Showing Flag and Unflag Information 

Follow these steps to unflag an order: 

1. Select the flagged order you want to unflag. 

2. Select Action > Unflag to display the Unflag Order dialog. 

 
Figure 4-285: Unflag Order dialog 

3. Enter a comment, if desired. 

4. Click OK to complete the unflagging order process. 

4.10.18.1.3 Quitting an Order 
If you start an order (does not apply to Text Only order), complete the information, 
and then click Quit, the application displays the Unsaved Order information message. 
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Figure 4-286: Information Message After Clicking Quit 

Click Yes to save the order and exit the Order dialog. (Otherwise click No to not save 
the order and exit the Order dialog.) 

4.10.18.1.4 Sign Selected 
When you have unsigned orders (appears in bold, blue lettering) on the Orders 
window, you can sign it. Follow these steps: 

1. Select an unsigned order on the Orders window. 

2. Select Action > Sign Selected (or select Sign Selected on the right-click menu) to 
display the Review/Sign Changes dialog. 

 
Figure 4-287: Review/Sign Changes dialog 

3. Enter your electronic signature code. It applies to the checked orders listed on the 
dialog. 

4. After entering the signature, click Sign. (Otherwise, click Cancel.) 

Important: It is recommended that orders be signed using 
the Integrated Signature Tool, particularly for 
medications or contrast media. There is a safety 
mechanism built into the Integrated Signature 
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Tool that processes any allergies in the dialog 
and then does another allergy order check prior 
to processing the orders. This is bypassed when 
using the Sign Selected option. 

4.10.18.1.5 Nurse and Clerk Verification 
For Inpatient tracking of orders, clerks and nurses can initial that they have reviewed 
orders entered by providers. 

Users need either the ORELSE (nurse) or ORMAS (clerk) security keys to view these 
options. 

Double-click the order to open and review the Order Details dialog to confirm the 
patient and data is correct before verifying. 

 
Figure 4-288: Inpatient Medication Order Details 

After verifying the Order Details, from the Action drop-down menu (or by right-
clicking an option), nurses can view Verify and Chart Review actions, and clerks can 
Verify an action. 
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Figure 4-289: Verify Action 

The nurse or clerk can select the orders they want to verify and then select the Verify 
action. 

 
Figure 4-290: Nurse Verify Action 

The action is then reviewed and signed. 
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Figure 4-291: Review and Sign 

The nurse's initials appear in the Nurse column. 

Chart Reviews 
A nurse can also select a group of orders and complete a chart review. In this 
instance, the nurse's initials appear in the Chart column. 

 
Figure 4-292: Chart Review dialog 

4.10.18.2 Using the SNOMED CT Lookup dialog 
To use the SNOMED CT Lookup dialog: 

1. Click the Ellipsis button by the appropriate field to display the SNOMED CT 
Lookup dialog. 
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Figure 4-293: SNOMED CT Lookup dialog 

2. In the SNOMED CT lookup dialog, in the Diagnosis Lookup section, select either 
the Fully specified name or Synonym option button. 

• Fully specified name returns a collapsed list of SNOMED CT terms. Click 
the Expand sign ( ) next to the term to expand and view the child entries. 

• Synonym returns the full list of SNOMED CT terms. 

3. In Search, type the term by which you want to search. 

4. In Subset, you can select a subset in which to search, if needed. 

5. In Search Date, the field defaults to the current date. Click the drop-down arrow 
to open the calendar and select a different date to search, if needed. 

6. Click the Find button. The list of SNOMED CT terms is populated. 

7. Select and highlight a term, and then click the Select button. The Clinical 
Indication field refreshes with the selected SNOMED CT term you selected. 
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4.10.19 Order Checking 
Order Checking is based on a system of rules that causes orders to be reviewed to 
determine whether they meet the defined criteria. If they do, an electronic message is 
sent to the ordering provider before the order is completed (such as duplicate order, 
drug-lab interaction, and so on). The provider can then choose to cancel the order or 
override the order check and place the order. 

4.10.19.1 Severity Levels and Source of Information 
Order Check dialogs cite the source of the drug interaction information and use 
colored icons to represent severity levels. 

The colors are: 

• Red – For High 

• Yellow – For Moderate 

• Green – For Low 

 
Figure 4-294: Order Check 

If the order is placed, a second order check appears after the order is signed. If the 
order check is moderate or high level, you are required to enter a reason why you are 
continuing with the order. 
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Figure 4-295: Order Check Justification 

The justification remains with the order and is available in the Order Details. 

4.10.19.2 Cancelling Orders in Order Checks 
If an order is already signed and the user tries to sign a duplicate order, the 
application displays the Order Checks dialog. The user can choose the order to be 
deleted. 
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Figure 4-296: Order Checks dialog 

1. If you check the order you want to delete and click the Cancel Selected Order(s) 
button, the application displays the Cancel Order information message: 

 
Figure 4-297: Cancel Order Information Message 

2. Click Yes to cancel the selected order. The order then is removed from the Order 
window. (Otherwise, click No to not cancel the order.) 

3. If you do not check the order and click the Continue button, you return to the 
Order window with both orders remaining on the list of orders. 

4.10.19.3 Prepackaged Order Checks 
The Order Checking application enables users to determine when order checks and 
notifications are sent. To accomplish this, the application includes several 
prepackaged order checks, as well as three menus for setting Order Checking 
parameters, such as enabling and disabling specific order checks. 

Order checks can also be configured to be mandatory by the CAC or IRM. If this 
feature is enabled, individual order checks cannot be edited by the end users. Non-
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mandatory order checks can be enabled or disabled through the Tools > Options 
menu. 

Order checks exported with EHR: 

Order Check Value 
ESTIMATED CREATININE CLEARANCE Enabled 
ORDER CHECKING NOT AVAILABLE Enabled 
ALLERGY-DRUG INTERACTION Enabled 
ALLERGY-CONTRAST MEDIA 
INTERACTION Enabled 

CT & MRI PHYSICAL LIMITATIONS Enabled 
BIOCHEM ABNORMALITY FOR 
CONTRAST MEDIA Enabled 

DUPLICATE ORDER Enabled 
RECENT BARIUM STUDY Enabled 
RECENT ORAL CHOLECYSTOGRAM Enabled 
DUPLICATE DRUG ORDER Enabled 
DUPLICATE DRUG CLASS ORDER Enabled 
CRITICAL DRUG INTERACTION Enabled 
CLOZAPINE APPROPRIATENESS Enabled 
AMINOGLYCOSIDE ORDERED Enabled 
RENAL FUNCTIONS OVER AGE 65 Enabled 
MISSING LAB TESTS FOR ANGIOGRAM 
PROCEDURE Enabled 

GLUCOPHAGE-CONTRAST MEDIA Enabled 
LAB ORDER FREQ RESTRICTIONS Enabled 
ERROR MESSAGE Enabled 
POLYPHARMACY Enabled 
DISPENSE DRUG NOT SELECTED Enabled 
GLUCOPHAGE-LAB RESULTS Enabled 
SIGNIFICANT DRUG INTERACTION Enabled 
NO ALLERGY ASSESSMENT Disabled 
DUPLICATE OPIOID MEDICATIONS Disabled 
ALLERGIES UNASSESSIBLE Disabled 

Note: Most of these order checks are exported in the enabled state 
at the package level. Sites can then turn them on for 
individuals or teams, as determined by the site. CACs, 
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individuals, or services can also disable individual order 
checks, if they so choose. Package levels are only visible to 
those with programmer access and should NEVER be 
modified. 

The list might not be up-to-date since it changes with EHR Patches. View order 
checks by using RPMS-EHR CONFIGURATION MASTER > ORD (Order Entry 
Configuration) > OCX (Order Check Configuration) > PAR (Order Check 
Parameters) > USR (Order Checks a User Can Receive) OR ENA (Enable/Disable an 
Order Check). Entering a question mark gives the user the list of order checks on the 
system. 

4.10.19.4 Personal Preferences in Order Checks 

Users can control what order checking is executed for orders. However, mandatory 
order checks cannot be turned off. 

To turn order checks on or off: 

1. Select Tools > Options to display the Options dialog. Then click the Order 
Checks tab. 

 
Figure 4-298: Order Checks Tab of Options dialog 

The Order Check list comes from the Order Check file in RPMS. The CAC can 
turn any Order Check ON or OFF, as well as set any Order Check to Mandatory. 

2. You can select or clear the various order checks, except for mandatory ones (the 
word Mandatory appears in the Comment column). 
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3. When the Options dialog is complete, click OK to dismiss it. 

4.10.20 Printing an Order 

You can print a selected order by selecting the Print option on the File menu. If 
necessary, you can set up the printer by selecting the Printer Setup option on the File 
menu. 

Printing can also be set to occur automatically or the Print Orders dialog to print may 
appear automatically. This is controlled by parameters set up by the CAC. 

To print a selected order: 

1. Select File > Print to display the Print Orders dialog. 

 
Figure 4-299: Print Orders dialog 

2. The Location field displays where the orders will print. You can change the 
location by clicking the Ellipsis button and selecting an option on the drop-down 
list. 

3. Select at least one check box to print. 

Note: Parameters set up by your CAC control which items appear 
for printing, such as charts, labels, regs, work copies, and 
so on. 
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You can change the Print to Device field by clicking the Change button to display 
the Printer Selection dialog. The printers listed are the available printers in the 
selected location (in the Location field) on the Printer Orders dialog. 

 
Figure 4-300: Printer Selection dialog 

4. Select a printer. The number associated with the printer defines the page width 
(the number of characters across the page). This number comes from the RPMS 
device file. 

Note: The selected printer can be made the default by clicking the 
Save as your default printer check box. 

5. Change the number of copies by changing the value in the Copies field. 

6. To review other setups (after selecting your printer), click the Setup button to 
display the Print Setup dialog. Here you can review the page width and page 
length dimensions. Although it appears you can change these numbers, you 
cannot because the application uses the values stored in the RPMS device file. 
The Page Length on a printer = number of lines on a page. 

7. After the Printer Selection dialog is complete, click OK. (Otherwise, click 
Cancel). 

8. Click the Print All Checked Items button on the Print Orders dialog. The contents 
of the (checked) orders output to the selected printer. 

Note: The Cancel Print button only closes the Print Orders dialog. 

4.11 Patient Education 
The Education component displays the current patient’s education events from the 
RPMS. This information appears on the grid below the Education label. 
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Figure 4-301: Education Component 

You can sort the Patient Education information by selecting a column heading. If no 
Education information is present in the RPMS for a patient, the grid is empty. 

The Patient Education component can be configured so that a user or class cannot 
add/edit information. 

You can view Visit Detail information about a visit associated with a Patient 
Education record. Select the Display Visit Detail option on the right-click menu to 
display the Visit Detail dialog. See Section 4.11.1 for more information. 

Note: Items for the current selected visit display in blue in the 
Patient Education component. 

4.11.1 Visit Detail Information 
The Patient education component has a Display Visit Detail option on the right-click 
menu. 

1. Select an existing record within the component. 

2. Right-click and then select the Display Visit Detail option. The Visit Detail 
window displays information from the visit file. 
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Figure 4-302: Visit Detail Information 

3. Click Close to dismiss the window. 

You can change the font size of the text displayed in this window by adjusting the 
size in the Font Size field (enter manually or use the Up and Down arrows). 

Note: When printing, this does not change the size of the text on 
the output. 

4. Click Print to choose a printer and to output the (entire) contents of this window 
to the specified printer. 

Note: The Print button appears according to how the component 
is configured. 

The Detail window has a right-click menu where you can copy selected text and 
paste it into any free-text field within the HER or into another application (like 
MS Word). 
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4.11.2 Selecting an Education Topic 
To add an Education event, you must first select an education topic. The selection 
utilizes one of five different selection dialogs by either clicking one of the icons or 
selecting one of the option buttons. 

When you click Add (or select the Add Patient Education option on the right-click 
menu) within the Education component, the Education Topic Selection dialog 
displays. 

 
Figure 4-303: Education Topic Selection dialog 

Many of the selection dialogs have the Display Outcome & Standard button. After 
selecting a topic and clicking the button, the Outcome and Standard for the selected 
education topic displays. See Outcome and Standard Statement for more information. 

If you do not want to enter an education topic, click Cancel to dismiss the Education 
Topic Selection dialog. 
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4.11.2.1 Selection by Category List 

1. To select the Education Topic using the Category List button ( ), expand the 
category you want view by clicking the Expand button ( ) to display its 
associated education topics. 

2. Then either double-click the desired entry or select it and click the Select button. 
(Otherwise, click Cancel.) 

 
Figure 4-304: Selecting Education Topic by Category list 

After clicking Select, the Add Patient Education Event dialog displays with your 
selection in the Education Topic field. 

4.11.2.2 Selection by Name Lookup 

1. To select the Education Topic using the Name Lookup button ( ), select an 
entry by either double-clicking the education topic entry in the list or highlighting 
the topic, and then clicking Select. 

2. To access an entry, you can either manually scroll the list or add the first few 
characters of its name to reposition the scroll list. 

3. Highlight the desired name and click Select, or double-click the name. 
(Otherwise, click Cancel.) 
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Figure 4-305: Selecting Education Topic by Name Lookup 

After clicking Select, the Add Patient Education Event dialog displays with your 
selection in the Education Topic field. 

4.11.2.3 Selection by Disease and Topic Entry 

1. To select the Education Topic using the Disease and Topic Entry button ( ), 
you must select both a Diagnosis code and a corresponding topic, and then click 
OK. (Otherwise, click Cancel.) 

2. Select the diagnosis from a SNOMED CT lookup or select the POV for the 
current encounter if it has already been entered. 
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Figure 4-306: Selecting Education Topic by Diagnosis and Topic Entry 

3. Populate the Disease/Illness field using one of two methods: 

• Method 1: If POV has already been entered, select the information in 
the POV field. The information populates the Disease/Illness field. 

• Method 2: Click the Ellipsis button next to the Disease/Illness field to 
open the SNOMED CT Lookup dialog. 

a. In the SNOMED CT lookup dialog, in the Diagnosis Lookup 
section, select either the Fully specified name or Synonym 
option button. 

o Fully specified name returns a collapsed list of 
SNOMED CT terms. Click the Expand button ( ) next 
to the term to expand and view the child entries. 

o Synonym returns the full list of SNOMED CT terms. 

b. In Maximum Results 
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o 25 

o 50 

o 100 

o 200 

o ALL 

c. In Search, type the term you want to search for. 

d. In Subset, you can select a subset to search, if needed. 

e. In Search Date, the field defaults to the current date. Click the 
drop-down arrow to open the calendar and select a different 
date to search, if needed. 

f. Click either the IHS SNOMED CT or ALL SNOMED CT 
button. The list of SNOMED CT terms and their mapped ICD 
code is populated. 

g. Select and highlight a term, and then click the Select button. 
The Disease/Illness field of the Education Topic Selection 
dialog refreshes with the selected SNOMED CT term you 
selected. 

4. In the Education Topic Selection dialog, in the Topic Selection section, select a 
topic. 

5. Click OK. The Add Patient Education Event dialog displays with the Education 
Topic field populated with your selection from the SNOMED CT Lookup. 

Note: If you need to change the SNOMED CT code, click the 
Ellipsis button next to the Disease/Illness field. 

4.11.2.4 Selection by Procedure and Topic Entry 

To select the Education Topic using the Procedure & Topic Entry button ( ), you 
must enter both a CPT code and the corresponding topic. 
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Figure 4-307: Selecting Education Topic by Procedure and Topic Entry 

1. Populate the CPT field using one of two methods: 

• Method 1: Select the information in the Visit Services field. This information 
populates the CPT field. 

• Method 2: Click the Ellipsis button by the CPT field to display the Procedure 
Lookup dialog. See Using the Procedure Lookup dialog for more information. 

2. Select one of the items on the Lookup dialog and click OK to have the selected 
item added to the CPT field on the Education Topic Selection dialog. 

3. In the Topic Selection field, select a topic, and then click OK. The Add Patient 
Education Event dialog displays with your selection in the Education Topic field. 

4.11.2.5 Selection by Pick List 

To select the Education Topic using the Pick List button ( ), select one or more 
options from a Pick List. 

One of two conditions is possible: 

• The Pick List panel is populated 

• The Pick List panel is empty (or you want to create a new Pick List). 
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4.11.2.5.1 Populated Pick List 

 
Figure 4-308: Populated Pick List Selection Menu 

1. The education category is displayed in the drop-down list next to the Pick Lists 
button. If there is more than one category, select one. In the previous example, the 
education category is Diabetes Education. 

2. You can check one or more items from the displayed Pick List. 

Note: Click the Show All check box to show all Pick List items. 

3. Select the Type of Training, Comprehension Level, Length (of time, in whole 
numbers) that specifies the number of minutes for the education, and Readiness to 
Learn. 

Note: If you select more than one education topic, the Length of 
time is divided equally among the topics. 

4. Click OK to add those items to the Education grid. (There is no Add Patient 
Education Event dialog in this instance.) 
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4.11.2.5.2 Empty Pick List 
When the Selection dialog is empty, you need to create a pick list. This same method 
is used to create a new pick list. 

 
Figure 4-309: Selecting Education Topic by Pick List 

Follow these steps to create a new Pick List: 

1. Click the Pick Lists button to display the Manage Education Quick Picks dialog. 
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Figure 4-310: Manage Education Quick Picks 

2. Click the Edit Pick Lists button to display the Manage Categories dialog. 

 
Figure 4-311: Manage Categories dialog 

3. Click the Add button to display the Add Category dialog. 
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Figure 4-312: Add Category dialog 

4. Type a name in the Category Name. 

5. Choose how the pick list displays from the methods that follow. If you do not 
select a display method, the pick list is available to all users in all locations. 

• Hospital Location: The pick list is available to anyone who is in the selected 
hospital location. 

• Clinic: The pick list is available to anyone who is in the selected the clinic. 

• Provider: The pick list is available to the selected provider. 

• Provider Discipline: The pick list is available to anyone who is in the selected 
provider discipline. 

6. To prevent other users from editing your pick list, add your name, and any other 
user allowed to edit your menu (in the Managers panel). 

7. Click OK when complete. 

8. Add education codes to the pick list category. 

9. On the Manage Education Quick Pick dialog, select your pick list category from 
the Education Topic Pick Lists field. 
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Figure 4-313: Manage Education Quick Picks dialog with no Pick Lists 

10. Click the Add button and search for the code on the lookup utility. Select an 
education code you would like to add and click OK. The education codes are 
added to the pick list. Repeat this step as needed to add more codes. 

 
Figure 4-314: Manage Education Quick Picks with Pick Lists 

Pick List Options 

Additional options, as needed, to help you manage the pick list are as follows: 
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• Rename: Highlight the education code you want to rename and click the Rename 
button. A window opens and enables you to rename the education code. 
Remember that when a code is inactivated nationally, it remains in the pick list 
until manually removed by the pick list manager. 

• Note: Renaming the code does not result in changing the way the education code 
is documented. 

• Delete: Highlight the education code you want to remove from the pick list and 
click the Delete button. 

• Copy: Click the Copy button to copy education codes from another menu to your 
new pick list. 

• Query: Click the Query button to list the most commonly used patient education 
codes used by a provider or a clinic. Use caution when using this option, as 
education codes change on a very frequent basis and you do not want to include 
inactive codes in your pick list. 

Note: To avoid selecting inactive patient education codes, use 
caution with the Query option since education codes 
change and become inactive frequently. 

• Zero Frequency: Every time you use an education code, the frequency is recorded 
and displayed on the pick list. This function resets the frequency for all of the 
education codes. 

• Import: Use this button to import an education code pick list from another user. 

• Export: Use this button to export an education code pick list to your desktop 
computer. This file can be shared with other EHR users. 

1. Complete the Education Topic Selection dialog: 

a. Select one or more options in the panel below the Pick Lists button. 

b. Select the Type of Training. 

c. Select the Comprehension Level from the drop-down menu: 

• Poor 

• Fair 

• Good 

• Group – No Assessment 

• Refused 

d. Type a length of time (in whole numbers) that specifies the number of minutes 
for the education. 
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Note: If you select more than one education topic, the length of 
time is divided equally among the topics. 

2. Click OK to populate the selected items in the Education panel. (There is no Add 
Patient Education Event dialog in this instance.) 

4.11.2.6 Using the Procedure Lookup dialog 
Follow these steps to use the Procedure Lookup dialog: 

1. Click the Ellipsis button at the end of the Procedure field to display the Procedure 
Lookup dialog. 

 
Figure 4-315: Initial Procedure Lookup dialog 

2. Select the Lexicon or CPT option button to determine where you want to search 
for the procedure. 

3. The Return Search Text as Narrative check box (when checked) enables the EHR 
to populate the Narrative field with whatever you enter in the Search Value field. 
Otherwise, the Narrative field is populated with whatever is selected for the 
Procedure field. 

4. Search for a procedure by entering a few characters in the Search Value field and 
clicking Search. The related procedures display in the lower part of the dialog. 
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Figure 4-316: Procedure Lookup dialog After Clicking Search 

5. If this is the wrong procedure, re-enter the characters in the Search Value field 
and click Search (repeat until you attain the correct procedure). 

6. If needed, sort the Code or CPT column by selecting the column heading. Use the 
scroll bar to view the entire list. When you have found the correct procedure, 
select it and then click OK, or double-click the procedure. (Otherwise, click 
Cancel.) 

The selected procedure populates the CPT field when selecting a CPT for a 
Procedure and Topic Entry in the Education Topic Selection dialog or if selecting 
a CPT for the Add Refusal tab when Completing the Health Factors and Refusal 
Information. 

4.11.2.7 Using the Lookup Utility dialog for Location 
Access the Lookup Utility by clicking the Ellipsis button at the end of the Location 
field. Use this dialog to search for and select a location for the Location field. 
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Figure 4-317: Initial Lookup Location dialog 

Follow these steps to complete the Lookup Location dialog: 

1. You can scroll the list to the location and select it. Otherwise you can search for a 
location. 

2. To search for a location, type of few characters in the Search Value field and click 
Search. 

 
Figure 4-318: Lookup Location dialog After Search 

3. Select the appropriate record in the lower panel and click OK. The selected record 
populates the Location field. (Otherwise, click Cancel.) 
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4.11.3 Adding an Education Event 
After selecting an education topic, you can add either new or historical Patient 
Education events: 

• New Patient Education is for a current visit. 

• Historical Patient Education is for past visits and typically for an outside facility 
or place. 

It is important to note that for non-historic visits, the date and location of the 
Education must correspond to the currently selected encounter in the EHR (which can 
be for past dates). 

Note: In order to add an Education record you must be assigned 
the PROVIDER key and cannot hold the BGOZ VIEW 
ONLY key. 

In conjunction with adding education event information, you can add health factor 
information as well as a refusal for a selected topic. 

The following information is divided into three parts: 

• Completing the Patient Education Information 

• Entering Historical Patient Education Information 

• Completing the Health Factors and Refusal Information 
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4.11.3.1 Completing the Patient Education Information 

 
Figure 4-319: Add Patient Education Event dialog with Education Refusal Selected 

Follow these steps to complete the Add Patient Education Event dialog for the current 
visit: 

Note: If you need to change the Education Topic, click the 
Ellipsis button next to the Education Topic field. The 
Education Topic Selection dialog opens. Refer to Selecting 
an Education Topic for details on completing the dialog. 

1. Select the type of training, if needed. 

2. The default for the Comprehension Level is Good, and should be changed 
accordingly. The patient’s Comprehension Level (also called Level of 
Understanding) can be classified as the following: 

• Good (examples: verbalizes understanding; able to return demonstration or 
teach-back correctly). 

• Fair (examples: verbalizes need for more education; incomplete return 
demonstration or teach-back indicates partial understanding). 

• Poor (examples: does not verbalize understanding; unable to return 
demonstration or teach-back). 

• Group – No Assessment (examples: education provided in group; unable to 
evaluate individual response). 

• Refused. 
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3. You can add a comment to the patient education code that provides further 
description of the encounter. Comments can be used for describing the name of a 
lesson plan or education material provided to the patient (limited to 100 
characters). 

4. If another provider is needed for the Provided By field, click the Ellipsis button to 
select from a lookup utility. 

5. Select the appropriate Readiness to Learn document from the drop-down menu. 

6. If needed, add goals. Goals are optional for the patient education documentation. 
Goals can be documented as Goal Set, Goal Met, or Goal Not Met. The free-text 
field in the Status/Outcome group box is limited to 20 characters (that describes 
something about the goal). 

7. Click Display Outcome & Standard to display the Outcome and Standard 
statement for the displayed education topic, if needed. 

8. When the Add Patient Education Event dialog is complete, click Add to add the 
education topic (or refusal) to the Education and Personal Health panels. 
(Otherwise, click Cancel.) 

4.11.3.2 Entering Historic Patient Education 
When you check the Historical check box on the Add Patient Education dialog, the 
Historical group box is added to the dialog. 

Another way to enter the Historical Patient Education Event is to have no visit 
selected and click the Add button. The Add Patient Education Event with the 
Historical check box selected displays. 
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Figure 4-320: Historical Patient Education Event 

• The Event Date and Location determine the date and location of the education 
event. 

• The Event Date must be a past date. Either manually enter it or click the 
Ellipsis button to display a calendar from which to select a date. 

• The Location can be either an IHS Facility or Other (at another facility or 
office). 

• If you enable the IHS/Tribal Facility option button, you can enter a valid IHS 
Facility name or click the Ellipsis button to display a lookup utility from 
which to select one. If the manually-entered facility name is not a valid one, 
the EHR displays the lookup utility. See Using the Lookup Utility dialog for 
Location for more information. 

• If you enable Other, you can enter the name of another place or office where 
the education event took place (like Dr. Brown’s Office). 

• If your site has been configured with a default outside location, type OTHER 
in the Location field. Then when you display the View Visit Detail window, 
the default outside location displays at the LOC. OF ENCOUNTER field. 

• Complete the fields in the other parts of the dialog as when entering a non-
historical education event. 
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4.11.3.3 Completing the Health Factors and Refusal Information 
This part of the Patient Education dialog is optional. By clicking the Patient’s 
Learning Health Factors button, you can add health factor information for the selected 
patient on the current visit. This information is divided into two parts: 

• Completing the health factors information 

• Completing the refusal information 
Click the Patient’s Learning Health Factors button on the Patient Education dialog to 
display the Add Health Factor and Add Refusal dialog. From this dialog, complete 
the following tabs. 

 
Figure 4-321: Add Health Factor and Add Refusal dialog 

4.11.3.3.1 Add Health Factor Tab 
Use the Health Factor tab to add specific learning factors which may help or hinder 
the patient's learning ability. 

1. Click the Add Health Factor tab. 

2. Expand one of the Items in order to select a health factor under that item. 
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Figure 4-322: Expanded Item for Particular Health Factor 

3. Highlight the particular health factor and click Add. 

This adds the particular health factor to the Health Factor component and it displays 
in the Patient’s Learning Health Factors panel on the Add or Edit Education dialog. 

4.11.3.3.2 Add Refusal Tab 
Use the Add Refusal tab to add a refusal for a specified health factor learning refusal 
type. 

1. Select the Add Refusal tab to add a refusal. 

 
Figure 4-323: Add Refusal Tab 
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2. Select any one of the check boxes in the Refusal Type panel. The label for the 
field reflects what is selected in the Refusal Type panel. 

3. Click the Ellipsis button next to the field below the Refusal Type. The Procedure 
Lookup dialog opens. Refer to the Using the Procedure Lookup dialog topic for 
details on completing the fields. 

4. In Reason, select one of the following from the drop-down menu: 

• (None Selected) 

• Declined Service 

• Not medically indicated 

• No response to follow-up 

• Provider discontinued 

• Considered and not done 

• System reason 
5. The Date Refused field defaults to the current date. Click the Ellipsis button to 

select a different (past) date. 

Note: The Date Refused cannot be a future date. 

6. The Comment field is a free-text field. Type a comment or notes, as needed. 

7. After you complete this dialog, click Add to have the information added to the 
patient's learning refusal file, shown in the field below the Patient's Learning 
Health Factors button on the Add (or Edit) Patient Education Event dialog. 

4.11.4 Editing an Education Event 
In order to edit an Education record you must be assigned the PROVIDER key and 
cannot hold the BGOZ VIEW ONLY key. The visit the education topic was entered 
on cannot be locked. 

See the Outcome and Standard topic for more information about the dialog that 
displays when you click the Display Outcome & Standard button. 

Make sure a visit is selected. Follow these steps to edit an education event: 

1. Select an Education Event you want to edit. 

2. Click Edit (or select Edit Patient Education on the right-click menu) to display the 
Edit Patient Education Incident dialog. 
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Figure 4-324: Edit patient Education Incident dialog 

See Selecting an Education Topic for information about how to select another 
education topic for the Education Topic field. 

3. As needed, update any or all of the data fields of the original education event. See 
Adding an Education Event for completing the dialog. 

Note: If the selected record is a historical patient education event, 
you cannot change the event date or place (in the Historical 
group box). 

4. When the Edit Patient Education Event dialog is complete, click Save to update 
the education topic on the Education panel. (Otherwise, click Cancel.) 

4.11.5 Deleting an Education Event 
In order to delete an Education record you must be assigned the PROVIDER key and 
cannot hold the BGOZ VIEW ONLY key. 

The education event must be on a visit that is not locked. 

Note: Any Health Factor/Refusal information entered for the 
selected education event is NOT removed by the Delete 
function. 

Make sure a visit is selected. Follow these steps to delete an education event: 

1. Select an Education Event you want to delete. 
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2. Click Delete (or select Delete Patient Education on the right-click menu) to 
display the Remove Patient Education? information message. 

 
Figure 4-325: Delete an Education Event Information Message 

3. Click Yes to delete the selected record. (Otherwise, click No.) 

4.11.6 Using the Web Reference Search 
The Web Reference Search for the Patient Education component depends if any 
records are present. The Reference Site list can be configured. 

• Condition 1: If there are records present, select one and click the Information 

button ( ), or select the Web Reference option on the right-click menu to go to 
the UpToDate Reference Web site for the topic associated with the selected 
record. You can change to another Web site by selecting from the Reference Site 
drop-down list (on the Web site). 

• Condition 2: If there are no records present, click the Information button ( ), or 
select the Web Reference option on the right-click menu to display the Web 
Reference Search dialog. 

 
Figure 4-326: Web Reference Search dialog 

The Web Reference Search dialog to select a reference site only opens if you do not 
have a default set up and you have not selected any item in the education list. Once 
you have highlighted an item in the list, the Web Reference attempts to go to the 
default site and search on the topic you selected. If you chose a topic attached to a DX 
or procedure, you are presented with information on that particular topic. 
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Figure 4-327: Web Reference Topic 

4.11.7 Outcome and Standard Statement 
Users can display and print the Outcome and Standard Statement for a selected 
education event by clicking the Show Standard button (or by selecting Show Standard 
on the right-click menu) on the Education panel. The same thing happens when you 
click the Display Outcome & Standard button on the Education Topic Selection 
dialog and on the Add/Edit Patient Education dialogs. 

 
Figure 4-328: Example of Outcome and Standard Statement 

The Standard window contains the outcome and standards for a selected education 
topic. 
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Click Close to dismiss the window. 

You can change the font size of the text displayed in this window by adjusting the 
size in the Font Size field (enter manually or use the Up and Down arrows). 

Note: This does not change the size of the text on the output 
(when you print). 

Click Print to choose a printer and to output the (entire) contents of this window to 
the specified printer. 

Note: The Print button appears according to how your application 
is configured. 

The Standard window has a right-click menu where you can copy selected text and 
paste it into any free-text field within the EHR or into another application (like MS 
Word.) 

4.12 Personal Health 
The Personal Health component has features where you can record data regarding 
Functional Status, Birth Measurements, Refusal, and Treatment Contract. 

Various options are available for recording personal health data, depending on the 
selected patient. For example, the Birth Measurements option is only available when 
a patient less than 8-years old is selected. 

 
Figure 4-329: Personal Health Component 

The choices available on the drop-down list depend on the appropriate BGOZ keys 
that are assigned. Contact your CAC about the available keys. 

This component can be configured so that a particular user or class cannot add or edit 
reproductive history information. 
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The Personal Health component contains the Display Visit Detail option on the right-
click menu. Selecting this option displays a dialog showing information about the 
visit where you can view or print the information. 

4.12.1 Adding Personal Health Records 
You can add several types of personal health records to the Personal Health 
component. 

Important: You must select a patient and an unlocked visit to add 
PHR information. 

4.12.2 Adding Functional Status 
The Functional Status option is where you record the activities of daily living. 

To add functional status to a record: 

1. From the Personal Health component, select a line item, select the Functional 
Status option from the drop-down menu, and then click the Add button (or select 
Add on the right-click menu). The Enter Functional Status Record dialog opens. 

 
Figure 4-330: Enter Functional Status Record dialog 

2. In the Activities of Daily Living or Instrumental Activities of Daily Living 
sections, select one of the following for any of the drop-down lists to record a 
functional status associated with those activities: 

• Independent 

• Needs Help 

• Totally Dependent 
3. In Change of Status, if you are updating or adding a change in the patient's 

functional status, select one of the following from the drop-down menu: 
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• Same 

• Improvement 

• Decline 

4. In Patient is Caregiver to Others, select one of the following from the drop-down 
menu: 

• Yes 

• No 
5. Click OK to add the Functional Status record to the Personal Health component. 

(Otherwise, click Cancel.) 

4.12.3 Adding Birth Measurements 
The Birth Measurements option is used to record birth measurement information 
about the current infant on the current visit. This option is only available when a 
patient less than 8-years old is selected. 

To add birth measurements to a record: 

1. From the Personal Health component, select the Birth Measurements option from 
the drop-down menu, and then click the Add button (or select Add on the right-
click menu). The Update Birth Measurements dialog opens. 

 
Figure 4-331: Update Birth Measurements dialog 
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Note: Follow the data formatting instructions on the Update Birth 
Measurements dialog. 

2. In Birth Weight, type the patient's weight at birth. The unit of measure for birth 
weight is automatically changed for the following: 

• Changes to kilograms if k or K is typed 

• Changes to grams if g or G is typed 

• Changes to lbs.-oz. if a hyphen or space is typed 
The resulting value is appropriately validated. 

3. In Birth Order, type a numeric value to indicate the patient's birth order. 

4. In the Feeding Choices section, type a value for the following fields: 

• Formula Started 

• Breast Feeding Stopped 

• Solids Started 
5. In the Mother or Guardian field, click the Ellipsis button to open the Lookup 

Patient dialog and follow these steps: 

a. In Search Value, type a name, and then click the Search button. 

 
Figure 4-332: Initial Lookup Patient dialog 

The Lookup Patient dialog refreshes with a list of matching names. 

b. Select a name, and then click Ok. 

The Mother or Guardian field on the Update Birth Measurements dialog populates 
with your selection. 
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Figure 4-333: Lookup Patient dialog 

6. Click OK to add the birth measurements record to the Personal Health 
component. (Otherwise, click Cancel.) 

4.12.4 Adding Refusals 
The Refusal option is where you record that the patient refused treatment or 
assessment on the current visit. A refusal demonstrates that an intention was 
attempted but the patient declined or stated not to perform the treatment or 
assessment. 

1. From the Personal Health component, select Refusal from the drop-down menu, 
and then click Add (or select Add on the right-click menu). The Enter Service Not 
Provided/Refusal dialog opens. 
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Figure 4-334: Enter Refusal dialog 

2. In Refusal Type, select the applicable refusal type: CPT, EKG, Exam, 
Immunization, Lab, Mammogram, Measurement, Medication/Drug, PAP Smear, 
Radiology Exam, Skin Test, and SNOMED CT. 

4.12.4.1 CPT 
1. Select the CPT check box on the Enter Service Not Provided/Refusal dialog. The 

Refusal Item field changes to CPT. 

 
Figure 4-335: Enter Refusal for CPT 
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2. Click the Ellipsis button next to the CPT field to display Procedure Lookup dialog 
where you search for and select current procedural terminology. 

 
Figure 4-336: Procedure Lookup dialog 

3. In the Procedure Lookup dialog, in Lookup Option, select either the Lexicon or 
CPT option button. 

4. In Search Value, type a value for which to search. 

5. In Included Code sets, select a check box, as applicable: 

• Medical 

• Surgical 

• HCPCS 

• E&M 

• Radiology 

• Laboratory 

• Anesthesia 

• Home Health 

6. If needed, click the Return Search Text as Narrative check box. 
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7. Click the Search button. The search results show a list of procedures which 
includes the Code and Narrative. 

8. Select a procedure from the list, and then click OK. Your selection populates in 
the CPT field of the Enter Service Not Provided/Refusal dialog. 

4.12.4.2 EKG 
1. Select the EKG check box on the Enter Service Not Provided/Refusal dialog. The 

Refusal Item field changes to EKG. 

 
Figure 4-337: Enter Refusal for EKG dialog 

2. Click the Ellipsis button for the EKG field to display Lookup Diagnostic 
Procedure for EKG where you select a Diagnostic Procedure for EKG (if any). 

Note: EKG is the default pre-populated entry for the EKG field. 

3. In Search Value, type a term for which to search, or leave the field blank, and 
then click Search. The Diagnostic Procedure results show a list of procedures. 
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Figure 4-338: Lookup Diagnostic Procedure for EKG 

4. Select a procedure from the list, and then click OK. Your selection populates in 
the EKG field of the Enter Service Not Provided/Refusal dialog. 

4.12.4.3 Exam 
1. Select the Exam check box on the Enter Service Not Provided/Refusal dialog. The 

Refusal Item field changes to Exam. 

 
Figure 4-339: Enter Refusal for Exam 
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2. Click the Ellipsis button for the Exam field to display the Lookup Exam dialog 
where you select an exam name. 

 
Figure 4-340: Lookup Exam dialog 

3. In the Lookup Exam dialog, in Search Value, type a search term or leave the field 
blank to return all choices. 

4. Click Search. The search results show a list of exams. 

5. Select an exam from the list, and then click OK. Your selection populates in the 
Exam field of the Enter Service Not Provided/Refusal dialog. 

4.12.4.4 Immunization 
1. Select the Immunization check box on the Enter Service Not Provided/Refusal 

dialog. The Refusal Item field changes to Immunization. 
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Figure 4-341: Enter Refusal for Immunization 

2. Click the Ellipsis button for the Immunization field to display the Vaccine 
Selection dialog where you select a vaccine. 

 
Figure 4-342: Vaccine Selection dialog 

3. In the Vaccine Selection dialog, in Search Value, type a search term or leave the 
field blank to return all choices. 
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4. Select one of the following option buttons: 

• Show All Active Vaccines 

• Show Only active Vaccines with a Lot Number 

• Show All Vaccines (default) 
5. Click Search. The search results show a list of immunizations and their 

description. 

6. Select an immunization from the list, and then click OK. Your selection populates 
in the Immunization field of the Enter Service Not Provided/Refusal dialog. 

4.12.4.5 Lab 
1. Select the Lab check box on the Enter Service Not Provided/Refusal dialog. The 

Refusal Item field changes to Lab. 

 
Figure 4-343: Enter Refusal for Lab 

2. Click the Ellipsis button for the Lab field to display a lookup utility where you 
select a lab test name. 
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Figure 4-344: Lookup Lab Test dialog 

3. In the Lookup Lab Test dialog, in Search Value, type a search term or leave the 
field blank to return all choices. 

4. Click Search. The search results show a list of lab tests. 

5. Select a lab test from the list, and then click OK. Your selection populates in the 
Lab field of the Enter Service Not Provided/Refusal dialog. 

4.12.4.6 Mammogram 
1. Select the Mammogram check box on the Enter Service Not Provided/Refusal 

dialog. The Refusal Item field changes to Mammogram. 
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Figure 4-345: Enter Refusal for Mammogram 

2. Click the Ellipsis button for the Mammogram field to display the Lookup 
Radiology Exam dialog where you select a radiology exam for mammogram. 

 
Figure 4-346: Lookup Mammogram dialog 

3. In the Lookup Radiology Exam dialog, in Search Value, type a search term or 
leave the field blank to return all choices. 

4. Click Search. The search results show a list of radiology exams. 

5. Select a radiology exam from the list, and then click OK. Your selection 
populates in the Mammogram field of the Enter Service Not Provided/Refusal 
dialog. 
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4.12.4.7 Measurement 
1. Select the Measurement check box on the Enter Service Not Provided/Refusal 

dialog. The Refusal Item field changes to Measurement. 

 
Figure 4-347: Enter Refusal for Measurement 

2. Click the Ellipsis button for the Measurement field to display a lookup utility 
where you select a vital measurement. 

 
Figure 4-348: Lookup Measurement dialog 

3. In the Lookup Measurement dialog, in Search Value, type a search term or leave 
the field blank to return all choices. 

4. Click Search. The search results show a list of measurement options. 

5. Select a measurement from the list, and then click OK. Your selection populates 
in the Measurement field of the Enter Service Not Provided/Refusal dialog. 
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4.12.4.8 Medication/Drug 
1. Select the Medication/Drug check box on the Enter Service Not Provided/Refusal 

dialog. The Refusal Item field changes to Medication/Drug. 

 
Figure 4-349: Enter Refusal for Medication/Drug 

2. Click the Ellipsis button for the Medication/Drug field to display a lookup utility 
where you select a drug name. 

 
Figure 4-350: Lookup Drug dialog 

3. In the Lookup Drug dialog, in Search Value, type a search term or leave the field 
blank to return all choices. 
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4. Click Search. The search results show a list of drugs. 

5. Select a drug from the list, and then click OK. Your selection populates in the 
Medication/Drug field of the Enter Service Not Provided/Refusal dialog. 

4.12.5 PAP Smear 
Select the PAP Smear check box on the Enter Service Not Provided/Refusal dialog. 
The Refusal Item field changes to PAP Smear. 

 
Figure 4-351: Refusal for PAP Smear 

Note: When clicking the Ellipsis button, there are no other 
choices other than PAP SMEAR. 

The Lookup Lab Test dialog opens, but defaults to PAP SMEAR. 

 
Figure 4-352: Lookup Lab Test dialog 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Updated Components 
September 2014 

388 

PAP SMEAR auto-populates in the Medication/Drug field of the Enter Service Not 
Provided/Refusal dialog. 

4.12.6 Radiology Exam 
1. Select the Radiology Exam check box on the Enter Service Not Provided/Refusal 

dialog. The Refusal Item field changes to Radiology Exam. 

 
Figure 4-353: Enter Refusal for Radiology Exam 

2. Click the Ellipsis button for the Radiology Exam field to display the Lookup 
Radiology Exam dialog where you select a radiology exam. 

 
Figure 4-354: Lookup Radiology Exam dialog 

3. In the Lookup Radiology Exam dialog, in Search Value, type a search term or 
leave the field blank to return all choices. 

4. Click Search. The search results show a list of radiology exams. 
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5. Select a Radiology exam from the list, and then click OK. Your selection 
populates in the Radiology Exam field of the Enter Service Not Provided/Refusal 
dialog. 

4.12.7 Skin Test 
1. Select the Skin Test check box on the Enter Service Not Provided/Refusal dialog. 

The Refusal Item field changes to Skin Test. 

 
Figure 4-355: Enter Refusal for Skin Test 

2. Click the Ellipsis button for the Skin Test field to display a lookup utility where 
you select a skin test. 

 
Figure 4-356: Lookup Drug dialog 

3. In the Lookup Drug dialog, in Search Value, type a search term or leave the field 
blank to return all choices. 

4. Click Search. The search results show a list of skin tests. 
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5. Select a skin test from the list, and then click OK. Your selection populates in the 
Skin Test field of the Enter Service Not Provided/Refusal dialog. 

4.12.8 SNOMED CT 
1. Select the SNOMED CT check box on the Enter Service Not Provided/Refusal 

dialog. The SNOMED CT field changes to SNOMED CT. 

 
Figure 4-357: Enter Refusal for SNOMED CT Test 

2. Click the Ellipsis button for the SNOMED CT field to display the SNOMED CT 
Lookup utility where you select a SNOMED CT term. 
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Figure 4-358: Lookup SNOMED CT dialog 

3. In the Diagnosis Lookup, select one of the following option buttons: 

• Fully specified name (default) 

• Synonym 

4. In Maximum Results, select one of the following option buttons: 

• 25 

• 50 

• 100 

• 200 

• ALL 

5. In the Search field, type a search term. 

6. In Subset, select one or more subsets to search. 

7. Click again to clear a term. 

8. Click either the IHS SNOMED CT or the ALL SNOMED CT button to search. 
The search results show a list of applicable problems and the mapped ICD code. 
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9. Select a problem from the list, and then click Select. Your selection populates in 
the SNOMED CT field of the Enter Service Not Provided/Refusal dialog. 

10. Complete the Enter Service Not Provided/Refusal dialog for all refusal types as 
follows: 

a. In Reason, select a refusal reason from the drop-down menu. 

b. The Date Refused field defaults to the current date. If needed, change the date 
by entering it manually or by clicking the Ellipsis button to select from a 
calendar. The date cannot be a future date. 

c. If needed, enter comments about the refusal in the Comment field. This field 
is a free-text field that contains a right-click menu to help you in editing the 
entered text. 

d. Click Add to add this record to the Personal Health component. (Otherwise, 
click Cancel.) The record shows in the Refusal section. 

 
Figure 4-359: Completed Personal Health Refusal 

4.12.9 Adding Treatment Contract Information 
The Treatment Contract option is where you record that the treatment contract was 
made with the patient. 

1. From the Personal Health component, select the Treatment Contract option and 
click Add (or select Add on the right-click menu) to display the Add Treatment 
Contract Record dialog. 

 
Figure 4-360: Add Treatment Contract Record dialog 
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2. In the Type pane, select a type of contract from one of the following: 

• Pain 

• Mental Health 

3. The Date Initiated field defaults to the current date. If needed, change the date by 
entering it manually or by clicking the Ellipsis button to select from a calendar. 
The date cannot be a future date. 

4. If needed, the Provider field has a lookup utility where you can search for a name. 
See Using the Lookup Utility dialog for Provider. 

5. Click OK to add the record to the Personal Health component. (Otherwise, click 
Cancel.) 

4.12.10 Using the Lookup Utility dialog for Provider 
You access the Lookup Utility by clicking the Ellipsis button at the end of the 
Provider field. You use this dialog to search for and select a name for the Provider 
field. 

Follow these steps to complete the Lookup Provider dialog. 

 
Figure 4-361: Initial Lookup Provider dialog 

1. Type a few characters in the Search Value field and click Search. The appropriate 
names display in the lower panel of the dialog. 

2. If this is not the correct data, repeat Step 1. 
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Figure 4-362: Lookup Provider dialog After Search 

3. Highlight the appropriate name in the lower panel and click OK. The selected 
record populates the Provider field. (Otherwise, click Cancel.) 

4.12.11 Editing Personal Health Records 
The Personal Health panel may appear like this for a patient: 

 
Figure 4-363: Editing Personal Health 

There are two ways to edit Personal Health data: 

• Edit by double-clicking the existing record in the grid. The appropriate dialog 
displays. 

• Select an existing record and click Edit (or select Edit on the right-click menu). 
The appropriate dialog displays. 

Make any changes, as applicable. 
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4.12.12 Deleting Personal Health Records 
1. Select a record in the Personal Health panel that you want to delete and click 

Delete (or select Delete on the right-click menu). The Remove Record? 
information message displays. 

 
Figure 4-364: Remove Record Information Message 

2. Click Yes to remove the selected record. (Otherwise, click No.) 

4.13 Visit Diagnosis 
The Visit Diagnosis is a view-only component that shows POV information for the 
current patient and information regarding the diagnosis for the visit. 

 
Figure 4-365: Visit Diagnosis Panel 

View visit information by selecting a record, and then selecting View Visit Detail on 
the right-click menu. The Visit Detail dialog opens. 

4.13.1 Web Reference Search Function 
There are two Web Reference search options available from the Visit Diagnosis 
component that enables the user to look up information on a highlighted diagnosis 
from the Provider Narrative column on the Visit Diagnosis dialog: 

• Education Information button ( ) 

• Clinical Decision Support button( ) 

The Web Reference search depends on if any records are present or not when you 
click either button. 

• Condition 1: If there are records present, select a record and click either the Ed 
Information or the Clinical Decision Support button. 
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Note: You can change to a different Web site, if desired, by 
selecting from the Reference Site drop-down list. 

• Condition 2: If there are no records present or if no record is selected, click either 
the Education Information button or the Clinical Decision Support button to 
display the Web Reference Search dialog. The UpToDate Web site is the default. 

 
Figure 4-366: Web Reference Search dialog 

Select a different Reference Site from the drop-down menu, if needed. After entering 
a term and clicking Search, the selected Web site opens for the specified term. 

4.13.1.1 Education Information Button 

When a patient diagnosis is selected, click the Education Information button ( ). 
This sends a call to the MedlinePlus Web site to provide information regarding the 
selected topic and the MedlinePlus Web site opens to the related page. 

Note: The Add Patient Education Event dialog also opens when 
the Education Information button is clicked. Patient 
education is tracked for Meaningful Use; therefore, the Add 
Patient Education Event dialog should be completed. Refer 
to the Patient Education Online Help for details on 
completing this dialog. 
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Figure 4-367: Medline Plus Web Site 

4.13.1.2 Clinical Decision Support Button 

When a patient diagnosis is selected, click the Clinical Decision Support button (
). This sends a call to the UpToDate Web site to provide information regarding the 
selected topic and the UpToDate Web site opens to the related page. 

 
Figure 4-368: UpToDate Web Site 
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Appendix A:  Image Viewer 
The IHS Imaging Viewer object was developed to provide tight integration of images 
with reports in the IHS EHR application. To meet the requirements of Meaningful 
Use II, the context between images and reports must be maintained all times. 

The EHR application is built on a flexible framework that allows the insertion of 
objects that communicate with the framework. The framework then handles all 
exchange of information with Resource and Patient Management System (RPMS). 

VistA Imaging is used to attach images to Radiology Reports or Text Integration 
Utility (TIU) Progress Notes in RPMS. In the EHR application, Progress Notes and 
Radiology reports are displayed in tabs that are part of the patient’s electronic 
medical chart. A user with access rights to Design Mode in the EHR application can 
add IHS Image Viewer objects to EHR templates. This allows users to easily display 
abstracts (thumbnail images) associated with a patient’s Progress Note or Radiology 
Report. The IHS Image Viewer object also allows the user to open the full resolution 
viewer to further interact with the images. 

The IHS Imaging Viewer has two distinct visual parts. The first visual part (which is 
inserted into the framework) communicates with the RPMS database, displays 
abstracts and launches the full resolution viewer when abstracts are selected for 
display. The second visual part is the full resolution viewer, which has no direct 
connection with the RPMS database. The full resolution viewer provides a rich set of 
tools to view and manipulate the images. 

Additionally this document contains information about the setup and configuration of 
EHR application to support the Imaging Viewer. 

A.1 Using the IHS Image Viewer 
The workflow of the typical user is a search and display process. A particular patient 
becomes of interest for a clinical reason, a provider looks up the patient, examines the 
patient chart, discovers that the patient has documentation with attached images, and 
the provider accesses these images at will. 

A.2 Client Configuration 

A.2.1 Adding the IHS Imaging Abstract Viewer Object to a Template 
3. To enter Design Mode, right-click the EHR title bar or press Ctrl/Alt/D on the 

keyboard. 

4. Once in Design Mode, select the tab where you want to add the IHS Image 
Viewer object. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Image Viewer 
September 2014 

399 

In a practical setting, the Notes and Reports tabs should have an IHS Image 
Viewer object inserted, since these are the only RPMS reports that have image 
indicators in the chart. 

Note: CACs are generally the users given access to Design Mode. 

5. Right-click in the area where you want to insert the IHS Image Viewer object into 
the EHR template. 

6. Select Add Object from the Context menu. 

7. Expand the Name item from the Object tree. 

8. Scroll down the list of objects and select IHS Image Viewer. 

9. Click Add. 

 
Figure A-1: Add an Object dialog 

This inserts an IHS Image Viewer object into the selected area, which can be 
sized to fit the client area. 

10. Access the properties by right-clicking the IHS Image Viewer object just inserted. 

11. Select the Properties Context Menu. 

A.2.1.1 Properties dialog 
The Properties dialog contains the standard EHR object properties and additional 
custom properties. Two check boxes control what types of images are displayed in the 
IHS Image Viewer object, and another check box controls the object’s appearance. 



Electronic Health Record (EHR) Version 1.1 Patch 13 

User Manual Image Viewer 
September 2014 

400 

 
Figure A-2: Properties dialog 

• When the Radiology check box is selected, the object displays Radiology images. 

• When the Notes check box is selected, the IHS Image Viewer object displays 
images attached to progress notes. This enables the user to have IHS Image 
Viewer objects inserted into tabs that display radiology reports, progress notes or 
both. 

• The Compact check box enables the IHS Image Viewer object to operate in 
compact mode. It is beneficial on very crowded tabs. In this mode the IHS Image 
Viewer object only shows the study information. When the user clicks an object, 
the abstracts are displayed in a popup window. Clicking outside of the pop up 
reverts the Abstract Viewer to its compact display. If the compact mode is not 
checked the abstracts and the study information is displayed within the object in 
detailed mode. 

Clicking OK saves the settings for the selected IHS Image Viewer object. 

1. Once the object is sized appropriately, click the Design menu. 

2. Select the Save as Template menu item and click Save to save the current 
template. You can also select a different template from the list or create a new 
template. 

3. Exit Design Mode by right-clicking the EHR title bar and selecting Design Mode 
from the context menu or press Ctrl/Alt/D on the keyboard. 
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The details of working with EHR templates can be found in the VueCentric EHR 
documentation, and are beyond the scope of this manual. 

Once the IHS Image Viewer object is inserted and properly sized, the object 
properties must be set in order to view images. 

Figure A-3 illustrates the IHS Image Viewer object inserted in Detailed Mode into the 
Notes tab: 

 
Figure A-3: IHS Image Viewer Object 

A.2.1.2 IHS Image Viewer Property Settings 
The user can access the Settings dialog for any of the inserted IHS Image Viewers by 
clicking the Settings ( ) icon on the upper-right corner of the IHS Image Viewer 
object. Figure A-4 displays the general settings. 
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General Tab 

 
Figure A-4: Settings dialog – General Tab 

On the General tab, the user may remap the image directory or force the install of the 
viewer component. These features are used for testing or troubleshooting. 

Layout Tab 
The Layout tab is used to control the appearance of radiology studies in the full 
resolution viewer. 

 
Figure A-5: Settings dialog – Layout Tab 
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The Layout tab provides the user with controls to select the full-resolution viewer 
layout based on the modality contained in the image headers. The default setting is 
used for the layout for modalities without specific layout definition. 

The Automatically Load Display Set check box enables the loading of the entire 
study into the layout when the abstract is double clicked in the IHS Image Viewer 
object inserted into the Notes or Reports tab. 

The expanded Modality drop-down list illustrates the currently supported Modality 
types. 

 
Figure A-6: Modality Drop-down List 

The layout enables the user to select optimum configurations for the most common 
radiology procedures. 

Notes Tab 
The Notes tab controls the initial layout of the viewports on the notes tab of the full 
resolution viewer. 
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Figure A-7: Settings dialog – Notes Tab 

The Image Box Row and Column selector controls the initial division of the full-
resolution viewer into image boxes (also known as viewports). 

A.3 Using the IHS Image Viewer 
The workflow of the typical user is a search and display process. A particular patient 
is of interest for a clinical reason. The provider looks up the patient, examines the 
patient chart, discovers that the patient has documentation with attached images, and 
the provider can access these images at will. 

A.3.1 Selecting a Patient 
The top-left corner of a chart usually contains the patient pane. 

Note: Sites may configure this area for their specific use, so there 
is no guarantee that the Patient Information pane will be in 
the same location. 
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Figure A-8: Patient Chart 

Selecting the Patient Information pane brings up the Patient Search tool. 

 
Figure A-9: Patient Search Tool dialog 

A.3.2 IHS Image Viewer Object 
Once a patient is selected, the user may interact with the IHS Image Viewer object 
inserted into one of the tabs. Figure A-10 shows a Detailed Abstract Viewer inserted 
into the Notes tab. When the Notes tab is selected and a note without images is 
selected, the Abstract Viewer is cleared. 
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Figure A-10: Detailed Abstract Viewer 

A.3.2.1 Notes 
When a note with attached images is selected, the Abstract Viewer loads the images 
and displays an abstract for each series of images attached. In most cases, note images 
have a single image in each series. Therefore, each abstract usually represents a single 
image. 

Some of the more advanced imaging modalities may generate DICOM series of 
images attached to TIU notes, in which case an abstract may represent multiple 
related images. 

 
Figure A-11: DICOM Image Series Attached to Notes 
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In Figure A-12, a compact Abstract Viewer has been added to the Reports tab. When 
the Reports tab is selected, the Abstract Viewer is cleared of images and information 
if there are no exams with attached images selected. 

 
Figure A-12: Abstract Viewer Cleared 

When an exam with images is selected, the Abstract Viewer displays information 
related to the selected case including the exam description and the number of images 
in the case. 

 
Figure A-13: Case Information Displayed in Abstract Viewer 

When the user selects the compact Abstract Viewer, the abstracts display in the 
dialog. 
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Figure A-14: Abstracts Loaded in the Abstract Viewer 

A.3.3 Full Resolution Viewer 
Selecting an abstract opens the full resolution viewer and loads the image into the 
viewports. 

Figure A-15 displays the full resolution viewer for images attached to a Note. 
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Figure A-15: Image-Attached Notes 

Selecting a Radiology abstract opens the full-resolution viewer and loads the images 
into viewports if the Autoload setting is selected in the object properties. 

If the Autoload setting is not selected, the user can take one of two actions: 

• Select an abstract and drag it to an unused viewport. 

• Double-click an abstract, which causes all the images of the case loaded into 
memory and the series of the case to populate the viewports from the upper-left 
corner of the grid. 

Figure A-16 represents a set of radiology images in the full resolution viewer: 
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Figure A-16: Radiology Images in Full Resolution Viewer 

A.3.4 Working with Note Images 
Once images associated with notes are loaded into the full-resolution viewer and 
automatically arranged into viewports, the user may start interacting with these 
images. 

It is important to recognize that if a set of note images cannot fit into the configured 
number of viewports, the viewer allows paging through multiple sets of images. This 
is accomplished by using the viewer tools on the Notes tab. The number of images 
attached to the case and the number of viewports visible in the viewer, determine the 
number of pages occupied by images. 

When there are more than one page of images, the viewer enables the Up and Down 
Arrow buttons as appropriate. Clicking the Down Arrow reveals the next page of 
images, while clicking the Up Arrow displays the previous page. 

To dynamically change the layout click the Grid button ( ) to launch the Layout 
Selection tool. 
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Figure A-17: Layout Selection Tool 

The tool’s shaded squares represent the grid layout to be applied to the viewer. Once 
the final selection is made, the viewer renders the case in the selected layout, where 
the top-left corner Viewport of the grid will be occupied by the image that is in the 
current layout’s top-left Viewport. 

The Viewport tools are used to manipulate image presentation. 

 
Adjusts the image magnification to fit the width of the viewport. The 
operation preserves the Image’s aspect ratio 

 Adjusts the image magnification to fit into the viewport in both vertical 
and horizontal direction while preserving the image’s aspect ratio 

 
Magnifier tools can be use to increase or reduce the magnification of the 
image 

 
Rotates the image 90 degrees to the left or to the right 

 
Resets the image to the presentation that was used to when the image was 
loaded 

 
Sliders adjust brightness and contrast 

A.3.5 Working with Radiology Images 
The loading of radiology images is controlled by the modality specific Layout 
settings. A radiology case may be auto loaded and laid out using all available 
Viewports, or may only load into the full resolution viewer’s abstract strip. The user 
may, at any time, drag an abstract to an unused Viewport, or double-click an abstract 
to load the entire case into the available Viewports. 

A.3.5.1 Viewports 
The Viewer uses one or more Viewports for image display. A Viewport can contain a 
single image or a group of related images. How images are displayed is largely 
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dependent on the organization of the DICOM study. As a general guideline one can 
expect that: 

• Images of a general radiology (CR or DX) exam are usually displayed one image 
per Viewport. 

• Images of CT or MR exams are usually divided among several Viewports: 

− One viewport per series (or sequence) 
− Optionally one Viewport for scout (localizer) images 

Images in a Viewport can be adjusted independently from images in other Viewports. 
Within a Viewport, all images can be adjusted at once or single images can be 
adjusted independently. 

 
Figure A-18: Viewport Images 

Viewports can display one image at a time (stacked view) or several images at once 
(tiled view). Users can switch between views without having to reload an exam. 
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Figure A-19: Viewport Display 

The Title Bar 
The Viewport Title bar displays the case ID, status and date of the exam. The 
Viewport Title bar may also display other information, such as the series ID. 

If there is not enough space to display all the text in the Viewport Title bar, pause the 
mouse pointer over the title bar to make it expand and display all its contents. 

The Contents Bar 
The Contents bar is located in the upper-right corner of a viewport. It displays the 
number of exams, image sets (series), and images in the viewport. 

Tick Marks 
In viewports that contain multiple images, the relative position of the selected image 
in the stack is indicated by tick marks on the left side of the viewport. The I label in 
the Contents bar can also indicate the position of an image in the stack. 

The Image Information Area 
The information area at the bottom of a viewport displays such details about the 
selected image as image number, acquisition date/time, the image’s current display 
properties (window/level, scale, and so on), and other acquisition data. 
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If there is not enough space to display all image information, you can pause the 
mouse pointer over the area to make it expand and display all its contents. 

Clicking the information area opens the Image Detail window. 

A.3.6 Manipulating Images 

A.3.6.1 Changing Image Properties 
The following changes can be made to images displayed in viewports: 

• Scale 

• Pan 

• Window/Level 

• Invert 

• Orientation 

• Sharpness 

• Reset 

Scaling Images 
An image can be can be dynamically zoomed from 5% to 800%, or it can be scaled to 
a specific percentage of its original size. You can also expand an image in the Viewer 
window to the size of an entire screen. 

As an image’s scale is changed, the current scale percentage is shown in the image 
information area at the bottom of the viewport. 

To Change Scale Dynamically 
Select the image you want to scale and drag it with the right-mouse button while 
pressing the Ctrl key. 

You can also turn on the Scale tool ( ). To do this, click the toolbar or right-click 
any image. Then click Scale and change scale by dragging with the left-mouse button. 

When you have finished using the scale tool, turn it off by right-clicking once. 

To scale an image to a specific size: 

1. Click the Scale tool ( ) in the toolbar or right-click any image. 

2. Click Scale. 

3. Point to the image you want to change and do any of the following: 
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To... Do this... 
Scale image to 100% Point near the top-left corner of the 

viewport. When the mouse pointer 

changes to , Click once. 
 

Scale image to fit viewport Point near the top middle part of the 
viewport. When the mouse pointer 

changes to , click once. 

Scale image to 50, 75, 125, 150, or 
200% 

Point near the top-right corner of the 
viewport. When the mouse pointer 

changes to , click once. Then click 
a scale option in the menu that 
displays. 

Note: While the Scale tool is turned on, you can also zoom in or 
out by dragging with the left-mouse button. 

4. Continue using the Scale tool, or disable it by right-clicking once or by choosing 
another tool. 

To use full-screen view: 
1. In the Viewer window, double-click an image. The image expands to fill an entire 

screen. 

2. While the full-screen view is active, you can: 

− Adjust (window/level, flip/rotate, and so on) the current image. 
− Scroll to other images or use the Cine tool. 

3. When you have finished, double-click the image to restore it to its original size. 

Panning images 
To pan an image, point to the image you want to pan and drag using the left-mouse 
button. Images that are completely visible cannot be panned. 

Note: If the image does not pan, right-click once to make sure 
that no other tools are active. (The mouse pointer looks like 
this when no tools are active: ). 

Changing Window/Level 
You can change an image’s window/level using the mouse, the keyboard, or a 
combination of both. You can also use the Auto-Window/Level tool to base 
window/level values on a selected area in an image. 
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As an image’s window/level is changed, the area under the image updates to show the 
current window/level values. Unless Apply To settings have been changed, 
window/level changes affect all images in the viewport. 

To change window/level: 
1. Point to the image you want to adjust and drag it using the right-mouse button. 

• Drag up or down to change window (window width) values. 

• Drag left or right to change level (window center) values. 

2. You can also click the Window/Level tool ( ) in the toolbar and change 
window/level by dragging it with the left-mouse button. 

3. When you have finished using the Window/Level tool, turn it off by right-clicking 
once. 

To use the auto-window/level tool: 

1. Click the Auto-Window/Level tool ( ) in the toolbar. 

2. In the image you want to adjust, drag the mouse pointer to define a rectangular 
area that includes the tissue you want to base the window/level on. 

3. When the drag/highlight is completed, the new window/level values are applied to 
the entire image. 

4. Continue using the Auto-Window/Level tool, or disable it by right-clicking once 
or by choosing another tool. 

Inverting Grayscale Values 
You can invert grayscale values to create a Negative view of an image. 

To invert an image: 

1. Click the Invert tool ( ) in the toolbar, or right-click any image and click Invert. 

2. Click the image you want to invert. 

3. Continue using the Invert tool, or disable it by right-clicking once or by choosing 
another tool. 

Reorienting Images 
You can change an image’s orientation by rotating it 90 degrees or by flipping it 
front-to- back. As changes are made, any positional indicators displayed near the 
edges of the image are updated to reflect the new orientation. (This does not include 
markers that are burned into the image itself.) 

To rotate images 90 degrees: 
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1. Click the Rotation tool ( ) in the toolbar. 

2. Point to the image you want to rotate. 

• To rotate the image counterclockwise, click on the left side of the image. 

• To rotate the image clockwise, click on the right side of the image. 

3. Continue using the Rotate tool or disable it by right-clicking once or by choosing 
another tool. 

To flip images: 

1. Click the Flip tool ( ) in the toolbar. 

2. Point to the image you want to flip. 

• To flip the image vertically, click the top part of the image. 

• To flip the image horizontally, click the bottom part of the image. 

Changing Layout 
You can specify the layout (number of rows and columns) in a window and in each 
viewport. The layout of each viewport or window can be set independently. 

To use full-screen view: 

• In the Viewer window, you can double-click an image to expand it to fit the 
current screen. 

• While you are in full-screen view, you can adjust the image or scroll to other 
images. 

• When you have finished, double-click again to return to the original screen layout 

To change layout in a viewport: 

1. In the upper-left corner of a viewport, click the Layout tool ( ) and drag it down 
using the mouse. 

2. In the grid that displays, move the mouse until the desired number of rows and 
columns are highlighted. 

3. Click the left-mouse button. 

Note: Layout cannot be changed if the viewport contains only one 
image. 
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To change layout in the Viewer: 

1. In the toolbar, click the Viewer Layout tool ( ) and drag down using the mouse. 

2. In the grid that displays, move the mouse until the desired number of rows and 
columns are highlighted. 

3. Click the left-mouse button. 

Copying Properties 
You can copy properties, such as window/level, scale, position (pan), and orientation, 
from one viewport to another. You can copy several properties at once, or copy a 
single property only. 

To control which properties are copied: 

1. In any occupied viewport, click the Copy tool ( ) and drag down to display the 
drop-down menu. 

• A check mark indicates properties to be copied 

• The absence of a check mark indicates properties that will not be copied 
2. Select a property to add or remove a checkmark. The settings you choose affect 

all viewports in all windows, and will be retained for the duration of your session. 

To copy properties (Copy icon): 
1. Select the image with the properties you want to copy. 

2. Click the Copy tool ( ) in the source viewport. 

3. Click an image in the target viewport. 

4. Continue using the Copy tool, or disable it by right-clicking once or by choosing 
another tool. 

To set initial copy settings: 
1. In the Viewer or Manager toolbar, click View | Settings. 

2. Click the Viewport tab. 

3. In the Copy Options area, select each property to be copied when the Copy 
Properties feature is used. 

4. Click OK. 

Linking Viewports 
Viewports in the Viewer can be linked. When viewports are linked, scrolling and 
paging changes made in one viewport affect all linked viewports. Changes to scale, 
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orientation, and so on, performed in one viewport can affect all linked viewports as 
well. 

When viewports are linked, the Link icon located near the top of the viewport appears 
as follows: 

 

When viewports are not linked, the Link icon changes appearance: 

 

To link viewports: 

If the viewports being linked contain images from different exams, select 
anatomically equivalent areas in each viewport before creating the link. 

1. In one of the viewports you want to link, click this Link tool ( ). 

2. Click each viewport you want to link. As the link is established, the Link icon will 
change ( ). 

3. When you have finished, right-click once to turn off the link function. Links are 
retained until the exam is closed or until the link is explicitly removed. 

4. Scroll or adjust the contents of one of the linked viewports as desired. Changes 
are reflected in all linked viewports. 

Important: If the linked viewports contain images from the 
same exam (for example, all images have the 
same Frame of Reference UID), each viewport 
shows the same anatomy as you scroll or page 
through images in the linked viewports. 

To unlink viewports: 

1. Use either of the following methods: 

• Point to the viewport you want to unlink, press the Ctrl key, then click the 
Link tool ( ). 

• In the viewport you want to unlink, click the Link tool ( ) and drag-down 
a short distance with the mouse. 

2. Click Unlink. 

To control which properties are linked: 

1. In a linked viewport, click the Link tool ( ) and drag-down to open the drop-
down menu. 
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• A check mark indicates that changes for a particular property have been 
applied across all linked viewports. 

• The absence of a check mark indicates that changes for a particular property 
have been applied to the current viewport only. 

2. Select a property to add or remove a checkmark. 

The settings you choose affect all linked viewports until the viewports are cleared. If 
there are multiple links active, settings for each link group can be set independently. 

Moving Image Sets 
Images can be moved from one viewport to another. 

To move images: 
1. Locate the viewport you want to use as the target viewport. 

• The target viewport can be empty, or it can contain a single image set. 

• The target viewport cannot contain more than one image set. The Contents bar 
in the upper-right corner indicates how many image sets (series) are present. 

2. Drag the title bar of the viewport that contains the images you want to move into 
the target viewport. 

• If the source viewport contains any hidden image sets, the next hidden image 
set is displayed when the move is completed. 

• If the target viewport was previously occupied, your current drag and drop 
settings determine if the contents of the target viewport are swapped or 
replaced. 

Sorting Image Sets 
Images in a viewport are automatically sorted based on information from the 
acquisition modality. If necessary, you can override the default sorting used and set 
your own sort order. 

A.3.6.2 Using the Cine Tool 
Starting and Stopping the Cine Tool 
1. If there are multiple images visible in the viewport (tiled view), click the image 

that you want to use as a starting point. 

2. Click the Arrow ( ) located in the upper-left corner a viewport. 

3. When you have finished, click Halt ( ) to stop the Cine tool. 
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To Set Cine Speed 

1. Open the Cine drop-down menu by clicking the Arrow ( ) or Halt ( ) and 
dragging-down with the mouse. 

2. Point to Speed, then click Low, Medium, or High. 

Note: To set the default cine speed, click View | Settings | 
Viewport, then choose an option from the Cine Speed box. 

To Set Cine Direction 

1. Open the Cine drop-down menu by clicking the Arrow ( ) or Halt ( ) and 
dragging-down with the mouse. 

2. Point to Direction and click Loop Forward, Loop Reverse, or Yoyo. 

• The direction you choose takes effect immediately, including any currently 
running Cines. 

• All viewports are affected by the change. 

Note: To set the default Cine direction, click View | Settings | 
Viewport, then choose an option from the Cine Direction 
box. 

To Set the Cine Range 
1. If the Cine tool is running, stop it by clicking Halt ( ). 

2. Display the image to be the first image in the Cine range. 

3. Open the Cine drop-down menu by clicking the Arrow ( ) and dragging-down 
with the mouse. 

4. Point to Range, then click First Cine Image. 

5. Display the image to be the last image in the range. 

6. Open the Cine drop-down menu by clicking the Arrow ( ) and dragging a short 
distance with the mouse. 

7. Point to Range, then click Last Cine Image. 

To Reset the Cine Range 

1. Open the Cine drop-down menu by clicking the Arrow ( ) or Halt ( ) and 
dragging-down with the mouse. 

2. Point to Range, then click Reset. 
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Using Sharpen/Smooth 
You can apply sharpen/smooth filters to an image. Unless Apply To settings have 
been changed, sharpen/smooth changes affect all images in the viewport. 

The info area at the bottom of each viewport displays which filter is used, where F+N 
indicates a sharpen filter, and where F-N indicates a smooth filter. 

Sharpening or Smoothing an Image 

1. Click the Sharpen tool ( ) in the toolbar; or right-click any image and then click 
Sharpen. 

2. Point to the image you want to adjust and drag the mouse using the left-mouse 
button. 

• To increase sharpness, drag up or left. 

• To decrease sharpness, drag down or right. 

3. Continue using the Sharpen/smooth tool, or disable it by right-clicking once or by 
choosing another tool. 

A.3.6.3 Mensurated Scale 
When an image is displayed, a mensurated scale is displayed on the left side of the 
image’s viewport. The scale uses pixel size data in the image header. If there is no 
pixel size data available for the image, you can use the Calibrate tool to establish a 
pixel size. See Using Calibrate for addition information. 

 
Figure A-20: Mensurated Scale 
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To display the mensurated scale: 
1. With an image in the viewport, right-click to display the Context menu. 

2. Click the Mensurated scale option from the menu. The scale displays to the left of 
the image. 

To remove the mensurated scale from view: 

• Right-click the image to display the Image Context menu, 

A.3.6.4 Annotations 
Annotation Basics 
You can use annotations to call attention to areas of interest in an image. You can 
also add text labels or measure image features. Annotations that are added during a 
session are not saved with the image and will be discarded when the Image Viewer is 
closed. 

Adding Shapes and Labels 
You can add lines, shapes, and text to an image. 

Note: Any hidden annotations in an image are displayed when 
you select an annotation- related tool. 

 
Figure A-21: Annotation Tools 

To add lines and arrows: 
1. Use the Annotation button in the toolbar to turn on the Line or Arrow tool. 

2. Set the start point of the line, drag the mouse, and release the mouse button when 
the line or arrow is the desired length. 
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3. You can add additional annotations, select a different tool, or right-click once to 
turn off the active tool. 

To add rectangles and ellipses: 
1. Use the Annotation button in the toolbar to turn on the Rectangle or Ellipse tool. 

2. Drag the mouse to draw the line or shape. An outline displays as you drag the 
mouse. 

3. Release the left-mouse button when the outlined area is the desired size. 

4. You can add additional annotations, select a different tool, or right-click once to 
turn off the active tool. 

To add freehand shapes: 
1. Use the Annotation button in the toolbar to turn on the Free Hand tool. 

2. Outline the area of interest by clicking three or more spots around its area. 

3. Right-click once to stop adding handles. 

4. Continue adding a new freehand shape, or right-click a second time to turn off the 
tool. 

5. To make adjustments to the freehand shape, enable edit mode, then drag the 
handles as needed. See To edit annotations for additional information. 

To add text labels: 
1. Turn on the Text tool by doing one of the following: 

• Use the Annotation button in the toolbar to turn on the Text tool. 

• If the button noted previously is not visible, click the arrow next to the 
Annotation button ( ), then click Text. 

2. In the image you want to annotate, drag the mouse to define a box that contains 
the text. When you complete the drag, a blinking cursor is displayed in the box. 

3. Type the text that you want to appear in the box. 

• The text you enter wraps, based on the width of the box. 

• You can copy text to and from the text box using Ctrl+C and Ctrl+V. 

• To add a line break, use the Enter key. 

4. Click once outside of the box to finalize your edits. 

5. You can add additional annotations, select a different tool, or right-click once to 
turn off the active tool. 
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To add auto numbers: 
1. Turn on the Auto Number tool by doing one of the following: 

• If the button noted previously is not visible, click the arrow next to the 
Annotation button, then click Auto Number. 

• In the Auto Number dialog that displays, click the buttons that correspond to 
the numbering style and starting point you want to use. 

2. Click each point in the image where you want a number to appear. 

3. Add additional numbers, select a different tool, or right-click once to turn off the 
active tool. 

Note: Spinal labels are incremented from C1 to L6. After L6 is 
used, auto-numbering is turned off automatically. 

A.3.6.5 Adding Measurements 
You can measure lengths, areas, angles, and Hounsfield values in an image. If you 
want measurements to be saved, make sure the exam is locked before adding 
measurements. 

Note: Before measuring a small image feature, increase the scale 
of the image to improve the placement of the measurement. 

To measure lines: 

1. Click the Measure | Length tool ( ) in the toolbar, or right-click an image and 
choose Measure | Length. 

Note: If the mouse pointer changes, you must use the Calibrate 
tool before proceeding. 

2. Point to the part of the image from which you want to begin measuring. 

3. Drag the mouse to create the measurement line. Once you have finished dragging, 
a label appears next to the line, displaying the measurement. 

4. Drag the text results to reposition as needed. 

Note: If the measurement label includes a (c) or a (c*) label, the 
measurement is based on a manual calibration, rather than 
on a modality-defined pixel size. 

5. Continue adding measurement lines or right-click once to turn off the tool. 
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To measure angles: 

1. Click the Measure | Angle tool ( ) in the toolbar, or right-click an image and 
choose Measure | Angle. 

2. Drag the mouse to draw the first line of the angle. The second line of the angle is 
automatically created. 

3. Drag either or both lines by their handles to adjust the angle. 

4. Drag the text results to reposition as needed. 

5. Continue adding angles, or right-click once to turn off the tool. 

To measure Cobb angles: 

1. Click the Measure | Cobb Angle tool ( ) in the toolbar, or right-click an image 
and choose Measure | Cobb Angle. 

2. Starting with the top-most line to be drawn, drag the mouse to create the line. The 
program automatically creates the second line. 

3. Reposition the lines as needed by dragging the handles. Drag the text results to 
reposition as needed. 

4. Continue adding angles or right-click once to turn off the tool. 

A.3.6.6 Using the Hounsfield Tool 
The Hounsfield tool offers the capabilities to measure areas captured in ellipse or 
freehand shape, as well as rectangles. 

To measure rectangular or elliptical areas: 
1. Select the area to be measured. 

2. Set the start point of the rectangle or ellipse. 

3. Drag the mouse and release the mouse button when the ellipse covers the desired 
area. 

4. Drag the end-points of the perpendicular lines as needed to adjust. 

5. Drag the text results to reposition as needed. 

6. Continue adding Hounsfield measurements, or right-click once to turn off the 
tool. 

To measure freehand areas: 
1. Outline the area to be measured by clicking three or more spots around its area. 
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2. Right-click once to stop adding handles. 

3. Continue adding a new freehand measurement, or right-click a second time to turn 
off the tool. 

4. To make adjustments to the measurement, enable the Edit mode. 

5. Reposition the text results or drag the handles as needed. See To edit annotations 
for additional information. 

A.3.6.7 Working with Annotations 
To move annotations: 

1. Click the Select tool ( ) in the toolbar. 

2. Click the Lock tool ( ) near the annotation you want to move. Or right-click the 
annotation, and choose Edit Annotation. 

3. Once you have finished, you can resize, move, or edit other annotations, or you 
can right-click once to turn off the tool. 

To resize annotations: 

1. Click the Select tool ( ) in the toolbar. 

2. Click the Lock tool ( ) near the annotation you want to resize. Or right-click the 
annotation, and choose Edit Annotation. 

3. Drag any of the sizing handles to change the size of the annotation. 

 
Figure A-22: Sizing Handles 

4. Once you have finished, you can resize, move, or edit other annotations, or you 
can right-click once to turn off the tool. 
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To edit annotations: 

1. Click the Lock tool ( ) near the annotation you want to edit. Or right-click the 
annotation, and choose Edit Annotation. 

Note: Only one annotation at a time in an image can be unlocked 
for editing. Clicking the Lock tool ( ) on an annotation 
releases only that particular annotation from its locked 
state. 

2. Make the changes you want to the annotation by clicking and dragging handles in 
a drawing tool, or clicking and dragging endpoints in a line. 

Note: While in Editing mode, the Arrow drawing tool has handles 
to drag for repositioning and re-sizing. However, to 
facilitate precise measurement, the Length-Measurement 
tool does not. When the cursor hovers at the line’s 
endpoint, crosshairs display to show the cursor is in the 
correct position for clicking and dragging the line. 

3. Right-click once to turn off the tool. 

To edit text labels: 

1. Click the Select tool ( ) in the toolbar to turn on the Select Annotation tool, or 
right-click the text annotation you want to edit. 

2. Double-click the text annotation. 

3. Edit the text. 

4. Click once outside the text annotation to finalize your edits. 

5. Once you have finished, you can resize, move, or edit other annotations, or you 
can right-click once to turn off the tool. 

A.3.6.8 Using Calibrate 
The Calibrate tool displays automatically if you try to measure an image that does not 
have a modality-defined pixel size. If the image in question has an embedded 
measurement scale, you can use the embedded scale and the Calibrate tool to set a 
pixel size manually. 

If the Calibrate tool has been used, measurement values display one of the following: 

• A (c) label indicates that pixel size was set manually. 

• A (c*) label indicates that a manually defined pixel size has been used to override 
a modality-defined pixel size. 
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To use the Calibrate tool: 

1. If the Calibrate tool is not already turned on, click the  tool in the viewport 
and drag-down to open the drop-down menu. 

2. Click Calibrate. 

3. While the mouse pointer appears in this mode ( ), draw a line between the two 
points that you want to use to establish a measurement standard. 

a. The Calibrate Image dialog displays as you start drawing the line. 

b. If the line is not ideally placed, you can re-draw the line. 

4. In the Calibrate Image dialog, enter the length of the line that you drew, and then 
choose the unit length (centimeters, millimeters, or inches). 

5. Check the Apply to Image Set check box if you want this calibration to be used 
for all images in the image set. Otherwise, the calibration applies to the individual 
image only. 

6. Click OK. 

Note: To remove calibration settings for a viewport, clear and 
reload the image in the viewport. 

Using the Image Detail Window: 
The Image Detail window is opened by clicking the information area at the bottom of 
an occupied viewport. Opening this window causes three tabs to display: 

• The Full Header tab displays the entire DICOM header except for private 
elements and Look Up Tables. 

• The Display Data tab lists acquisition data for the selected image. 

• The Image Data tab lists DICOM header data. 
Information in the Image Detail window is updated if you select a different image in 
the same viewport. 

To close the Image Detail window, click the Exit icon ( ), or click the information 
area that the window was opened from. 

You can click the Information icon ( ) in the toolbar to open an instance of this 
window for each occupied viewport. Clicking the Information icon again closes all 
windows. 
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A.4 RPCs 
The Image Viewer code calls the following existing RPCs to acquire contextual 
information upon the receipt of a windows message. All RPC calls are made from the 
Abstract View component, and the results are communicated to the Full-Resolution 
Viewer component. This allows the Full-Resolution Viewer component to be 
independent of EHR. 

The KIDS package automatically assigns them to the proper menu options to make 
them accessible to the EHR client. 

Table A-1: RPC Contextual Information Table 

RPC Required 
MAGJ USER2 Yes 

RPC: MAGG CPRS RAD EXAM 
INPUT PARAMETER: CPRSMSG 

String from the CPRS Windows Message 
Sample CPRSMSG: 
RPT^CPRS^20^RA^i6918775.83 
69-1^39 

RETURN PARAMETER: Array of Image data 

Yes 

NAME: MAG3 CPRS TIU NOTE 

RETURN VALUE TYPE: ARRAY 
Returns a list of all images for a TIU 
document 
INPUT PARAMTER: TIUDA 
DESCRIPTION: internal entry number of the 
TIU document 

RETURN PARAMETER DESCRIPTION: 
Array of “^” delimited Image information in the 
format 

Yes 
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Appendix B:  Rules of Behavior 
The Resource and Patient Management (RPMS) system is a United States 
Department of Health and Human Services (HHS), Indian Health Service (IHS) 
information system that is FOR OFFICIAL USE ONLY. The RPMS system is 
subject to monitoring; therefore, no expectation of privacy shall be assumed. 
Individuals found performing unauthorized activities are subject to disciplinary action 
including criminal prosecution. 

All users (Contractors and IHS Employees) of RPMS will be provided a copy of the 
Rules of Behavior (RoB) and must acknowledge that they have received and read 
them prior to being granted access to a RPMS system, in accordance IHS policy. 

• For a listing of general ROB for all users, see the most recent edition of IHS 
General User Security Handbook (SOP 06-11a).  

• For a listing of system administrators/managers rules, see the most recent edition 
of the IHS Technical and Managerial Handbook (SOP 06-11b). 

Both documents are available at this IHS Web site: http://security.ihs.gov/. 

The ROB listed in the following sections are specific to RPMS.  

B.1 All RPMS Users 
In addition to these rules, each application may include additional RoBs that may be 
defined within the documentation of that application (e.g., Dental, Pharmacy). 

B.1.1 Access 
RPMS users shall 

• Only use data for which you have been granted authorization. 

• Only give information to personnel who have access authority and have a need to 
know.  

• Always verify a caller’s identification and job purpose with your supervisor or the 
entity provided as employer before providing any type of information system 
access, sensitive information, or nonpublic agency information. 

• Be aware that personal use of information resources is authorized on a limited 
basis within the provisions Indian Health Manual Part 8, “Information Resources 
Management,” Chapter 6, “Limited Personal Use of Information Technology 
Resources.” 

RPMS users shall not 

• Retrieve information for someone who does not have authority to access the 
information. 

http://security.ihs.gov/
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• Access, research, or change any user account, file, directory, table, or record not 
required to perform their official duties. 

• Store sensitive files on a PC hard drive, or portable devices or media, if access to 
the PC or files cannot be physically or technically limited. 

• Exceed their authorized access limits in RPMS by changing information or 
searching databases beyond the responsibilities of their jobs or by divulging 
information to anyone not authorized to know that information. 

B.1.2 Information Accessibility 
RPMS shall restrict access to information based on the type and identity of the user. 
However, regardless of the type of user, access shall be restricted to the minimum 
level necessary to perform the job. 

RPMS users shall 

• Access only those documents they created and those other documents to which 
they have a valid need-to-know and to which they have specifically granted 
access through an RPMS application based on their menus (job roles), keys, and 
FileMan access codes. Some users may be afforded additional privileges based on 
the functions they perform, such as system administrator or application 
administrator. 

• Acquire a written preauthorization in accordance with IHS policies and 
procedures prior to interconnection to or transferring data from RPMS. 

B.1.3 Accountability 
RPMS users shall 

• Behave in an ethical, technically proficient, informed, and trustworthy manner. 

• Log out of the system whenever they leave the vicinity of their personal 
computers (PCs). 

• Be alert to threats and vulnerabilities in the security of the system. 

• Report all security incidents to their local Information System Security Officer 
(ISSO)  

• Differentiate tasks and functions to ensure that no one person has sole access to or 
control over important resources. 

• Protect all sensitive data entrusted to them as part of their government 
employment. 

• Abide by all Department and Agency policies and procedures and guidelines 
related to ethics, conduct, behavior, and information technology (IT) information 
processes. 
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B.1.4 Confidentiality 
RPMS users shall 

• Be aware of the sensitivity of electronic and hard copy information, and protect it 
accordingly. 

• Store hard copy reports/storage media containing confidential information in a 
locked room or cabinet. 

• Erase sensitive data on storage media prior to reusing or disposing of the media. 

• Protect all RPMS terminals from public viewing at all times. 

• Abide by all Health Insurance Portability and Accountability Act (HIPAA) 
regulations to ensure patient confidentiality. 

RPMS users shall not 

• Allow confidential information to remain on the PC screen when someone who is 
not authorized to that data is in the vicinity. 

• Store sensitive files on a portable device or media without encrypting. 

B.1.5 Integrity 
RPMS users shall 

• Protect their systems against viruses and similar malicious programs. 

• Observe all software license agreements.  

• Follow industry standard procedures for maintaining and managing RPMS 
hardware, operating system software, application software, and/or database 
software and database tables. 

• Comply with all copyright regulations and license agreements associated with 
RPMS software. 

RPMS users shall not 

• Violate federal copyright laws. 

• Install or use unauthorized software within the system libraries or folders. 

• Use freeware, shareware, or public domain software on/with the system without 
their manager’s written permission and without scanning it for viruses first. 

B.1.6 System Logon 
RPMS users shall 

• Have a unique User Identification/Account name and password. 
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• Be granted access based on authenticating the account name and password 
entered. 

• Be locked out of an account after five successive failed login attempts within a 
specified time period (e.g., one hour). 

B.1.7 Passwords 
RPMS users shall 

• Change passwords a minimum of every 90 days. 

• Create passwords with a minimum of eight characters. 

• If the system allows, use a combination of alpha-numeric characters for 
passwords, with at least one uppercase letter, one lower case letter, and one 
number. It is recommended, if possible, that a special character also be used in the 
password. 

• Change vendor-supplied passwords immediately. 

• Protect passwords by committing them to memory or store them in a safe place 
(do not store passwords in login scripts or batch files).  

• Change passwords immediately if password has been seen, guessed, or otherwise 
compromised, and report the compromise or suspected compromise to their ISSO. 

• Keep user identifications (IDs) and passwords confidential. 

RPMS users shall not 

• Use common words found in any dictionary as a password. 

• Use obvious readable passwords or passwords that incorporate personal data 
elements (e.g., user’s name, date of birth, address, telephone number, or social 
security number; names of children or spouses; favorite band, sports team, or 
automobile; or other personal attributes). 

• Share passwords/IDs with anyone or accept the use of another’s password/ID, 
even if offered. 

• Reuse passwords. A new password must contain no more than five characters per 
eight characters from the previous password. 

• Post passwords. 

• Keep a password list in an obvious place, such as under keyboards, in desk 
drawers, or in any other location where it might be disclosed. 

• Give a password out over the phone. 
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B.1.8 Backups 
RPMS users shall 

• Plan for contingencies such as physical disasters, loss of processing, and 
disclosure of information by preparing alternate work strategies and system 
recovery mechanisms. 

• Make backups of systems and files on a regular, defined basis.  

• If possible, store backups away from the system in a secure environment. 

B.1.9 Reporting 
RPMS users shall 

• Contact and inform their ISSO that they have identified an IT security incident 
and begin the reporting process by providing an IT Incident Reporting Form 
regarding this incident. 

• Report security incidents as detailed in the IHS Incident Handling Guide (SOP 
05-03). 

RPMS users shall not 

• Assume that someone else has already reported an incident. The risk of an 
incident going unreported far outweighs the possibility that an incident gets 
reported more than once. 

B.1.10 Session Timeouts 
RPMS system implements system-based timeouts that back users out of a prompt 
after no more than 5 minutes of inactivity. 

RPMS users shall 

• Utilize a screen saver with password protection set to suspend operations at no 
greater than 10 minutes of inactivity. This will prevent inappropriate access and 
viewing of any material displayed on the screen after some period of inactivity. 

B.1.11 Hardware 
RPMS users shall 

• Avoid placing system equipment near obvious environmental hazards (e.g., water 
pipes).  

• Keep an inventory of all system equipment.  

• Keep records of maintenance/repairs performed on system equipment. 
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RPMS users shall not 

• Eat or drink near system equipment. 

B.1.12 Awareness 
RPMS users shall 

• Participate in organization-wide security training as required.  

• Read and adhere to security information pertaining to system hardware and 
software. 

• Take the annual information security awareness. 

• Read all applicable RPMS manuals for the applications used in their jobs. 

B.1.13 Remote Access 
Each subscriber organization establishes its own policies for determining which 
employees may work at home or in other remote workplace locations. Any remote 
work arrangement should include policies that 

• Are in writing. 

• Provide authentication of the remote user through the use of ID and password or 
other acceptable technical means. 

• Outline the work requirements and the security safeguards and procedures the 
employee is expected to follow. 

• Ensure adequate storage of files, removal, and nonrecovery of temporary files 
created in processing sensitive data, virus protection, and intrusion detection, and 
provide physical security for government equipment and sensitive data. 

• Establish mechanisms to back up data created and/or stored at alternate work 
locations. 

Remote RPMS users shall 

• Remotely access RPMS through a virtual private network (VPN) whenever 
possible. Use of direct dial in access must be justified and approved in writing and 
its use secured in accordance with industry best practices or government 
procedures. 

Remote RPMS users shall not 

• Disable any encryption established for network, internet, and Web browser 
communications. 
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B.2 RPMS Developers 
RPMS developers shall 

• Always be mindful of protecting the confidentiality, availability, and integrity of 
RPMS when writing or revising code. 

• Always follow the IHS RPMS Programming Standards and Conventions (SAC) 
when developing for RPMS. 

• Only access information or code within the namespaces for which they have been 
assigned as part of their duties. 

• Remember that all RPMS code is the property of the U.S. Government, not the 
developer. 

• Not access live production systems without obtaining appropriate written access, 
and shall only retain that access for the shortest period possible to accomplish the 
task that requires the access. 

• Observe separation of duties policies and procedures to the fullest extent possible. 

• Document or comment all changes to any RPMS software at the time the change 
or update is made. Documentation shall include the programmer’s initials, date of 
change, and reason for the change. 

• Use checksums or other integrity mechanism when releasing their certified 
applications to assure the integrity of the routines within their RPMS applications. 

• Follow industry best standards for systems they are assigned to develop or 
maintain, and abide by all Department and Agency policies and procedures. 

• Document and implement security processes whenever available. 
RPMS developers shall not 

• Write any code that adversely impacts RPMS, such as backdoor access, “Easter 
eggs,” time bombs, or any other malicious code or make inappropriate comments 
within the code, manuals, or help frames. 

• Grant any user or system administrator access to RPMS unless proper 
documentation is provided.  

• Release any sensitive agency or patient information. 
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B.3 Privileged Users 
Personnel who have significant access to processes and data in RPMS, such as, 
system security administrators, systems administrators, and database administrators, 
have added responsibilities to ensure the secure operation of RPMS. 

Privileged RPMS users shall 

• Verify that any user requesting access to any RPMS system has completed the 
appropriate access request forms. 

• Ensure that government personnel and contractor personnel understand and 
comply with license requirements. End users, supervisors, and functional 
managers are ultimately responsible for this compliance. 

• Advise the system owner on matters concerning information technology security. 

• Assist the system owner in developing security plans, risk assessments, and 
supporting documentation for the certification and accreditation process. 

• Ensure that any changes to RPMS that affect contingency and disaster recovery 
plans are conveyed to the person responsible for maintaining continuity of 
operations plans.  

• Ensure that adequate physical and administrative safeguards are operational 
within their areas of responsibility and that access to information and data is 
restricted to authorized personnel on a need-to-know basis.  

• Verify that users have received appropriate security training before allowing 
access to RPMS. 

• Implement applicable security access procedures and mechanisms, incorporate 
appropriate levels of system auditing, and review audit logs.  

• Document and investigate known or suspected security incidents or violations and 
report them to the ISSO, Chief Information Security Officer (CISO), and systems 
owner. 

• Protect the supervisor, superuser, or system administrator passwords. 

• Avoid instances where the same individual has responsibility for several functions 
(i.e., transaction entry and transaction approval). 

• Watch for unscheduled, unusual, and unauthorized programs. 

• Help train system users on the appropriate use and security of the system. 

• Establish protective controls to ensure the accountability, integrity, 
confidentiality, and availability of the system. 

• Replace passwords when a compromise is suspected. Delete user accounts as 
quickly as possible from the time that the user is no longer authorized system. 
Passwords forgotten by their owner should be replaced, not reissued. 
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• Terminate user accounts when a user transfers or has been terminated. If the user 
has authority to grant authorizations to others, review these other authorizations. 
Retrieve any devices used to gain access to the system or equipment. Cancel 
logon IDs and passwords, and delete or reassign related active and backup files. 

• Use a suspend program to prevent an unauthorized user from logging on with the 
current user's ID if the system is left on and unattended. 

• Verify the identity of the user when resetting passwords. This can be done either 
in person or having the user answer a question that can be compared to one in the 
administrator’s database. 

• Shall follow industry best standards for systems they are assigned to, and abide by 
all Department and Agency policies and procedures. 

Privileged RPMS users shall not 

• Access any files, records, systems, etc., that are not explicitly needed to perform 
their duties 

• Grant any user or system administrator access to RPMS unless proper 
documentation is provided.  

• Release any sensitive agency or patient information. 
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Acronym List 

AMI Acute Myocardial Infarction 

CAC Clinical Application Coordinator 

CCDA Consolidated Clinical Document Architecture 

CCR Continuity of Care Record 

CIR Clinical Information Reconciliation 

CPRS Computerized Patient Record System 

EHR Electronic Health Record 

ICD International Classification of Diseases 

IHS Indian Health Service 

IPL Integrated Problem List 

LOINC Logical Observation Identifiers Names and Codes 

OP Outpatient 

PDF Portable Document Format 

PHN Public Health Nurse 

PHR Personal Health Record 

POV Purpose of Visit 

RPMS Resource and Patient Management System 

SNOMED CT Systematized Nomenclature of Medicine-Clinical 
Terms 

TOC Transitions of Care 

VA Department of Veterans Affairs 
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Contact Information 

If you have any questions or comments regarding this distribution, contact the OIT 
User Support (IHS) by: 
Phone: (888) 830-7280 

Web: http://www.ihs.gov/helpdesk/ 

Email: mailto:support@ihs.gov 

http://www.ihs.gov/helpdesk/
mailto:support@ihs.gov
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